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CHAPTER 1

Introduction

RGB's Broadcast Network Processor 3xr model (BNP3xr) offers a 2 rack unit (RU) platform with hot-
swappable redundant fan modules and power supplies.

The BNP3xr delivers the industry's highest density digital video solution for grooming, statistical 
multiplexing, transrating, digital program insertion (DPI), and the incorporation of DVB Conditional 
Access for program encryption. Based on RGB's flexible, scalable and modular platform, the BNP 
simplifies and expedites deployments of advanced video services, simplifies operation and 
management, and reduces operational and capital costs. 

Receiving input through its Gigabit Ethernet or ASI interfaces, the BNP3xr can statistically multiplex 
while performing grooming and digital ad and overlay insertion.

The BNP3xr can receive both standard definition (SD) and high definition (HD) program services, can 
concurrently groom and insert digital ads within the same box while providing program-level 
encryption. 

The BNP is fully MPEG compliant and interoperable with leading cable industry equipment. The 3xr 
unit offers hot-swappable redundant fan modules and power supplies.

The BNP makes configuration more intuitive and simple by providing an easy-to-use Java-based 
graphical user interface that can be accessed through a standard Web browser. Configuration can be 
performed through SNMP using any standard network management application. The SNMP MIBs are 
readily available from the BNP home page.

Figure 1. RGB’s Broadcast Network Processor—Model BNP3xr

This guide describes the installation, configuration, and FRU replacement for the BNP3xr.
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Document Organization

This guide is organized as follows:

• Chapter 1, "Introduction," (this chapter) describes the contents and conventions used in this guide.

• Chapter 2, "Overview," provides a detailed description of the BNP3xr and its features.

• Chapter 3, "Installation," describes the tools, precautions, and steps necessary to install the system 
in the network.

• Chapter 4, "System Configuration," describes the initial product setup and product configuration 
using the Java-based BNP Element Manager.

• Chapter 5, “Grooming and PSIP,” shows you how to set up grooming, transrating, and other 
configuration and operational procedures.

• Chapter 6, “Digital Program Insertion (DPI)” describes DPI using the BNP3xr.

• Chapter 7, "ETV Binary Interchange Format (EBIF)," provides an overview of EBIF and typical 
use cases for configuration.

• Chapter 8, “DVB Conditional Access” describes how to set up DVP-CA system using the BNP3xr.

• Chapter 9, “Monitoring the BNP,” discusses the methods used to monitor the health of the BNP3xr 
and its status in the network.

• Chapter 10, "Troubleshooting," provides information about system status, alarm messages, 
software upgrades, and contacting technical support.

• Chapter 11, "Field-replaceable Units," shows you how to replace all field-replaceable units in the 
BNP3xr.

• Chapter 12, "Specifications," includes information about system specifications including physical, 
environmental, and regulatory and compliance definitions.

• Appendix A, “Editing the DVB NIT Table,” shows you how to edit, make additions to, and delete 
items from the NIT table, one of the DVB tables.

• Appendix B, “Localized Cautions and Warnings,” lists all of this guide’s Caution and Warning 
statements in French and German.

• “Information to Users” provides regulatory compliance information for the BNP3xr.

• The glossary and index can be used to quickly reference information.

Document Audience

This guide is for system administrators and operators who are responsible for installation and 
maintenance of the BNP3xr and for processing network broadcast. You should be familiar with general 
video and networking terminology, and should be familiar with basic installation of hardware. 

Most importantly, you must be familiar with the basics and principles of broadcast network processing.
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Document Conventions

Document Conventions

Table 1 provides an easy way to recognize important information in the text.

Graphics Used

In some cases, the screens shown in this manual may have been slightly modified after the manual was 
released, or may appear slightly different on different browsers.

All efforts have been made to ensure that the latest images are used. In all cases, the functionality 
described is current at the time of writing.

Table 1. Document Conventions

When 
you see: It means:

Notes point out information that may not be part of the text but provide tips and other helpful 
advice.

Cautions let you know that an action may have undesirable consequences if the instructions are 
not followed correctly. Cautions also indicate that failure to follow guidelines could cause damage 
to equipment or loss of data.

Les symboles "ATTENTION", représentés par l'icône de gauche, indiquent qu'une action peut 
avoir des conséquences indésirables si les instructions ne sont pas suivies correctement.

Les symboles " ATTENTION " indiquent également que le fait de ne pas suivre les instructions 
peut causer des dommages à l'équipement ou résulter en une perte de données.

Das links abgebildete Symbol Vorsicht weist darauf hin, dass ein Vorgang unerwünschte 
Konsequenzen haben kann, falls die Anweisungen nicht korrekt befolgt werden.

Das Symbol Vorsicht weist außerdem darauf hin, dass Geräte beschädigt oder Daten verloren 
gehen können, wenn die Anweisungen nicht befolgt werden.

Warnings indicate that failure to take the necessary precautions or to follow guidelines could 
cause harm to equipment and personnel.

Les symboles " AVERTISSEMENT ", représentés par l'icône de gauche, indiquent que le fait 
de ne pas prendre les précautions nécessaires ou de ne pas suivre les instructions peut 
endommager l'équipement ou provoquer des blessures.

Das links abgebildete Symbol Warnung weist darauf hin, dass Geräte beschädigt oder 
Personen verletzt werden können, wenn die notwendigen Vorsichtsmaßnahmen nicht 
eingehalten oder die Anweisungen nicht befolgt werden. 

Clicking any blue link takes you to the item to which the link refers.

For a list of all Caution and Warning statements in French and German, refer to Appendix B, “Localized 
Cautions and Warnings”.
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CHAPTER 2

Overview

This chapter provides an overview of the Broadcast Network Processor 3xr model. 

In This Chapter:

• “Product Overview,” next.

• “Product Features” on page 5.

• “BNP3xr Applications” on page 6.

• “BNP Deployment Architecture” on page 9.

• “Redundancy” on page 12.

Product Overview

RGB’s Broadcast Network Processor 3xr is a 2RU (two rack unit) device that provides: 

• Support of both standard definition (SD) and high definition (HD) program services in either 
MPEG-2 or H.264 encoding; the BNP simultaneously grooms and inserts digital ads.

• High density video transrating (rate shaping), statistical multiplexing, grooming and digital 
program insertion (DPI); transrates video streams with impressively high video quality.

• Multiple levels of redundancy support including service level and 1:1 chassis level redundancy.

• Hot-swappable redundant fan modules and power supplies.

• New Gigabit Processor-3 (GBP3) and Processor-3 (PROC3) hardware modules. 

• Up to 8 Gigabit Ethernet (GigE) interfaces for video input or output, as well as up to 18 
asynchronous serial interface (ASI) I/O ports in a single rack unit device.

• Incorporation of DVB Conditional Access (CA) common scrambling algorithm, to encrypt 
programs processed by the BNP3xr.

Product Features

In addition to being software-upgradeable, scalable, and highly reliable, the BNP3xr has the following 
features:

• Based on RGB's flexible Video Intelligence Architecture™ (VIA).

• 8 GigE interfaces standard and up to 18 optional ASI ports.

• Management via two 10/100BaseT Ethernet ports

• Able to process and encrypt MPEG-2 and H.264 program streams over any of its Gigabit Ethernet 
or ASI inputs, and route them to any of these interfaces.

• Performs seamless digital ad insertion and program substitution.
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• Fully compliant with the SCTE 30 and SCTE 35 standards.

• Fully interoperable ad insertion with SeaChange, Arris, and other industry standard ad servers.

• EBIF support.

• Incorporates DVB Conditional Access common scrambling algorithm (CSA) and is compliant with 
DVB CSA and DVB SimulCrypt protocols.

• Supports multiple levels of redundancy at the chassis, service (program) and Ethernet port level.

• Supports SCTE 18 Digital Emergency Alert Messaging (EAS), which is used to integrate the BNP 
with EAS management systems to control the playout of message crawls and audio during an 
emergency alert event. 

• Supports operator-generated text and graphic messages from the BNP GUI based on digital overlay 
technology.

• Graphic overlays can be inserted anywhere on a program (MPEG-2) using the BNP GUI to import 
standard graphic files (PNG).

• Supports scheduling for Logo Overlay and Operator Messaging up to one month in advance. 

• Interface to Event Information Scheduler (EIS), Entitlement Control Message Generator (ECMG) 
and Entitlement Management Message Generator (EMMG).

• Dedicated 10/100 BaseT IP management interface for DVB CA encryption.

• Supports H.264 grooming and multiplexing in a MPEG-2 TS format.

• Supports “FAT” ASI transport services, multiple program groups over a single TS / ASI interface.

• Supports program substitution of a primary network source with a secondary source based on 
SCTE 30 control.

• Supports SCTE 21 to SCTE 20 closed caption conversion. 

• A graphical user interface for easy configuration and management.

• ATSC and DVB content support.

• International Time Zones.

• Language-specific GUI support.

• RADIUS/TACACS authentication support.

• Bandwidth-based DVB-CA licensing support.

BNP3xr Applications

The BNP3xr delivers the industry’s highest density digital video processing solution for a variety of 
applications including:

• Switched digital broadcast grooming, transrating, and statistical multiplexing.

• DPI-based ad insertion.

• Enhanced TV.

• Digital Alert Messaging (including digital EAS, Advanced Messaging, and Logo Overlay 
applications).

• Advanced Logo Overlay and Operator Messaging scheduling.

• DVB-CA program encryption.
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BNP3xr Applications

Grooming, Transrating and Multiplexing

Based on RGB’s Video Intelligence Architecture™ (VIA), the BNP’s ability to transrate program 
streams with the highest quality is unsurpassed in the industry. The BNP seamlessly grooms multi-
program transport streams (MPTS / MUX) and single-program transport streams (SPTS) on both input 
and output ports. It also offers multiple Quality of Service (QoS) priority levels on any MPEG-2 
program stream enabling selection of the desired level of transrating. 

DPI-Based Ad Splicing

Additionally, the BNP can concurrently groom and seamlessly splice both SD and HD program 
streams encoded in either MPEG-2 or H.264 formats. This grooming and splicing capability eliminates 
the need to dedicate multiple devices for different functions. The simplified installation, wiring and 
configuration reduces system deployment time. The BNP is fully compliant with SCTE 30 and 
SCTE 35 standards and is interoperable with the leading digital program insertion (DPI) ad servers. 
This flexible product can also perform SCTE 30 to SCTE 35 conversion to support digital ad insertion 
at the hub. The BNP is an ideal solution for both centrally located DPI systems at the headend facility, 
distributed DPI systems, and zoned and targeted ad insertion.

A BNP deployed in a cable digital broadcast video grooming and ad insertion environment is shown in 
Figure 2.

Figure 2. Regional Ad Zone Insertion Illustration

Messaging System

Digital EAS and Operator / Advanced Messaging

Leveraging its existing high-density video processing technology, the BNP’s digital Messaging 
System capability allows operators to program both digital SCTE 18 Emergency Alert System (EAS) 
alerts and operator-generated messages. The Advanced Messaging option allows importing graphics 
and text files into the operator crawl message. EAS and Operator / Advanced Messaging alerts are 
delivered universally throughout the network, overcoming existing challenges that cable operators face 
in supporting analog and digital subscribers with an increasing range of decoding technologies. 
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The BNP’s Messaging System support can be applied selectively to any MPEG-2 program being 
processed. EAS and operator-generated messages are digitally rendered and overlaid directly onto a 
program, delivered directly to any digital subscriber set-top box or to analog decoders, and presented 
as an overlay alert crawl to viewers. The BNP also supports operator-configurable audio override or 
audio stream insertion to complement the text crawl message generated by industry-leading EAS 
management vendors for a completely customizable deployment.

A BNP in an SCTE 18 digital EAS application is shown below in Figure 3 below.

Figure 3. BNP in SCTE 18 Digital EAS application

Graphic Overlay Insertion

In addition to EAS and operator messaging, the BNP Messaging System Logo Overlay option supports 
inserting graphic overlays into any MPEG-2 program being processed. Graphic overlays are based on 
importing static graphic Portable Network Graphics (PNG) files. Importing text files is also supported, 
meaning that customers can create a library of graphic and text files to routinely use (see workflow 
example below). Users can preview the imported PNG files before starting the overlay insertion. 

The location of the insertion is user configurable with positioning anywhere on the display screen 
defined by (x,y) screen coordinates based on pixels relating to program resolution (e.g., SD and HD). 
Logo overlay files can be created with PNG alpha channels to control transparency effects supported 
by the BNP during the insertion of the overlay. Additionally, background transparency support is 
available for non-ascii text overlays in order to support foreign markets. 

DVB Conditional Access (DVB-CA) Encryption

The BNP3xr supports the DVB-CA common scrambling algorithm (CSA) for encryption of MPEG-2 
and H.264 programs. The embedded SimulCrypt Engine is a low cost, high density, scalable 
encryption and management control implementation that is fully DVB-CA compliant.

The DVB-CA encryption feature includes the following functionalities:

• SimulCrypt Synchronization (SCS).

• Control Word Generation (CWG).

• Common Scrambling Algorithm (CSA).

• ECM / EMM insertion.

• CA-related PSI / SI generation and insertion.

• SimulCrypt EIS Lite GUI configuration and management.
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BNP Deployment Architecture

RGB’s SimulCrypt engine interfaces with the following external devices:

• Event Information Scheduler (EIS).

• Entitlement Control Message Generator (ECMG).

• Entitlement Management Message Generator (EMMG).

Figure 4 shows the BNP3xr in a DVB-CA network.

Figure 4. BNP3xr in a DVB-CA network

BNP Deployment Architecture

The BNP’s modular and programmable platform is designed to provide operators with full processing 
scalability to meet their specific processing requirements today and in the future. The program density 
of the BNP is software-configurable and upgradeable, allowing operators to start at lower densities and 
upgrade to the full hardware capacity through software licenses as their stream densities and network 
needs grow.

This scalability reduces capital costs and allows operators to allocate budgets accordingly. By paying 
for processing on an as needed basis, operators can wisely plan budgets based on today’s requirements 
and avoid over-allocation to meet future needs. The programmable and upgradeable architecture of the 
BNP, as well as its high processing power, eliminates hardware changes and will simplify and expedite 
future deployments of new video processing applications.

The BNP supports both ASI and Gigabit Ethernet interfaces, allowing operators who have deployed 
Gigabit Ethernet networks to profit from the increased cost-efficiency offered with this transport, 
while still providing support for operators with legacy ASI networks. This flexibility enables operators 
with ASI networks to continue with their existing infrastructures while providing an upgrade path for a 
future transition to an IP-based network.

The BNP has eight Gigabit Ethernet interfaces and is scalable to support up to 18 ASI interfaces using 
up to three ASI modules. The Gigabit Ethernet interfaces are part of the BNP’s base configuration and 
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no additional hardware or licensing is required to utilize these ports. Providing added flexibility, each 
ASI interface is software configurable as input or output via an easy-to-use graphical user interface.

Figure 5. Example of BNP Grooming of GigE or ASI Input Over GigE Transport Network

The BNP3xr deployed for bulk rate capping in a Switched Digital Video (SDV) architecture is shown 
in Figure 6.

Figure 6. Example of SDV Architecture over GigE Transport Network
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BNP Deployment Architecture

Figure 7 shows how the BNP3xr fits within the network for a centralized system architecture using 
ASI interfaces. GigE interfaces could also be used for both input and output in a co-located headend 
application.

Figure 7. Example of Co-Located ASI Architecture

Either ASI or GigE interfaces are used for MPEG input or output. Because of the distance, GigE 
interfaces are typically used for transport between the headend and the hub/node.

Note: This unit is intended for local (intra-building) connections only and is not designed or 
evaluated for direct connections to the public telecommunications/cable distribution system. 
Cable and Ethernet connections should be made in accordance with the National Electrical 
Code (NEC).

For example, make sure that at least one of the following conditions are met1: 

- Cable runs are located in the same building as this unit;

- Any copper cables that run through air between buildings are less than 42m (140ft);

- Cable runs between buildings are in underground conduit, where a continuous metallic 
cable shield or a continuous metallic conduit containing the cable is bonded to each 
building grounding electrode system.

1. These options are from the US National Electrical Code, Sections 800.10, 800.12, 800.13, 800.31, 800.32, 800.33, and 
800.40.
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Redundancy

Since a single BNP may deliver advanced video services to hundreds or even tens of thousands of 
subscribers in a video network, it is critical that the BNP provide a high availability of services. To 
achieve such reliability, the BNP supports a multi-level redundancy feature to ensure service 
availability and reduce system downtime. With proper configuration, the BNP can provide full chassis 
level redundancy. On the hardware level, a BNP3xr provides fan, power, and chassis redundancy; on 
the software level, the BNP3xr Gigabit Ethernet port redundancy and a configurable program service 
redundancy feature. 

There are three distinct, user-configurable redundancy options supported by a BNP. These are:

• Program Redundancy

• Port Redundancy

• 1:1 Chassis Redundancy

The first two redundancies—Program and Port—operate within a single BNP chassis. The third—1:1 
Chassis Redundancy—makes use of two BNP chassis. The redundancy for hot-swappable fan trays 
and power supply modules happens automatically. 

Program Redundancy

The BNP supports program redundancy, sometimes referred to as service-level redundancy. For this 
type of redundancy, when the primary program is gone, the BNP automatically switches to a redundant 
or backup program. 

In a program redundancy configuration, a switch to backup occurs when:

• Missing MPTS/SPTS streams are identified by checking the PAT.

• Missing program streams are identified by checking the PMT.

• A missing video stream is detected.

You can assign a backup program for every program, and any program can be assigned to backup a 
running primary program. The backup program can be another program on the same GigE port or it 
can be on a different GigE port in the same chassis. 

Program level redundancy is supported such that when there is a groomed program missing, a 
designated input program can function as a “standby program” and will take over for the missing 
program. The detection of a PAT / PMT missing for over 2 seconds is used as the threshold for the 
detection of the missing input program. 

For information about Program Redundancy configuration, see “Program Redundancy” on page 175.

Gigabit Ethernet Port Output Mirroring

The BNP supports Gigabit Ethernet port output mirroring within the same chassis. The mirrored port 
serves as a standby port in case the primary port fails. The mirroring port must have a unique IP 
address configured. The BNP delivers identical streams to both the primary port and the mirrored port 
with the same destination IP address and port number, but a different source IP address.
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Redundancy

The multiplexes output on one GigE are delivered to the mirrored GigE port simultaneously as a fully 
operational, redundant output GigE port. Regardless of mirroring, all active GigE ports must have 
unique IP addresses assigned.

To set GigE port-level redundancy, see “GigE Port Configuration” on page 53.

1:1 Chassis-level Redundancy 

When the ports and global settings are configured to do so, the BNP provides 1:1 redundancy. The 
BNP supports hot-standby 1:1 chassis redundancy through heartbeat and virtual IP failover 
mechanism. 

Heartbeats provide the ability to synchronize failover to a secondary BNP. A heartbeat daemon on the 
primary unit will send out unicast heartbeat messages on the management interface every 250 
milliseconds.The heartbeat daemon running on the standby BNP listens to the heartbeats coming from 
the primary BNP. If the standby BNP does not hear the primary BNP’s, it initiates a failover and takes 
ownership. The heartbeat daemon running on the standby BNP checks for heartbeats coming from the 
primary BNP over both the normal Ethernet 10/100BaseT management connection and optionally the 
eighth Gigabit Ethernet port (GigE 8) connection (when used as a backup to the Ethernet 10/100BaseT 
management port). 

The Backup LED on the front of the chassis indicates the redundancy role of a chassis: green indicates 
the active chassis, and orange indicates a standby chassis. 

The standby chassis takes over if the primary (active) chassis fails, if there is a system or module 
overheat, failed fan, failed power supply, or missing heartbeat from the primary unit. The formerly 
standby (now the active) chassis now becomes configurable through the BNP Element Manager.

Virtual IP addressing is used to support the BNP 1:1 chassis redundancy feature. If the active chassis 
fails, the standby assumes the virtual IP address. Network devices communicate with the virtual IP 
addresses, not to the physical IP addresses. If the active chassis’ input/output changes, the new setting 
will be synchronized to the standby chassis automatically.

GigE 8 can be configured to send heartbeat messages in the initial setting. If the network Ethernet 10/
100 management connection is unplugged, the active chassis remains active. If the input or output 
GigE link is down, the active chassis shows a hardware fault and becomes the standby.

The standby chassis does not have any separate licenses. The license usage on the active and standby 
chassis is always synchronized; if the standby chassis becomes the active chassis, it assumes the 
licenses of the active chassis.
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Figure 8 illustrates a typical configuration scenario of the BNP hot-standby 1:1 chassis redundancy 
feature.

Figure 8. 1:1 Chassis Redundancy using Heartbeat and Virtual IP Failover Mechanism

In this example, the primary BNP has a management IP address of 192.168.21.1 and the secondary 
BNP has an address of 192.168.21.2. A third IP address in the same subnet 192.168.21.200 is 
configured as a virtual IP address. The video server and management workstation will use this virtual 
IP address to communicate to the active BNP unit. During the normal course of operation, the primary 
BNP assumes the virtual IP address and acts as the active unit. When a failover event happens, the 
secondary BNP will take ownership of the virtual IP address and assume the active role. It achieves 
this by sending an ARP request to associate the secondary ports’ MAC addresses with the virtual IP 
addresses. For information about 1:1 chassis redundancy configuration, see “1:1 Redundancy Best 
Practices and Considerations” on page 50.
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CHAPTER 3

Installation

This chapter provides the information necessary to install the BNP3xr into a rack. Read this entire 
chapter before beginning, and perform the installation in the order described. Chapter 4, “System 
Configuration” describes the configuration procedure.

In This Chapter:

• “Before You Begin,” next.

• “Broadcast Network Processor Components” on page 16.

• “BNP3xr Component Layout” on page 20.

• “Rack Mounting the BNP3xr” on page 22.

• “Grounding the BNP3xr” on page 24.

• “Installing SFP Modules” on page 25.

• “Connecting AC Power to the BNP3xr” on page 26.

• “Connecting DC Power to the BNP3xr” on page 27.

• “Connecting External Ports” on page 29.

• “Installing the Compact Flash Card” on page 30.

Before You Begin

Required Equipment

Be sure that you have the required items listed below before you begin the installation of the BNP3xr. 
You will need:

• Populated BNP3xr chassis, including:

- 1 GBP3 module;

- Up to four PROC3 modules;

- Dual redundant AC or DC power supplies;

- Dual redundant fan trays;

- ASI modules, if ordered.

• Compact flash card.

• AC power cord, included.

• DC connector cables, if DC power supply is used.

• Front and rear rack mount brackets, included.

• Rack mount bracket screws, included. 

• Two (2) M4 grounding nuts, included.
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• Eight (8) rack mount screws, not included.

• Phillips and slotted screwdrivers, not included.

• 1 ring lug for grounding, included.

• Ethernet cable long enough to directly connect the BNP3xr and the management workstation, not 
included.

Electrostatic Precautions

Warning: Whenever computer components are handled (especially during installation), the 
equipment can be damaged by the buildup of static electricity. Take precautions before 
touching any internal components or boards by wearing an ESD wrist strap or working on 
an antistatic mat. Always hold system modules by the edges and avoid touching any 
electronic circuitry on the cards. 

Broadcast Network Processor Components

This section describes the physical characteristics of the BNP3xr. Before installing, configuring, or 
replacing any component of the BNP3xr, please be sure that you understand the chassis and its 
components. 

Front Panel

Figure 9 shows the front view of the BNP3xr with the bezel in place. When the front bezel is removed, 
the RS-232 serial port is visible, as shown in Figure 10.

Figure 9. Front panel (with bezel)

Note: The 10 GigE (XFP) and DTI ports are currently not used. 

BNP3xr

Compact Flash Card
GigE Ports 1-8 (SFP)

10 GigE Port (XFP) - Not Used
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10/100-0 BaseT 
Mgmt Port

System LEDs

Hot Swappable Fan Modules

10/100-1 BaseT 
DVB-CA Port

PSU 1 LEDs

PSU 2 LEDs
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Broadcast Network Processor Components

Each BNP3xr has eight GigE ports. These ports can be used for input and output (full-duplex) of video 
over IP data streams. The ports, LEDs, and compact flash card are located on the Gigabit Ethernet 
Processor-3 (GBP-3) module on the front within the chassis enclosure.

For instructions on removing and replacing the GBP3 module, see “Replacing a Gigabit Ethernet 
Processor (GBP3) Module” on page 289.

The RS-232 serial port, shown in Figure 10, is used only by field service personnel. Under normal 
circumstances you will not need to access this port.

Figure 10. Front panel (without bezel)

LED Indicators

The primary Light Emitting Diodes (LEDs) visible on the front of the BNP3xr chassis are shown in 
Figure 11. These LEDs indicate the general health of the BNP3xr.

Figure 11. LEDs

Serial port

P3xr

Cfg/Pwr     Fault     Backup
Compact Flash

10/100-1

GigE 1-8 Port Status
(SFPs)

10/100-0

PSU1    PSU2
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Table 2 describes the patterns used by the LED indicators.
 

Table 2. LED indicators 

LED Color Indication

PSU 1  
(left, power input)

Solid Green Power to input of Power Supply 1 is OK.

PSU 1  
(left, power input)

Off Power range to input of Power Supply 1 is incorrect or power 
not present.

PSU 1  
(right, power output)

Solid Green Power from output of Power Supply 1 is OK.

PSU 1  
(right, power output)

Amber Power range from output of Power Supply 1 is incorrect or 
power not present.

PSU2  
(left, power input)

Solid Green Power to input of Power Supply 2 is OK.

PSU2  
(left, power output)

Off Power range to input of Power Supply 2 is incorrect or power 
not present.

PSU2  
(right, power output)

Solid Green Power from output of Power Supply 2 is OK.

PSU2  
(right, power output)

Amber Power range from output of Power Supply 2 is incorrect or 
not present.

CFG/PWR Off No power to chassis

Solid Green Power is OK

Solid Red Chassis is powering up and configuration load is in progress

Fault Solid Green System main process is in wrong state

Blinking Green System status is OK

Blinking Red/Orange Hardware fault or alarm

Backup Solid Green Active or primary chassis

Solid Red/Orange Standby chassis

Compact flasha

a. The compact flash card is necessary for BNP functionality.

Blinking Green FPGA configuration load in progress

Solid Green Compact flash card is OK

Blinking Red Compact flash card not installed

Solid Red Compact flash card error is present

GigE 1-8 Solid Green SFP installed

10/100-0 Solid Green Autonegotiated link status

Blinking Yellow Activity

10/100-1 Solid Green Autonegotiated link status

Blinking Yellow Activity

AC/DC Power On 
Indicator 
(Rear Panel 
Figure 13)

Solid Green AC/DC Power is on

Off No input AC/DC Power

On-Board DC 
Power Status 
(Figure 14)

Solid Green On-board DC power OK

Solid Yellow On-board DC power fault
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Broadcast Network Processor Components

Port Mapping

Figure 12 shows the SFP port location mapping scheme. These port numbers correspond with the port 
LEDs described in “LED Indicators,” above.

Figure 12. Port mapping and LED indicators

Rear Panel 

Figure 13 shows the rear view of the BNP3xr with two network processor (PROC3) and two ASI 
modules installed. The BNP3xr can be configured with different combinations of modules, depending 
on the result you desire.

Figure 13. Rear panel

Port number2 4 6 8

1 3 5 7
Port LEDs

1 2    3 4    5 6    7 8

Network Processor Module (PROC3)

ASI Module

ASI Module

Network Processor Module (PROC3)
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Figure 14 shows the DC power supplies:

Figure 14. DC Power Supply

Configuration Options for PROC3 Combinations

There are a maximum of four modules in each BNP3xr chassis. At least one card must be a processor 
module. Up to three modules can be ASI. 

The right side of the chassis (rear view) holds the power supplies, including the power connectors. The 
redundant power supplies and fans are hot-swappable. For details about replacing the modules and 
power supplies, see Chapter 11, “Field-replaceable Units.”

BNP3xr Component Layout

The BNP3xr consists of four main sections: a network interface module—called the Gigabit Ethernet 
Processor (GBP3) module, two to four network processing modules or Asynchronous Serial 
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BNP3xr Component Layout

Interfaces—called PROC3 or ASI modules, up to two redundant power supplies, and dual redundant 
fan tray modules.

Figure 15. BNP3xr chassis, components visible

The GBP3 module is located underneath the fan trays; its design is shown below in Figure 16

Figure 16. Gigabit Processor - 3 Module
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Rack Mounting the BNP3xr

Caution! Please install the BNP3xr so as to be easily accessible and as close to a power socket outlet 
as possible. 

The BNP3xr requires 2RU of space and is mounted into a standard 19-inch rack using rack mount 
brackets for both the front and rear of the system. 

When choosing the location for the BNP within a rack, make sure that the BNP3xr will be placed 
within the rack evenly, and that the installation will not cause uneven mechanical loading and weight 
distribution. 

Do not mount the BNP3xr into any rack that obstructs clean air flow either in the front or the rear. 
Generally, an aisle of at least 15 inches is the minimum distance to ensure proper air flow.

Caution! Be sure that the BNP3xr is mounted in a location that meets the environmental conditions 
shown in Table 3.

To install the BNP3xr into a rack:

1. Using the provided screws, attach the front rack mount bracket to one side of the chassis as shown 
in Figure 17. 

Figure 17. Front brackets attached

2. Repeat Step 1 on the other side of the chassis.

Table 3. Environmental Requirements

Condition Limits

Storage Temperature -40° to 70° C (-40° to 158° F)

Operating Temperature 0° to 40° C (32° to 104° F)

Humidity 5% to 95% (non-condensing)
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Rack Mounting the BNP3xr

3. Install the chassis rear rack shelf to the rear mounting rails of the rack using two screws on each 
side as shown in Figure 18.

Figure 18. Rack shelf

Secure shelf to rear rails
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4. Install the BNP3xr chassis in the rack. 

The rear edge of the chassis will rest on the rear rack shelf. Secure the front of the chassis to the 
rack using two screws on each side, as shown in Figure 19. 

Figure 19. Mounted BNP3xr

Grounding the BNP3xr

Warning: The BNP3xr must be properly grounded to ensure safe operation. Before you connect 
power or turn on the BNP3xr, ground the chassis. This section provides one method of 
grounding. There may be others: check your network configuration for details.

Warning: If you are installing dual redundant power supplies, only ground one of the two power 
supplies.

To connect the chassis ground:

1. Using a length of wire, terminate one end with a ring lug.

For use with a DC power supply, the grounding wire must be a minimum of 12 AWG.

Two screws 
on each side
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Installing SFP Modules

2. Using the provided M4 nut, install the ring lug on the grounding terminal.

The grounding terminal is at the rear of the BNP3xr chassis, located at the lower left of the power 
supply, just beneath the power supply handle.

Figure 20. Grounding terminal, rear of chassis: AC power supply top, DC power supply bottom

3. Using wire strippers, strip off 3/8 inch of insulation from the other end of the wire.

4. Attach the stripped wire into a grounding hole on the equipment rack.

Installing SFP Modules

For optical output, Small Form Factor 1Gbps (SFP) transceivers comply with the current SFP Multi-
Source Agreement (MSA) Specification.

• GigE interfaces that meet 1000 Base SX specifications support 850 nm wavelengths for distances 
up to 550 meters. 

• GigE interfaces that meet 1000 Base LX specifications support 1310 nm and 1550 nm wavelengths 
for distances up to 70 kilometers.

SFPs approved for use with the BNP3xr are based on the Multi-Source Agreement (MSA) and listed in 
Table 4:

Note: For updates on the latest SFPs and XFPs approved for use with RGB’s products, log in to 
RGB’s Customer Portal and search for the following term: 
 
SFP 
-or- 
XFP

GOOD
AC PWR

GOOD LOCK

100-240V-8.8A,50/60 Hz

Grounding terminal (AC power supply)

Grounding terminal (DC power supply)+ +

INPUT
OK
PWR
OK LOCK

Input 48V DC  22A

Table 4. Supported SFPs 

Manufacturer Part Number Description

Finisar FTLF1519P1BCL SFP 1550nm GigE optical module

Finisar FCMJ-8521-3 1000BaseT Copper SFP Transceiver

Fiberdyne FGE-SFP-T 1000BaseT Copper SFP Transceiver

Avago ABCU-5710RZ SFP 1550nm GigE optical module
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To install an SFP, follow the manufacturer’s instructions. General guidelines to SFP installation 
include:

1. Consider your network and cabling requirements and verify that the SFP you are installing is an 
approved model as described in Table 4.

2. Insert the SFP into the port.

SFPs are keyed so they can only be installed one way.

3. Slide the SFP into the port until it clicks into place and the LED is activated.

Connecting AC Power to the BNP3xr 

Once installed in a rack, connect power to the chassis. 

Before you connect power to the chassis, make sure that the circuit, wiring, and connections that you 
are using to supply the power will not become overloaded by the BNP3xr(s). For power consumption 
details, see “Specifications” on page 293.

Caution!  The power cord is the disconnect device for the BNP3xr. There is no power switch: once 
connected to the power outlet, the unit powers up immediately.

Connect all ports before connecting power. 

To connect AC power to a BNP3xr:

1. Locate the AC power cables included with the BNP3xr chassis.

2. Plug one end of the power cables into the BNP3xr power connectors.

3. The AC power connectors are located on the power supplies.

Figure 21. Connect AC power 

4. Plug the other end of the power cables into the input power sources.

The unit should now have power. Check the LEDs to verify that power has been applied. See “LED 
Indicators” on page 17 for details.

When the BNP3xr is installed and powered on, verify that the Cfg/Pwr LED and the PSU1 and PSU2 
LEDs are solid green. See “LED Indicators” on page 17.

GOOD
AC PWR

GOOD LOCK

100-240V-8.8A,50/60 Hz

GOOD
AC PWR

GOOD LOCK

100-240V-8.8A,50/60 Hz

Power connector, PSU1

Power supply LEDs

Power connector, PSU2

Power supply LEDs
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Connecting DC Power to the BNP3xr

Disconnecting AC Power from the BNP

To remove AC power from the BNP, disconnect the power cables from the power source, that is, pull 
the plug from the power connectors. This is the only way to ensure that the unit is not receiving power.

Connecting DC Power to the BNP3xr

Before Connecting Power

Caution! Only trained personnel should install or replace this equipment.

• Remove all jewelry, including rings, necklaces, and watches. Metal objects will heat up when 
connected to power and ground, and can cause serious injury or weld the metal object to the 
terminals.

• The protective earth connection should be connected before proceeding with the power connection.

• The power cables should be attached to the breaker.

• Confirm that the DC power sources are powered off during installation.

• For a centralized DC power connection, the unit must be installed in a restricted access location in 
accordance with Articles 110-16, 110-17, and 110-18 of the National Electrical Code,  
ANSI / NFPA 70.

• Damage may occur if the power is connected improperly.

Connecting Power

Caution! Make sure that the safety screws are in the locked position (turned counterclockwise) after 
the power supplies are installed, but before connecting power (Figure 22). Note that the 
locked position may be different than that of similar units. This ensures that the power 
supplies cannot be accidentally disconnected, causing possible damage.

Once installed in a rack, connect power to the chassis. 

Before you connect power to the chassis, make sure that the circuit, wiring, and connections that you 
are using to supply the power will not become overloaded by the BNP3xr(s). See “Specifications” on 
page 293 for power consumption details.

Caution! These are +48V DC power supplies, not -48V. Please connect accordingly.

The two inputs to each of the DC power supplies are +48V inputs. If you wish to have redundant 
inputs, connect the inputs to the DC power supply from two different 48V sources. When both 48V 
inputs of each power supply are sourced, each power supply will load share across the inputs, each of 
the inputs drawing half the total power. When one 48V input source fails, the other 48V input will 
draw the full power. If you choose not to have redundant inputs, connect only one of the two inputs to 
one of the DC power supplies and leave the other disconnected.
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Each DC power supply is configured so that the black (top) cable connects to a -48VDC input and the 
red (bottom) cable connects to positive ground. Before connecting any cables, measure the output to 
make sure that you are connecting a -48VDC input to the black cable of the power supply.

Connect all ports before connecting power. 

To connect DC power to a BNP3xr:

1. Cut the provided DC connector cables to the correct length to reach the BNP3xr from the power 
source. 

2. The DC power connectors are permanently attached to the power supplies. Attach the connector 
cables from the power source to the BNP3xr power connectors.

Note: Only one of the two redundant DC power supplies is shown below. The same process 
described in this section applies to the second DC power supply.

Figure 22. Connect DC power

Lock the safety screw

Power connector cables

Two cables for 48VDC redundancy

Two cables for ground redundancy

Connect -48VDC input to black cable

Connect positive ground to red cable
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Connecting External Ports

3. Attach the other end of the power connector cables into the input power source.

The power cables should be attached to an external UL Listed 20 amp circuit breaker.

Figure 23. Connect the power cables

4. To power the unit on, toggle the external circuit breaker to the ON position. There are no circuit 
breakers on the BNP3xr.

The unit should now have power. Check the LEDs to verify that power is connected. See “LED 
Indicators” on page 17 for details.

When the BNP3xr is installed and powered on, verify that the Cfg/Pwr LED is solid green. See 
“LED Indicators” on page 17.

Disconnecting DC Power from the BNP3xr

To remove DC power from the BNP3xr, toggle the circuit breaker to the OFF position, or remove the 
fuse from the fuse panel. This is the only way to ensure that the unit is not receiving power.

Connecting External Ports

The BNP3xr chassis has four discrete types of ports. When connecting ports, be sure to use the correct 
cabling. This section describes the port types and basic cabling, but the actual cabling requirements 
will depend on your specific network configuration and needs. 

Fast Ethernet Management Port 10/100-0

The 10/100BaseT (10/100-0) Ethernet port is used to communicate unencrypted with an external 
console for SNMP configuration control, maintenance diagnostics, status monitoring, fault 
notification, and redundancy switching. The external console can be a workstation on the IP network.

Connect to the 
DC power source
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Fast Ethernet Management Port 10/100-1

The 10/100BaseT (10/100-1) Ethernet port is used to communicate via CA encryption with an external 
console for SNMP configuration control, maintenance diagnostics, status monitoring, fault 
notification, and redundancy switching. The external console can be a workstation on the IP network.

GigE Port

The Ethernet port must be fitted with small-form-factor pluggables (SFPs). See Table 4 for a list of 
tested and approved SFPs that can be used with the BNP3xr.

ASI Port

The number of ASI ports in your BNP3xr chassis depends on the number of ASI cards that are 
installed. Up to three ASI cards can be installed, each with six ports.

Installing the Compact Flash Card

The BNP3xr uses a compact flash card to load software and save configuration information. You 
cannot use your BNP3xr without it.

If the compact flash card was not shipped pre-installed with your BNP, you must install it. Remove the 
flash card from the shipping container and install it into the compact flash slot located on the front of 
the BNP chassis.

If your compact flash card fails, contact technical support for details about flash repair or replacement. 
See page 280 for details on contacting technical support.

Caution! Your license is attached to the compact flash (CF); do not discard it. Even if a CF card fails, 
keep the device and contact RGB technical support for instructions on repair or obtaining a 
working replacement. 
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CHAPTER 4

System Configuration

The BNP is configurable through a Java-based graphical user interface (GUI) available through a 
standard Web browser, or through SNMP using standard network management applications. The easy-
to-use interface offers a variety of features that simplify the set-up and operation of the BNP, including 
program and transport level drag and drop grooming; simultaneous bit rate analysis of input and output 
transport streams and programs; alarms and logs window; scheduled dynamic grooming with start/end 
time and calendar entry; redundancy configuration; and full configurability of ASI and Gigabit 
Ethernet ports. 

This chapter describes how to configure the BNP3xr using the BNP Element Manager. You can also 
use the BNP Element Manager to define and manage network processing as described in Chapter 5, 
“Grooming and PSIP,” and to monitor the BNP system as described in Chapter 9, “Monitoring the 
BNP.”

In This Chapter:

• “Obtaining Java Runtime Environment,” next.

• “Launching the BNP Element Manager” on page 32.

• “Using the Element Manager” on page 34.

• “BNP Element Manager Overview” on page 34.

• “Chassis View” on page 36.

• “Setting the Time Offset Table (TOT)” on page 38.

• “Global Chassis Configuration” on page 41.

• “Ethernet Control Port Configuration” on page 50.

• “GigE Port Configuration” on page 53.

• “Configuring ASI Ports” on page 55.

• “Modifying a Port Name” on page 56.

• “User Authentication ” on page 57 

• “Messaging System Configuration” on page 69.

• “SNMP Configuration” on page 103.

• “Upgrading Software” on page 107.

• “Clearing the Web Start Cache” on page 110.

• “The License Manager” on page 111.

• “Regrooming” on page 114.

• “Stopping All Services” on page 115.

• “Rebooting the System” on page 116.

• “Checking for the BNP Element Manager Version” on page 117.
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Obtaining Java Runtime Environment 

The BNP Element Manager requires that the PC on which it is running have Java™ Runtime 
Environment (JRE) v1.6 or higher. If your PC does not have the correct JRE installed, it is available 
free from the RGB Customer Portal (see below).

Obtaining JRE from the RGB Customer Portal

To obtain installation instructions and the latest version of JRE that is compatible with the BNP 
Element Manager, log in to RGB’s Customer Portal and search for the following term:

Download Java Runtime Environment

Launching the BNP Element Manager
You do not need to install the BNP Element Manager software. It is installed on the BNP at the 
factory, and you connect via the IP address of the BNP.

To launch the BNP Element Manager:

1. Open a browser session on the management workstation or on any computer that has access to the 
BNP. 

The IP address of the workstation being used to access the BNP must be changed to an address on 
the same subnet as the BNP chassis.

2. Enter the IP address of the BNP into the browser’s address field. The default IP address is 10.1.1.1. 

For easier access, bookmark the URL or set it as the home page.

Figure 24. Enter the IP address of the BNP to access
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Launching the BNP Element Manager

3. Click the Launch BNP Element Manager link. 

Figure 25. Launch BNP Element Manager window

Once launched, the window displays the Login Window. Log in as described in “Logging In” on 
page 34.

Figure 26. BNP Element Manager login window (Local login, left; AAA server login, right)
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Using the Element Manager
Use the BNP Element Manager to configure your system, perform grooming and ad insertion, monitor 
system status, and upgrade software as needed. 

Logging In

1. Once you have launched the BNP Element Manager and clicked the login link at the top of the 
page, the login screen appears.

2. The BNP’s IP address automatically populates the IP Address or Host Name field.

3. Select your user account from the User drop-down list, or type the user name if using an AAA 
server for authentication.

4. Enter the corresponding password in the Password field. 

Note: Passwords are case sensitive. To change the password, see “User Authentication ” on 
page 57. To change an AAA server password, refer to the relevant documentation for the AAA 
server being used.

Three levels of user, each with specific access to the system, have permission to use the Element 
Manager. If you log in as a user with limited privileges, any option not available to you is grayed 
out and cannot be selected. User levels include:

5. Click Log in.

By default, the BNP Element Manager now opens to display the Grooming -> Mapping screen.

BNP Element Manager Overview

Element Manager Title Bar

Note: Many of the screens across the BNP Element Manager platform—whether you are using 
BNPxr, BNP2xr, or BNP3xr—will appear exactly the same. For this reason, some figures in 
this manual will not include the title bar. The BNP3xr model title bar is shown below.

Table 5. User levels

User name
Default 
Password Permission

User User Logging in as User provides read-only access. You cannot make any 
changes to the configuration.

Operator Operator Logging in as Operator provides both read and write access. Operators 
can make changes to the configuration. This is the normal login level.

Administrator Admin The Administrator level is typically only used by Field Application 
Engineers and Technical Support personnel, however access can be 
granted to key headend personnel. The Admin has the highest rights and 
can change the password.
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BNP Element Manager Overview

For the BNP3xr model, the title bar appears as follows:

Figure 27. BNP3xr title bar

Element Manager Main Menu and Tabs

Once installed, the BNP Element Manager provides an easy way to configure your BNP system. The 
BNP Element Manager contains the following menus and tabs, which are used to access specific 
screens:

Some primary tabs have subtabs to further refine the view, others use selections that increase the 
granularity of the information shown and provide access to further activities. The primary tabs include:

Status Information

The lowest portion of the BNP Element Manager window provides status information. The 
information displayed depends on the current selection and status of the BNP.

System Name BNP Model IP Address Login Level

Table 6. Element Manager Menus

Menu Use

File Exits the BNP Element Manager.

View Refreshes the currently active window and allows you to choose whether the 
program and grooming information will be displayed.

Maintenance Upgrade software, enter licensing options, change SNMP strings, set up and edit 
Network Information Tables, Time Offset Tables, reboot, system shutdown, 
remove chassis redundancy, and regroom.

DVB-CA Opens the global configuration parameters for setting up a DVB-CA system.

Help Display online help and application information.

Table 7. Element Manager Primary Tabs

Tab Use

Grooming Create and map programming, or monitor bit rates in real time.

Alarms & Events Specified events and alarms can be tracked on this tab. Configure the alarms and 
events to display only the items you are interested in.

Configuration BNP configuration is performed through the subtabs of the Configuration tab. 
These tabs include Global, Ethernet Control Ports, GigE Ports, ASI Ports, User 
Authentication, Messaging System, and SNMP Trap.

Chassis The Chassis tab has no subtabs, but provides a quick overview of the status of 
the BNP. Clicking a port opens port information and configuration dialogs.

DVB-CA Configuration of the DVB Conditional Access encryption features is performed in 
the DVB-CA tab. Subtabs include: CA System and SCG.
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The left section displays the IP address of the BNP to which the BNP Element Manager is connected. 
The right portion of the status bar shows the most recent, highest priority alarm triggered, if one exists. 
Alarms are color-coded for fast identification.

Figure 28. Typical BNP Element Manager status bar

Chassis View

The BNP Element Manager automatically detects the chassis hardware and provides a graphical 
display of the product components and their state, as shown in Figure 29 and Figure 30. The exact 
display that appears will depend upon whether the unit is AC- or DC-powered.

By default, the first port is selected. All active ports appear green on the screen. For easy identification, 
whenever another port is selected, that port’s icon is shown. 

Figure 29. Chassis tab - AC view

4
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Chassis View

Figure 30. Chassis tab - DC view

The information on these screens cannot be changed and is displayed for informational purposes only. 
When you move the cursor over a port on the screen, the cursor changes to a hand, indicating a link. 
Depending on which port is selected, you can see the information about the 10/100 BaseT port 
(Ethernet control), the GigE ports, or the ASI ports. If the selected port is active, it appears green on 
the screen. In Figure 29, for example, the Ethernet Control Port is selected and active.
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The information displayed in the main Chassis Information screens is shown in Table 8. This 
information is available regardless of whether the BNP selected or is the active or standby unit. For 
standby units, however, some configuration options will not be available.

Setting the Time Offset Table (TOT)

The TOT conveys additional information about summer and winter time periods and gives the local 
time offset with respect to UTC for different countries or regions. If the TOT is locally generated, user 
interaction is required to define the country or region in which the receiver is operated.

The BNP supports the required DVB tables, including TOT. To set the TOT time offset:

Table 8. Chassis information window 

Field Description

Chassis Software Version Version of the software currently installed

Chassis Serial No Serial number for the chassis; useful when troubleshooting or contacting 
technical support. The serial number is the same as the 100-BaseT port 
MAC address.

Chassis Up Time Amount of time that the chassis has been continuously accessible

Inside Chassis Temperature The internal junction temperature of the FPGA chip is displayed, enabling 
easy determination that the FPGA die temperature is within acceptable 
limits.

If the value of any component inside the chassis exceeds 100°, an alarm 
is generated.

GBP Serial No Displays the serial number of the Gigabit Processing card.

Power Supply Unit Provides Status and Serial Numbers for both power supply units (PS1 
and PS2). When a power supply is present and operable, status will be 
Present; when a power supply is not present or out of range, status will be 
Not Present. 

Fan Module Provides Status information for FAN1 and FAN2. When a fan is present 
and operating, status will be OK; when a fan is not present or inoperable, 
status will be Failed.

Graphical view of physical 
configuration

A graphical representation of the front and rear of the chassis 
configuration: click on any individual module to display its configuration.

GigE port information Configuration and addresses of the GigE ports; click on the port on the 
graphical representation to view the information.

Ethernet Control ports Configuration and addresses of the Ethernet Control Port; click either 
management port on the graphical representation to view the information.

ASI Port Information Port, direction, and status; click a port on the representation to see details 
about the port.

PROC3 Slot Information Clicking on the card shows: Slot (A, B, C, or D) and Card Serial No. 
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Setting the Time Offset Table (TOT)

1. From the Element Manager, select Maintenance -> Setup Time Offset table(TOT) (Figure 31).

Figure 31. Choosing TOT Time Offset

The window of Figure 32 appears.

Figure 32. TOT Time Offset Window
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Table 9 explains these parameters.

2. Enter the required information and click OK.

Table 9. Tot Time Offset Window Parameters

Field Description

Country Code The three character country code.

Region ID The region identifier, with range 0 to 60. If there is only one time zone in the 
country, this value is zero. Otherwise, the timezones are numbered from 1 
(most easterly) up to 60, (the most westerly).

DST Offset The DST offset: (range is -2:00, -1:30, -1:00, -0:30, 0, +0:30, +1:00, +1:30, 
+2:00). The value is 0: when DST is not applicable; otherwise the offset to be 
applied to current time when DST is in effect.

For instance, in the US, the local time offset when DST is not in effect is -8, 
and when DST is in effect, it is –7. So, the DST offset is +1. polarity is 1 as 
time is behind UTC.

Start Time Indicates when DST takes effect in the current year.

End Time Indicates when DST ends in the current year.

Day 1st, 2nd, 3rd or last Sunday.

Month January - December.

Hour 0-23.

Minute 0-59.
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Global Chassis Configuration

Global Chassis Configuration

To view and configure information that is global to the BNP chassis:

1. From the Element Manager, select Configuration -> Global.

The Global chassis configuration window appears.

Figure 33. Global chassis configuration
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2. Use the fields and selection options to change the global configuration variables.

Table 10 describes the Global Configuration values that can be changed.

Table 10. Global Chassis Configuration Fields  

Category Field Description/Values

System Time Source 
(NTP)

Force Sync Click this button to force synchronization between the 
BNP and the NTP server. This action will prompt for a 
reboot of the BNP. See “NTP Server Force Sync” on 
page 45 for details.

IP Addressa

(Servers 1-5)

Enter up to 5 IP addresses for the NTP server; the first 
field cannot be blank. Enter one per NTP Address 
field.

A green circle to the left of the Server number field 
represents the active NTP server. The lack of a green 
circle would mean the specified server is not active.

Offset (msec) This value shows the difference in milliseconds 
between the reference time and the system clock.

Jitter (msec) This value indicates the magnitude of jitter in 
milliseconds between several time queries.

Time Zone If Internal is selected, choose the time zone from the 
pull-down list.

System Name You can assign a unique system name for this BNP. 
After you click Apply Configuration, this name will 
appear at the top of the screen.

System Log Address Enter the IP address to communicate with a Syslog 
server.



BNP3xr User Guide 43

Global Chassis Configuration

Advanced System 
Parameters

Support SCTE 27 Subtitle 

(Stream Type 0x82)a
SCTE 27 Subtitling defines stream type 0x82 for 
program subtitles and subtitling methods. The default 
value is checked. When unchecked stream type 0x82 
is not treated as a subtitle.

Enable SCTE-21 to 

SCTE-20 Conversionb
Check this box to enable the input program 
conversion of SCTE 21 to both SCTE 21 and 
SCTE 20 closed captioning formats on the output 
program.

Enable PSIP processingc Check this box to enable the BNP to detect PSIP 
tables and pass them from the input to the output. 
PSIP processing is enabled by default. 

PAL Moded Check this box to optimize BNP processing of Phase 
Alternating Line (PAL) content.

• This setting is recommended if most programming 
from the BNP uses PAL.

• This setting is not recommended with progressive 
content.

Optimize Messaging on 

HDe
Check this box when using a 3 to 1 ratio of HD 
programs per transport stream on which messaging is 
enabled. This feature will decrease the PROC3 card’s 
capacity. This box is unchecked by default.

Enable Transparency for 

Messaging Systemf
Check this box to enable transparency filters in the 
Messaging System tab. 

• This box must be checked if you wish to enable 
transparency for Operator Messaging, Advanced 
Messaging, and Logo Overlay in the Configuration  
-> Messaging System tab.

• Checking this box reduces BNP capacityg.

Chassis Redundancy Chassis Active Status Shows the role of the selected chassis: Primary or 
Standby.

Redundancy Switch 
(button)

Interchanges the Primary and Standby in a redundant 
configuration.

Redundant Chassis 
Configuration

 IP Address for 10/100 BNP uses the active/redundant designation for 
failover

• In the Element Manager GUI for the Active chassis, 
enter the IP address of the Standby chassis.

• In the Element Manager GUI for the Standby 
chassis, enter the IP address of the Active chassis.

IP Address for GigE 8 
(Optional)

Enter the IP address of the GigE port if used to pass 
redundancy information.

• When this port is configured with an IP address, 
heartbeat messages will be exchanged on this port.

Table 10. Global Chassis Configuration Fields  (Continued)

Category Field Description/Values
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Virtual IP Address 

Configurationh
IP Address for 10/100 Enter the virtual IP address used by the system to 

manage redundancy for the 10/100 management port.

• This address must be the same on both the active 
and standby chassis as it is shared by both units. 

• This address must be on the same subnet as the 
physical IP address.

• Leave blank if no redundancy system is in place

Gateway for 10/100 Enter the IP address of the gateway (default router) 
that the 10/100 virtual IP should use

• This field is optional.

• This address must be the same on both the active 
and standby chassis as it is shared by both units.

IP Address for ETH 2 Enter the virtual IP address used by the system to 
manage redundancy for the ETH 2 DVB-CA port.

• This address must be the same on both the active 
and standby chassis as it is shared by both units. 

• This address must be on the same subnet as the 
physical IP address for ETH 2.

• Leave blank if no redundancy system is in place

Gateway for ETH 2 Enter the IP address of the gateway (default router) 
that the ETH 2 DVB-CA port should use

• This field is optional.

• This address must be the same on both the active 
and standby chassis as it is shared by both units.

IP Address for GigE (1-8) For each redundant GigE port, (1 through 8) enter the 
IP address shared by the redundant ports. 

• Each GigE port must be on a separate subnet.

Postblack Enable 
Options

AD Server Request Check this to play postblack that an ad server 
specifies be played at the end of an ad. Left 
unchecked, the BNP ignores postblack requests from 
ad servers.

AD Underflows Check this to insert postblack at the end of an ad that 
is shorter than the duration specified by the ad server.

a. It is recommended that at least one NTP server be used with the BNP. An NTP server is required for Digital Program 
Insertion (DPI). It is recommended that the NTP server be up and running prior to booting up and / or configuring the pri-
mary NTP server for the BNP. To force a sync with the NTP server, click the Force Sync button. This will prompt for a 
reboot of the BNP.

b. Checking or unchecking the SCTE-21 to SCTE-20 Conversion box requires a mandatory reboot of the BNP. It is recom-
mended that this flag be configured before any input or output transport stream configuration. 

c. Checking or unchecking the PSIP Processing box requires a mandatory reboot of the BNP. It is recommended that this 
flag be configured before any input or output transport stream configuration.

d. Checking or unchecking the PAL Mode box requires a mandatory reboot of the BNP. It is recommended that this flag be 
configured before any input or output transport stream configuration.

e. Checking or unchecking the Optimize Messaging on HD box requires a mandatory reboot of the BNP. It is recommended 
that this flag be configured before any input or output transport stream configuration.

f. Checking or unchecking the Enable Transparency for Messaging System box requires a mandatory reboot of the BNP. It 
is recommended that this flag be configured before any input or output transport stream configuration. 

g. Please see the latest Release Notes for details on the impact of enabling transparency for load time and bandwidth on 
the BNP.

h. Changing the Virtual IP Address Configuration parameters will require a reboot of the BNP.

Table 10. Global Chassis Configuration Fields  (Continued)

Category Field Description/Values
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Global Chassis Configuration

3. Click Apply Configuration. 

Any time changes are made to a configuration, you must click Apply Configuration to save and 
implement the changes.

4. To interchange the active and standby in a redundant configuration, click Redundancy Switch. If 
you choose to force redundancy, there will be a service interruption of approximately two seconds. 
See “Forcing Redundancy” on page 50.

NTP Server Force Sync

The BNP can be configured to use up to five NTP servers with which the BNP will attempt to 
synchronize. In the event of a significant disparity between the BNP’s time and that of the NTP server, 
the BNP may (by design) take a long time to synchronize with the NTP server. You can manually force 
a quick synchronization between the server and the BNP. 

Forcing a synchronization will prompt for a reboot of the BNP, thus resulting in a service disruption on 
non-redundant BNP configurations. Forced NTP synchronization on non-redundant BNP 
configurations should be conducted during a maintenance window.

To force a synchronization of the BNP with an NTP server, proceed as follows:

1. From the Configuration -> Global menu, click the Force Sync button.

You will be asked if you wish to apply the Force Sync:

Figure 34. Apply Force Sync

2. Click Yes.

The Password Verification window will open.

Figure 35. Reboot Password Verification window
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3. Enter the Administrator password and click OK.

The Reboot confirmation window will open.

Figure 36. Reboot confirmation

4. Click Yes to reboot.

Force Sync on Redundant BNP Systems

To force an NTP server sync in a 1:1 redundancy configuration, proceed as follows:

1. Log into the standby chassis using the physical IP address of the standby BNP.

2. Click on the Configuration -> Global tab.

3. Observe which server is active (a green dot will be next to the active server) and determine if the 
Offset value warrants an NTP sync (offset exceeds +/- 15ms).

Figure 37. Force sync for standby NTP server
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Global Chassis Configuration

4. Click the Force Sync button.

You will be asked if you wish to apply the Force Sync (Figure 34 on page 45).

5. Click Yes.

The Password Verification window of Figure 35 on page 45 will open.

6. Enter the Administrator password and click OK.

The Reboot confirmation window of Figure 36 on page 46 will open.

7. Click Yes to reboot the standby BNP.

8. Allow the standby BNP to reboot and return to its available backup status.

9. Log into the active BNP via its Virtual IP (VIP) address.

10.From the Configuration -> Global window, click the Redundancy Switch button. 

The standby chassis now becomes the active chassis, and vice versa.

11.Log into the new standby BNP (formerly, the active chassis) via its physical IP address.

12.Follow steps 4 through 7 above to Force Sync the new standby BNP.

The new standby BNP will now reboot and return to its available backup status.

Configuring Chassis-level 1:1 Redundancy

Conditions and Restrictions

1. To setup the Virtual IP address for the GigE ports, the 10/100BaseT management port, or the 10/
100BaseT DVB-CA port, you must first have valid physical IP addresses for these ports. 

2. An ad or video server should only send ads or video streams to the virtual IP addresses.

3. Note that with hot-standby 1:1 chassis redundancy configured with virtual IP failover, unicast 
inputs can not be received by both the active BNP and the standby BNP simultaneously. This means 
that unicast stream failover will not be immediate and the standby unit will need to initiate new 
unicast sessions, which will not allow an immediate failover condition for those streams. As an 
alternative, two BNP units without virtual IP coordination could be configured with identical 
streams routed to both units running in parallel with the standby unit output muted.

4. Currently, the BNP does not support the Gigabit Ethernet input port level redundancy. The 1:1 
chassis level redundancy will cover the Gigabit Ethernet input port failure case. The indication of 
the Gigabit Ethernet input port failure includes disconnection of the Gigabit Ethernet cable, loss of 
the Gigabit Ethernet link.

5. When a Gigabit Ethernet port delivers only one program and the program is missing for over 2 
seconds, the 1:1 chassis failover is used, instead of standby program failover.

6. Active and Standby BNPs must use the same software version.

To Configure Redundancy:

Configure the Standby Chassis first:

1. Log in to the Element Manager of the standby chassis as described in “Logging In” on page 34.

2. If you have not already done so, select the Configuration -> Ethernet Control Port menu and 
change the IP Configuration, IP Address, Subnet Mask, and Gateway fields for Ethernet Port 1 and 
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Ethernet Port 2 of the standby chassis to the appropriate parameters for your network. (See 
“Ethernet Control Port Configuration” on page 50 for more information). If you are changing any 
of these parameters, the system must be rebooted, which you will be prompted to do when clicking 
Apply Configuration.

3. From the Element Manager of the standby chassis, select Configuration -> Global.

4. Enter the IP Address for 10/100 of the active chassis’ Ethernet control port as described in 
Table 10, “Global Chassis Configuration Fields,” on page 42. 

5. Under Virtual IP Address Configuration, enter the IP Address for 10/100 that will be shared by 
both active and standby chassis as described in Table 10, “Global Chassis Configuration Fields,” on 
page 42. 

6. Under Virtual IP Address Configuration, enter the IP Address for ETH 2 that will be shared by 
both active and standby chassis of for the DVB-CA management port as described in Table 10, 
“Global Chassis Configuration Fields,” on page 42.

7. Both active and standby chassis must have the same virtual IP (VIP) address: one VIP for the 10/
100 management port and one VIP for the DVB-CA port (ETH 2).

8. Under Virtual IP Address Configuration, enter the IP address in the Gateway for 10/100 field that 
will be shared by both active and standby chassis as described in Table 10, “Global Chassis 
Configuration Fields,” on page 42. 

9. If you are using a virtual gateway (optional), both active and standby chassis must have the same 
virtual gateway for the 10/100 management port.

10.Under Virtual IP Address Configuration, enter the IP address in the Gateway for ETH 2 field that 
will be shared by both active and standby chassis as described in Table 10, “Global Chassis 
Configuration Fields,” on page 42. 

11.If you are using a virtual gateway (optional) for ETH 2, both active and standby chassis must have 
the same virtual gateway for ETH 2.

12.OPTIONAL: If you wish to enable heartbeat messages on the standby chassis, configure the IP 
Address for the GigE 8(Optional) field as described in Table 10, “Global Chassis Configuration 
Fields,” on page 42.

Note: If you configure the GigE 8(Optional) field to enable heartbeat messages and you have 
directly connected the GigE 8 ports (i.e., you are not using a switch or hub to connect the 
ports), you must disable Auto-negotiation for the GigE 8 port on the standby chassis as 
described in “GigE Port Configuration” on page 53 for proper chassis functionality. 

13.Click Apply Configuration.

14.Wait two minutes for the configuration to be saved. During this time, a change will occur to the 
BNP GUI status bar: the addition of an indicator showing Active and Standby BNP IP addresses.

15.Ensure that the standby chassis does not have any license keys associated with it:

• From the main Element Manager window, select Maintenance -> License Manager.

• Confirm there are no entries in any of the License Key fields as described in “The License 
Manager” on page 111. 

• If there are entries in any of these fields, please contact RGB technical support for assistance on 
how to remove the license keys.



BNP3xr User Guide 49

Global Chassis Configuration

16.Shutdown the standby chassis from the Element Manager’s Maintenance -> Shutdown menu.

17.Turn off the standby chassis.

Configure the Active Chassis next:

1. Log in to Element Manager of the active chassis as described in “Logging In” on page 34.

2. From the Element Manager of the active chassis, select Configuration -> Global.

3. Enter the IP Address for 10/100 of the standby chassis’ Ethernet control port. 

4. In the Element Manager configuration for the active chassis, under Virtual IP Address 
Configuration, enter the IP Address for 10/100 that will be shared by both active and standby 
chassis’. 

5. Under Virtual IP Address Configuration, enter the IP Address for ETH 2 that will be shared by 
both active and standby chassis of for the DVB-CA management port.

6. Both active and standby chassis must have the same virtual IP (VIP) address: one VIP for the 10/
100 management port and one VIP for the DVB-CA port (ETH 2).

7. In the Element Manager configuration for the active chassis, under Virtual IP Address 
Configuration, enter the IP address in the Gateway for 10/100 field that will be shared by both 
active and standby chassis’. 

8. If you are using a virtual gateway (optional), both active and standby chassis must have the same 
virtual gateway for the 10/100 management port.

9. Under Virtual IP Address Configuration, enter the IP address in the Gateway for ETH 2 field that 
will be shared by both active and standby chassis. 

10.If you are using a virtual gateway (optional) for ETH 2, both active and standby chassis must have 
the same virtual gateway for ETH 2.

11.Do not configure the IP Address of the GigE 8(Optional) field on the active chassis; this must be 
done on the standby chassis.

Note: If you configure the GigE 8(Optional) field to enable heartbeat messages and you have 
directly connected the GigE 8 ports (i.e., you are not using a switch or hub to connect the 
ports), you must disable Auto-negotiation for the GigE 8 port on the active chassis as 
described in “GigE Port Configuration” on page 53 for proper chassis functionality.

12.Click Apply Configuration.

13.Make sure that the active chassis does have a license key.

14.Turn off the active chassis.

15.Turn on the active chassis. Wait for it to fully boot up.

16.Turn on the standby chassis.
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Forcing Redundancy

Caution! Care is needed when selecting this action: forcing a redundancy change will temporarily 
(and briefly) interrupt services during the failover process.

To force the current redundancy configuration to change (the secondary will become the active, or vice 
versa), click the Redundancy Switch button from the Configuration -> Global tab.

1:1 Redundancy Best Practices and Considerations

The following information must be considered when working with 1:1 chassis-level redundancy:

• The configuration of the standby chassis is not available from the Element Manager while the unit 
is a standby unit.

• Because the virtual subnet mask is not configurable, the virtual IP address must be on the same 
subnet as the physical chassis IP addresses.

• Any changes to the virtual IP address requires a reboot of the active chassis.

• If the connection to the 10/100 control port on the active chassis is broken, both chassis will have 
the same output, unless GigE 8 is configured for heartbeat messages. This can be confusing to the 
network.

• A heartbeat is also sent through the GigE ports.

Ethernet Control Port Configuration

There are two Ethernet control ports for each BNP3xr: one for basic management and access to the 
Element Manager; the other for DVB-CA connectivity and access. To view and configure the Ethernet 
Control Port configuration:



BNP3xr User Guide 51

Ethernet Control Port Configuration

1. From the Element Manager, select Configuration -> Ethernet Control Port.

The Ethernet Control Port configuration window appears.

Figure 38. Ethernet Control Port configuration

2. Table 11 describes the variables that can be changed. Depending on whether you choose a static 
configuration or DHCP for obtaining an IP address to login, the variables may be different. By 
default, a static IP address is used.

Table 11. Ethernet Control Port Configuration Fields 

Category Field Description

IP Configuration Select the source of the BNP boot configuration file from the 
pull-down menu: choices include BOOTP/ DHCP or Static.
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3. Click Apply Configuration to save and load the changes.

Ethernet Port 1a MAC Address A read-only field that displays the MAC address of the 10/100 
management port.

IP Address If static is selected, enter the IP address of the management port 
for the BNP; this field cannot be blank.

Subnet Mask If static is selected, enter the subnet mask of the management 
port for the BNP; this field cannot be blank.

Gateway If static is selected, enter the IP address where management 
packets are routed out of the local network (the default router 
address).

DNS Server If static is selected, enter the IP address of the DNS server being 
used for management of the BNP.

• This field is optional.

Ethernet Port 2b MAC Address A read-only field that displays the MAC address of the DVB-CA 
management port.

IP Address If static is selected, enter the IP address of the DVB-CA 
management port.

Subnet Mask If static is selected, enter the subnet mask of the DVB-CA 
management port.

Gateway If static is selected, enter the IP address where DVB-CA packets 
are routed out of the local network (the default router address).

• If configuring the BNP3xr in a 1:1 redundancy environment, 
the Gateway IP Address must be configured for this port.

DNS Server If static is selected, enter the IP address of the DNS server being 
used for DVB-CA.

• This field is optional.

a. The IP address for Ethernet Port 1 must be on a different subnet from any of the Gigabit Ethernet IP addresses.
b. The IP address for Ethernet Port 2 must be on a different subnet from the IP address of Ethernet Port 1 and any of the 

Gigabit Ethernet IP addresses.

Table 11. Ethernet Control Port Configuration Fields (Continued)

Category Field Description
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GigE Port Configuration

Determining the BNP IP Address for DHCP

If DHCP has been selected to obtain an IP address, the IP address can not be obtained through the 
Element Manager. There are three methods you can use to determine the IP address:

1. Connect to the BNP through the serial console and at a prompt type ifconfig eth0.

or

2. If the DHCP server is available, check the MAC and IP mapping on the DHCP server.

or

3. Use a “sniffer” to sniff the network for DHCP traffic.

Note: If you choose DHCP rather than a static IP address, you will need the assistance of RGB 
Networks customer support. Contact them before you choose DHCP.

GigE Port Configuration

All GigE ports can be configured from the BNP Element Manager. The GigE ports support full duplex 
processing of transport streams; this means that the same GigE port can be used for input and output. 
The GigE Port configuration screen is shown in Figure 39.

Figure 39. GigE Port configuration screen
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To modify a GigE port:

1. From the Element Manager, select Configuration -> GigE Ports.

All GigE ports are shown in a list. For easy identification, the ports appear with a color-coded icon 
to recognize active and inactive ports. Active ports are shown in green.

2. Make any necessary changes to the GigE port configuration. Type the changes directly into the 
appropriate field for the GigE port being modified.

Table 12 describes the variables that can be changed for each GigE port.

3. Click Apply Configuration to apply the changes to your configuration.

Gigabit Ethernet Port Mirroring

Figure 40 shows an example of Gigabit Ethernet port mirroring. Gigabit Ethernet port 6 is mirrored to 
Gigabit Ethernet port 3. This means that all output traffic on Gigabit Ethernet 6 is copied over to 
Gigabit Ethernet 3. The only difference for the traffic coming from Gigabit Ethernet 6 and Gigabit 
Ethernet 3 is the source IP address.

To mirror one GigE port to another:

1. From the Configuration -> GigE Ports menu, click the Set button next to the port that is to be mir-
rored.

Table 12. GigE Port Configuration Fields  

Field Description

Port The GigE port number, listed sequentially.

Status Read-only; the current status of the port.

MAC Address Read-only; the MAC address of the port.

IP Addressa

a. While the Element Manager allows the IP addresses of the GigE ports to be configured in the same subnet, it is recom-
mended that all GigE ports be configured on different subnets for proper routing.

The IP address for the interface; if no IP address is used, leave the field 
empty.

Subnet Mask The subnet mask address.

Default Gateway The default gateway (default router) to use, if applicable.

Mirrored To If the port is mirrored, the port to which the selected port is mirrored 
appears in a read-only field. When you mirror two GigE ports, in the 
event of failure of one, the other one takes over without interruption.

Mirroring Click Set to open a dialog, allowing you to mirror this port.

Autonegotiaton Enable or disable autonegotation.



BNP3xr User Guide 55
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2. From the drop down menu that appears, select the desired port to which the current port is to be 
mirrored.

There is no need to click Apply Configuration as the mirroring happens as soon as the port is 
chosen.

Figure 40. Mirroring GigE ports

This configuration is typically used in Source Specific Multicast deployment with IGMPv3 support. 
The two Gigabit Ethernet ports serve as two different sources for the same video traffic.

Removing Port Mirroring

To remove mirroring from a GigE port, from the GigE port configuration page, locate the mirrored 
port and click Remove from the Mirroring column.

Configuring ASI Ports

The ASI ports on each slot can be viewed from the Configuration tab. Only active slots appear on the 
tab; inactive slots are not shown. Up to four slots are displayed. For each slot, you can see:

• Port: the port number.

• Status: the current status of the port: Active or Inactive.

• Direction: the direction of dataflow on this port: Input or Output. 

Note: In order for the ASI port to be displayed on the Inputs side of the Grooming -> Mapping 
window, the port direction must be Input; in order for the ASI port to be displayed on the 
Outputs side of the Grooming -> Mapping window, the port direction must be Output.
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Use the pull-down list for direction to select or to change the data flow direction of a specific port.

Figure 41. ASI port configuration tab

Modifying a Port Name

You can modify or change a port name for either a GigE or an ASI port. Proceed as follows.

1. From the Inputs or Outputs side of the Grooming -> Mapping window, right click the desired 
port name. The following pop-up menu appears (Figure 42).

Figure 42. Modify Port Name Menu
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User Authentication 

2. Choose Modify Port Name. The Modify Port Name menu appears (Figure 43).

Figure 43. Modifying the Port Name

3. Click OK. The modified port name appears (Figure 44).

Figure 44. Port Name Modified

User Authentication 

The User Authentication screen provides a central area from which user control settings can be 
edited, added, or deleted. The BNP permits both local and remote user authentication. Remote user 
authentication is performed using an authentication, authorization and accounting (AAA) server that 
supports RADIUS or TACACS+. 

The AAA server handles requests for access to system resources to be configured, allowing 
maintenance of user profiles to be performed once for any number of clients. When a client wants to 
access a system resource, it must first get permission from the AAA server. 

The BNP provides a local user fallback authentication method enabling users to log in when an AAA 
server is not available. However, for security and account management reasons, use of AAA is 
recommended. All passwords configured for AAA—both remote and local—are encrypted.

Modified Port Name
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The following workflow (Figure 45) describes the behavior of the authentication process when a user 
attempts to login to the BNP.

Figure 45. BNP User Authentication Workflow
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User Authentication 

The tabs available in the User Authentication screen are: Global, Local, and Servers, seen below in 
Figure 46.

Global Configuration

The Global tab is used to configure global AAA options for the BNP system. To configure Global 
AAA parameters, proceed as follows:

1. From the Element Manager, select Configuration -> User Authentication -> Global.

Figure 46. User Authentication - Global, AAA disabled

2. Check the Enable box to enable and view AAA-related fields.
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The Enable checkbox is used to activate the AAA settings on this screen. If Enable is not checked 
(Figure 46) the AAA server-related fields are hidden and local user authentication will be used. If 
Enable is checked (Figure 47) a specified AAA server will be used to user authentication.

Figure 47. User Authentication - Global, AAA enabled

3. Fill in the fields according to the parameters listed in Table 13.

Table 13 describes the fields available on the Global tab of the User Authentication screen:

Table 13. User Authentication - Global Fields.

These fields are hidden 
when the Enable box 
is unchecked

Field Description

Enable Used to enable authentication using AAA. When checked, the remaining fields in this 
table will appear.

Default is unchecked.

Number of Retries The number of times the system will try connecting to a remote server before trying 
another server in the list.

Default is 0. Valid range is from 0 to 2.

Timeout (sec) The amount of time (in seconds) to wait for a response from the remote server.

Default is 2. Valid range is from 1 to 4.
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4. Click the Apply Configuration button to save changes.

Local Configuration

The Local tab permits the Administrator to configure the local user account passwords for the BNP 
system. To configure passwords for the local login, proceed as follows:

1. From the Element Manager, select Configuration -> User Authentication -> Local.

Figure 48. User Authentication - Local

Protocol The preferred protocol to use in selecting a server.

Valid options are:

• Radius - Try all RADIUS servers before trying TACACS+ servers.

• TACACS+ - Try all TACACS+ servers before trying RADIUS servers.

Default is Radius.

Remote Only Checking this box will require the BNP to use only remote authentication. If enabled 
and remote authentication fails or connection with the AAA server is not established, 
local authentication is not performed and the user is not logged in.

Default is unchecked.

• At least one AAA server must first be configured before the Remote Only option is 
checked and the configuration applied to the BNP. See “Server Configuration” on 
page 62 for details on configuring an AAA server.

Field Description
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The fields in the Local screen are used to manage the three local user account passwords. These 
settings only apply if AAA is disabled or the AAA server is unreachable, and Remote Only is not 
enabled.

2. From the User drop down box, select the user whose password you wish to modify.

3. In the Old Password field, type in the existing password for the account.

4. In the New Password field, type in the new password.

5. In the Retype New Password field, retype the new password.

Note: Passwords are case sensitive. They may be composed of alphanumeric and most special 
characters.

Table 14 describes the fields available in the Local screen.

Table 14. Local User Accounts:

6. Click the Change Password button to save changes. New passwords will be effective the next time 
the user account is used to log into the Element Manager.

Server Configuration

The Servers tab is used to set up and configure AAA servers for the BNP system to use.

Field Description

User Read-only access account. No changes to the configuration are allowed.

• Default password is: User

• Passwords are case-sensitive.

Operator Read and write access are allowed for all configuration operations except changing 
passwords.

• Default password is: Operator.

• Passwords are case-sensitive.

Administrator Full access to the BNP system configuration is allowed. This is the only user account that 
is authorized to change passwords.

• Default password is: Admin.

• Passwords are case-sensitive.
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From the Element Manager, select Configuration -> User Authentication -> Servers.

Figure 49. User AUthentication - Servers

The Servers tab lists the currently configured AAA servers that are to be used by the BNP system for 
user authentication. From here AAA servers can be added, edited, or reordered.

Note: When deleting an AAA server, it may be necessary to reorder the list of servers so that the 
desired server may be deleted in descending order. For instructions on changing the server 
order, see “Server Order Behavior” on page 67.

Adding or Editing AAA Servers

The Edit AAA Server dialog is used both to add new AAA servers or to edit existing AAA servers. 
The system allows up to eight AAA servers.

To add a server, proceed as follows:
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1. From the Servers tab, click Add.

The Edit AAA Server window will open:

Figure 50. Add AAA Server

2. Fill out the fields according to the parameters in Table 15. 

3. If this server is to be available for the BNP to use when logging in via AAA, you must check the 
Enable field.

Note: At least one AAA server must be enabled when the Remote Only option is selected from the 
AAA Global Configuration menu. See “Global Configuration” on page 59 for more 
information.

Editing an AAA Server

To edit an AAA server, proceed as follows:
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1. From the Servers tab (Table 49) highlight the desired AAA server to edit and click the Edit button.

The Edit AAA Server window will open.

Figure 51. Edit AAA Server

2. Edit the fields according to the parameters listed in Table 15 below.

3. Click the Apply button to save changes and modify the server.

Table 15 describes the fields available in the Edit AAA Server dialog.

Table 15. User Authentication - Servers - Add/Edit Server Fields

Reordering Server List

The Servers tab is used to change the order in which the BNP system looks for AAA servers. To set 
the server order, proceed as follows:

1. From the Element Manager, select Configuration -> User Authentication -> Servers.

Field Description

IP Address The IP address of the AAA server.

When adding a server, default is blank.

When editing a server, this field is read-only.

Port Enter the TCP port to use on the AAA server. Valid range is: 0 to 65535.

Default for Radius is 1812.

Default for TACACS+ is 49.

Protocol Select the authentication protocol from the drop-down box to use when 
communicating with the AAA server. Choose between Radius and TACACS+.

Default is Radius.

Shared Secret Enter the password or passphrase used to authenticate with the AAA server.

Retype Shared Secret Re-enter the password or passphrase used to authenticate with the AAA server.

Enable Check this box to enable the AAA server. If an AAA server is not enabled, it will not 
be available for the BNP to use when logging in via AAA.
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2. Click on the Apply button.

Figure 52. Edit AAA Server Order

3. In the Change Order to field, enter the new order of the AAA servers. Figure 53 shows an 
example:

Figure 53. Edit AAA Server Order - modified
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4. Click Apply to save changes.

The new server order will be displayed in the Servers tab as shown in Figure 54 below:

Figure 54. New Server order

Table 16 describes the fields available in the Edit AAA Server Order menu

Table 16. User Authentication - Servers - Edit AAA Server Order Fields.

Server Order Behavior

The order in which the system attempts to connect to an AAA server is based on the following:

• The preferred authentication protocol specified in the Protocol field of the User Authentication -> 
Global tab;

• The current server order as shown in the Order column of the User Authentication -> Servers tab.

If the preferred authentication protocol is set to Radius, all Radius servers will be tried first, followed 
by TACACS+ servers. If set to TACACS+, all TACACS+ servers will be tried first, followed by 
RADIUS servers.

For example, if four AAA servers have been added to the AAA server list (see Table 17) and the 
specified protocol preference is Radius, the order in which the servers are tried is A, D, B, C.

Field Description

Current Order Displays the current server order. The default server order is the order in which the 
AAA servers were added to the list. This field is read-only.

Change Order To The new server order to use.

• Separate each number with one space.

• The same number of servers must be entered that are listed in the current order 
field. For example, if there are 5 servers listed in the Current Order field, changing 
the order to 1 2 4 3 would be invalid; changing the order to 1 2 4 3 5 is valid.
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Table 17. AAA Server List Example

Deleting Servers

To delete an AAA server, proceed as follows:

1. From the Element Manager, select Configuration -> User Authentication -> Servers.

2. Select the highest numbered AAA server from the Order column (see Figure 49 on page 63) and 
click the Delete button.

The Delete Confirmation window will be displayed:

Figure 55. Server deletion confirmation

3. Select Yes to delete the server.

Note: The Servers tab will only allow deletion of a server in descending order. For example, if there 
are four servers in the order of 1, 2, 3, 4, the order in which the servers must be deleted is 
4 3 2 1.

To delete a server whose order is not last, reorder the servers to change the desired deletion to the last 
number in that order.

AAA Server
Current Server
Order Protocol

A 1 RADIUS

B 2 TACACS+

C 3 TACACS+

D 4 RADIUS



BNP3xr User Guide 69
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Messaging System Configuration

The Configuration -> Messaging System tab allows you to configure parameters for the BNP to 
integrate with external messaging systems, insert operator messages directly from the BNP GUI, or 
configure the BNP to use external text or graphic files as overlay messages. You can also configure the 
BNP to insert a graphics file (PNG) into one or more programs as a digital logo overlay. To configure 
these features you must create specific Messaging or Logo Overlay zones under the Messaging 
System tab, which are then associated to desired programs through the Grooming -> Mapping tab. 
This section describes how to create both Messaging and Logo Overlay zones. See “Show Program 
List” on page 99 for instructions on how to associate and enable programs to Messaging or Logo 
Overlay zones.

Messaging Zones

Up to ten Messaging Zones can be configured for the BNP. Within each zone, two types can be 
configured: EAS or Operator and Advanced. A Messaging Zone may be sent either SCTE 18 alerts 
that are used for EAS Messaging, Operator Messaging based on operator-defined text, or Advanced 
Messaging created from imported graphics (.PNG) or text files, and advanced text parameters. 

 From the Configuration -> Messaging System tab, select the Messaging Zones subtab.

The Messaging Zones subtab (Figure 56) provides a snapshot view of all messaging zones. It also 
provides a global parameter associated only with EAS messaging for system-wide configuration of 
audio EAS override during DPI.

Figure 56. Configuration -> Messaging System tab
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Table 18 describes the fields available from the Messaging Zones subtab.

EAS Messaging Zones

The BNP Digital EAS feature supports the SCTE 18 (2007) “Emergency Alert Messaging for Cable” 
standard specification for EAS message control and display, which defines the standard for playout of 
text message crawls and audio during an emergency alert event. Using the 10/100 BaseT management 
interface, the BNP supports the following SCTE 18 messages:

• EAS text crawl;

• EAS text crawl with audio override;

• Substitute EAS detail channel for the network feed.

Table 18. Messaging Zones subtab 

Field Description

Reject EAS audio 
override during DPI

When checked, the BNP will reject all external SCTE 18 EAS messages with audio 
override priority for the duration of an ad insertion (text crawling will still continue). 

Zone Index The sequential index number of the created zone.This field is read-only. Up to ten 
zones can be added.

Zone Type Displays what type of zone has been created. Choices are: EAS or Operator and 
Advanced Messaging.

Zone Status

(for EAS Messaging 
Zones)

The status of the Messaging Zone. This field is read-only. If the zone is an EAS 
Messaging Zone, possible choices are:

• Enable: EAS Zone is ready for SCTE 18 EAS message.

• Emergency Alert Crawl On: SCTE 18 EAS alert activated, text crawl is 
displaying.

• Emergency Alert Audio Override: SCTE 18 EAS alert activated with 
Priority 1-14, emergency audio is playing, text crawl will be present.

• Emergency Alert Video Switch: SCTE 18 EAS alert activated with Priority 15, 
emergency video is playing.

Zone Status

(for Operator or 
Advanced Messaging 
zones)

The status of the Messaging Zone. This field is read-only. If the zone is an 
Operator or Advanced Messaging Zone, possible choices are:

• Enable: Messaging zone is ready to start Operator messaging or Advanced 
Messaging operations.

• Operator Messaging Loaded: Operator message is loaded on the BNP and is 
ready to start the operator message. 

• Operator Messaging Text On: Operator Alert Message is loaded on the BNP 
and crawl text is displaying in the zone. 

• Advanced Messaging Loaded: Text or graphic file is loaded on the BNP and 
ready to play. 

• Advanced Messaging On: Advanced Messaging is loaded on the BNP and 
imported graphic and/or text crawl is displaying in the zone 

• Scheduled: Operator Messaging or Advanced Messaging has been loaded and 
scheduled, but currently is not being played. 

Zone Name The name of the zone. This field is read-only and is created when adding or 
modifying a new Messaging Zone.

UDP The UDP port used to detect an external SCTE 18 EAS server message. This field 
is read-only and is populated when adding or modifying a new EAS Messaging 
Zone. If the zone is Operator or Overlay this field will display “N/A”.
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The BNP will respond to any EAS alert based on the following SCTE 18-defined alerts:

• Levels 1-14: The BNP delivers a text crawl and allows adherence to the SCTE 18 specification to 
override the audio source on defined channel with text information and encoded audio sources from 
the EAS system.

• Level 15 (highest priority): The BNP offers user configuration to allow adherence to the SCTE 18 
specification to override both video and audio on a detailed channel with the encoded service 
provided by the EAS system, or to use the same configuration options for Levels 1-14.

- The BNP will force tune to the detailed channel for H.264 and treat it as a data program.

The BNP communicates with an external EAS management system for messaging zone control 
information, including interpretation of FIPS (Federal Information Processing Standards) 
announcements. Additionally, user configurable audio muting and audio override of the network 
program's audio is supported.

To configure a new EAS Messaging zone:

Note: You must be logged in as the Administrator to add, modify, or delete Messaging Zones 
configuration.

1. From the Configuration -> Messaging System tab, click on the Messaging Zones subtab.

2. Right-click anywhere on the white or light blue rows.

Figure 57. Messaging Zone pop-up window

3. Select Add EAS Messaging Zone from the pop-up menu (Figure 57).
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4. The Add EAS Messaging Zone window of Figure 58 opens:

Figure 58. Add EAS Messaging window

5. Fill out the appropriate fields according to your desired configuration.

Table 19 provides a description of the fields available in the Add / Modify EAS Messaging Zone 
menu.

Table 19. Add / Modify EAS Messaging Zone menu 

Section Field Description

Zone Index Zone Name Assign a unique name for the zone to be created. 
This field accepts alphanumeric entries.

Up to ten Messaging Zones may be created; these 
may be a mix of EAS or Operator and Advanced 
zones. 
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EAS Video Configuration

(This defines the EAS 
video source parameters 
for substituting over the 
network program due to 
alert status or audio 
override option.)

Port Select desired GigE or ASIa port from the pull down 
menu on which detailed channel information 
(transport stream) is received for EAS messaging.

IP Address The IP address of the GigE port. Input a valid 
multicast IP address on which the detailed channel 
transport stream is received for EAS messaging. 
(Not required for ASI ports.)

Source IP Address The IP address of the source from which the GigE 
port receives data; the source IP address is 
optional and should only be included for IGMPv3 
transport streams. (Not required for ASI ports.)

UDP Port Input a valid UDP port on which the detailed 
channel transport stream is received for EAS 
messaging. Valid range is from 1 to 65535. (Not 
required for ASI ports.)

Program Number Input the program number on which the program 
information is received for EAS messaging.

Audio Override Delay (In 
Secs)

Specifies the delay of audio splicing of the EAS 
program by x number of seconds. Range is from 0-
255. A setting of 0 specifies no delay.

EAS Zone Control 
Configuration

UDP Port Input the UDP port which will be used to detect an 
external SCTE 18 EAS server message. The 
typical port number used for this is 5050. 

• SCTE 18 zone specific messaging will vary by 
UDP port configuration.

• A unique UDP port should be configured for each 
EAS zone.

PID Choice of two hexadecimal values as defined by 
the SCTE 18 standard. Choose which value 
corresponds to your server: 

0x1FFB or 0x1FFC

Crawl Only Priority Sets the threshold at which program audio will be 
overridden by an external EAS source. 

• If the SCTE 18 message is less than or equal to 
the value set here, then audio override will not 
occur. 

• If the SCTE 18 message is higher than this level, 
but lower than priority 15, audio override will 
occur. 

• If the SCTE 18 message is priority 15, then all 
output programs configured to receive EAS 
messaging are tuned to the emergency channel 
and the audio and text crawl is overridden. 

• If priority is set to 0, then no SCTE 18 messages 
will be set to Crawl Only.

Table 19. Add / Modify EAS Messaging Zone menu (Continued)

Section Field Description
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EAS Crawl Configuration Crawl Position Select the location on the end user’s TV screen in 
which the crawl text will appear. Choices are: 

Top, Middle, Bottom.

For details on crawl positioning, see Table 20.

Crawl Speed Select the speed at which text will crawl across the 
end user’s TV screen. Choices are:

Fast, Normal, Slow.

Crawl Background Color Select the background color on which the crawl text 
will be displayed. Choices are:

Red, Green, Blue, Black.

EAS Zone Status Start Time Read-only field. Displays the day, date, and time 
that the crawl has or will begin. Applies to both 
external SCTE 18 EAS server and Operator Alert 
messages.

Remaining Time Read-only field. If a limit was placed on the duration 
of the alert (either in the Operator-defined Crawl 
Duration field or from the external SCTE 18 EAS 
server), the time remaining is displayed here.

Event Duration Read-only field. Displays how long the event is to 
take place.

Current Status This field is read-only and will display one of the 
following values:

• Enable

• Emergency Alert Crawl On

• Emergency Alert Audio Override

• Emergency Alert Video Switch

See Table 18 for a complete description of these 
values.

Priority Read only field. This field will display the EAS 
message priority (1-15). 

Alert Text Read only field. Displays the EAS message alert.

Action Buttons at bottom of 
screen

Show Program List Clicking this button will open the Show Program List 
window, which displays all programs associated for 
the specified zone. 

• This button only appears when modifying a zone, 
and not when creating a zone.

Enable Status Update / 
Disable Status Update

Clicking this button will enable real-time polling of 
the Zone Status fields as well as any Operator-
defined text crawls.

• When the Enable Status Update button is clicked 
and real-time polling enabled, the button will 
change to Disable Status Update. Clicking the 
Disable Status Update button will disable real-
time polling.

• This button only appears when modifying a zone, 
and not when creating a zone.

a. The applicable ASI port (if selecting) must have been configured as an input port in order to appear in the pull down menu

Table 19. Add / Modify EAS Messaging Zone menu (Continued)

Section Field Description
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Table 20, below, describes how the BNP displays crawl positioning with various resolutions:

6. Click Apply to save changes and create the messaging zone.

To modify an EAS Messaging Zone:

1. From the Messaging System -> Messaging Zones subtab, double-click the EAS messaging zone 
you wish to modify, or right-click EAS the zone and select Modify Messaging Zone from the pop-
up menu (Figure 57).

2. The EAS Messaging Zone ([Zone Index]:[Zone Name]) window opens.

Figure 59. Modify EAS Zone

3. Modify the desired fields according to the parameters listed in Table 19.

4. Click Apply to save changes to the messaging zone.

Table 20. Crawl Positioninga

a. Positioning is in pixels, from top of screen to top of crawl. Crawl Height is also in pixels.

Resolution Crawl Height Top Middle Bottom

480 SD 48 32 208 384 

576 SD 48 48 256 464

750 HD 80 64 320 576

1080 HD 80 96 496 896
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To Delete an EAS Messaging Zone:

1. From the Configuration -> Messaging System -> Messaging Zones menu, highlight and right-
click on the EAS Messaging Zone you wish to delete.

2. Select Delete Messaging Zone from the pop-up menu (Figure 57). 

3. If there are no output transport streams associated with the selected zone, you will be asked to 
confirm deletion and the zone will be deleted.

4. If there are output transport streams associated with the selected zone, the following message 
appears:

Figure 60. Delete Output TS-associated messaging zones

5. Click Yes to delete the zone and its association to any programs.

Operator and Advanced Messaging Zones

The BNP Messaging System feature supports Operator and Advanced Messaging Zones, which allows 
the cable operator to generate a text crawl of up to 400 characters in length directly from the BNP 
Element Manager or to specify a text or graphic file as an overlay. Both Operator and Advanced zones 
can be associated to individual programs. This capability is only allowed using Administrator login 
privileges. 

Note: An Advanced Overlay license must be purchased in order to view or configure an Advanced 
Messaging Zone. For more information on Advanced Overlay licensing, see “The License 
Manager” on page 111.

Note: SCTE 18 EAS messages take precedence over Operator and Advanced Alert Messages. The 
latter can not be sent to a program that has an active SCTE 18 message alert. An SCTE 18 
message alert sent to a zone will immediately override any current GUI generated alert 
message playout.

To configure an Operator Messaging Zone:

Note: You must be logged in as the Administrator to add, modify, or delete Messaging Zone 
configuration.

1. From the Configuration -> Messaging System tab, click on the Messaging Zones subtab.
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2. Right-click anywhere on the white or light blue rows.

Figure 61. Messaging Zone pop-up window

3. Select Add Operator and Advanced Messaging Zone from the pop-up menu (Figure 61).

The Add Operator and Advanced Messaging Zone window opens (Figure 62).

4. Click the Operator Messaging tab.

Figure 62. Add Operator and Advanced Messaging Zone - Operator Messaging tab
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5. Fill out the appropriate fields according to your desired configuration.

Table 21 provides a description of the fields available in the Operator Messaging tab of the Add / 
Modify Operator and Advanced Messaging Zone menu.

Table 21. Operator Messaging tab 

Section Field Description

Zone Name Zone Name This field is common to both Operator and Advanced 
tabs.

Up to ten Messaging Zones may be created; these 
may be a mix of EAS or Operator and Advanced 
zones. 

Crawl Configuration Crawl Position Select the location on the end user’s TV screen in 
which the crawl text will appear. Choices are: 

Top, Middle, Bottom.

For details on crawl positioning, see Table 20.

Crawl Speed Select the speed at which text will crawl across the 
end user’s TV screen. Choices are:

Fast, Normal, Slow.

Crawl Background Color Select the background color on which the crawl text 
will be displayed. Choices are:

Red, Green, Blue, Black.

Background 
Transparency Level

Specifies the level of transparency in which the 
background color will be displayed. At 0%, the 
background color will be opaque; at 100% there will 
be no background color. 

You may type in any value from 0 to 100 or choose a 
value from the drop-down box as follows: 

0% (opaque), 25%, 50%, 75%, and 100%

NOTE: This box will not display unless Transparency 
was enabled in the Global Configuration window. 
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Crawl Text, Duration, & 
Frequency

Crawl Text Input the desired alert message up to 400 
alphanumeric characters.

Crawl Duration This section provides the following options for the 
duration of the text crawl:

• One Cycle: Plays the full message one time all the 
way through.

• Play xxx Seconds: Plays the message for the 
specified number of seconds (with a 5 second or 
one cycle minimum). Message will play for the 
duration that is longest: Specified value of seconds 
OR one cycle.

• Continuous: Continuously plays message until the 
Stop Crawl button is clicked.

Frequency Choose between two options for how often message 
is played:

• Once: Plays message once, either for one cycle or 
specified number of seconds (see above).

• Every: Select either 30 or 60 to play message every 
thirty or sixty minutes, either for one cycle or for 
specified number of seconds (see above) from the 
moment Start is clicked until the moment Stop is 
clicked.

Schedule Start The BNP permits you to start a message immediately 
or schedule it. 

• Now: Starts play immediately. 

• Time: Allows you to schedule start time. Click on 
the pulldown arrow to display a popup window 
(seen in Figure 63 on page 81) to set start. 

Stop • Forever: If message is set to play once (see 
Frequency, above) this is the default. 

• Time: When Frequency is set to every 30 or 60 
minutes, the Scheduler popup is enabled. Click on 
the pulldown arrow to display (see Figure 63 on 
page 81) and set. 

Table 21. Operator Messaging tab (Continued)

Section Field Description
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6. Click Apply to save changes and create the messaging zone.

To Schedule Messaging in Advance :

1. Click the Time button. 

Zone Status Start Time Read-only field. Displays the day, date, and time that 
the crawl has or will begin. 

Remaining Time Read-only field. If a limit was placed on the duration of 
the alert, the time remaining is displayed here.

Event Duration Read-only field. Displays how long the event is to take 
place.

Current Status This field is read-only and will display one of the 
following values:

• Enable

• Operator Messaging Loaded

• Operator Messaging Text On

• Advanced Messaging Loaded

• Advanced Messaging On

• Scheduled 

See Table 18 on page 70 for a complete description of 
these values.

Next Start Time Read-only field. Displays the time that the next round 
of messaging will begin.

Overlay Image Read-only field. Applicable to Advanced Messaging 
tab. Displays the status of the graphic and/or text 
overlay. Possible values are:

• Complete: An image or text file has been uploaded 
to the BNP.

• None: No image or text file has been uploaded to 
the BNP.

Action Buttons at bottom 
of screen

Show Program List Clicking this button will open the Show Program List 
window, which displays all programs associated for 
the specified zone. 

• This button only appears when modifying a zone, 
and not when creating a zone.

Enable Status Update/ 
Disable Status Update

Clicking this button will enable real-time polling of the 
Zone Status fields as well as any Operator-defined 
text crawls.

• When the Enable Status Update button is clicked 
and real-time polling enabled, the button will 
change to Disable Status Update. Clicking the 
Disable Status Update button will disable real-time 
polling.

• This button only appears when modifying a zone, 
and not when creating a zone.

Table 21. Operator Messaging tab (Continued)

Section Field Description



BNP3xr User Guide 81

Messaging System Configuration

2. Click the pulldown arrow in the Time field. The Advanced Messaging Schedule Window 
appears. 

3. Click the Month, Day, and Time fields to schedule the message. 

4. Press OK. 

Figure 63. Advanced Messaging Schedule Window

To modify an Operator Messaging zone:

1. From the Messaging System -> Messaging Zones subtab, double-click the messaging zone you 
wish to modify, or right-click the zone and select Modify Messaging Zone from the pop-up menu 
(Figure 57 on page 71). 
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2. The Operator and Advanced Messaging Zone ([Zone Index]) window below opens.

Figure 64. Modify Operator Messaging Zone

3. Modify the desired fields according to the parameters listed in Table 21 on page 78.

4. Click Apply to save changes to the messaging zone.

To configure an Advanced Messaging Zone:

Note: You must be logged in as the Administrator to add, modify, or delete Messaging Zone 
configuration.

Note: An Advanced Overlay license must be purchased in order to view or configure an Advanced 
Messaging Zone. For more information on Advanced Overlay licensing, see “The License 
Manager” on page 111.

1. From the Configuration -> Messaging System tab, click on the Messaging Zones subtab.
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2. Right-click anywhere on the white or light blue rows.

Figure 65. Messaging Zones pop-up window

3. Select Add Operator and Advanced Messaging Zone from the pop-up menu (Figure 65).

4. The Add Operator and Advanced Messaging Zone window of Figure 66 opens.

5. Click the Advanced Messaging tab.

Figure 66. Advanced Messaging Zone tab
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6. Fill out the appropriate fields according to your desired configuration.

Table 22 provides a description of the fields available in the Advanced Messaging tab of the Add / 
Modify Operator and Advanced Messaging Zone menu.

Table 22. Advanced Messaging tab 

Section Field Description

Zone Name Zone Name This field is common to both Operator and Advanced 
tabs.

Up to ten Messaging Zones may be created; these 
may be a mix of EAS, Operator, or Advanced zones. 
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Overlay Crawl 
Configuration

Foreground Color Specifies the foreground color of the imported text file. 
Click the Select Color button to choose which color 
and color scheme to use.

Background Color Specifies the background color of the imported text 
file. Click the Select Color button to choose which 
color and color scheme to use.

Crawl Position Select the location on the end user’s TV screen in 
which the imported crawl text or graphic will appear. 
Choices are: 

Top, Middle, Bottom.

For details on crawl positioning, see Table 20 on 
page 75.

Background 

Transparency Levela
Specifies the level of transparency at which the 
background color will be displayed for ASCII and Non-
Ascii text. At 0%, the background color will be opaque; 

at 100% there will be no background colorb. 

• You may type in any value from 0 to 100 or choose 
a value from the drop-down box as follows: 

• 0% (opaque), 25%, 50%, 75%, and 100%.

NOTE: This box will not be displayed unless 
Transparency was enabled in the Global 
Configuration window. 

Crawl Speed Select the speed at which the imported text or graphic 
will crawl across the end user’s TV screen. Choices 
are:

Fast, Normal, Slow.

Font Choose the font in which the imported or typed text 
should be displayed. Click the Select Font button to 
choose font style, size, and attributes.

Text Input the desired alert message up to 400 
alphanumeric characters, or use the Import Text 
button to select a text file from the hard drive of the 
computer on which the Element Manager is running. 
The text file will then be uploaded to the BNP’s 
memory. 

Graphic Displays the name of the .PNG file being used for 
overlay crawl. If no file has been specified, this field 
will be blank. To select a graphic file as an overlay 
crawl, click on the Import Graphic button and choose 
a .PNG file from the local computer on which the 
Element Manager is running. The graphic will be 
uploaded to the BNP’s memory when Apply is clicked. 

Table 22. Advanced Messaging tab (Continued)

Section Field Description
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Preview, Crawl 
Resolution, Crawl 
Duration, and Frequency

Previewc Allows you to choose in which order the overlay (if 
using both text and graphics) will appear. Choose 
from:

Graphic+Text: Graphic on the left, text on the right

Text+Graphic: Text on the left, graphic on the right

NOTE: The Background Transparency setting only 
applies to the text portion (ASCII or Non-ASCII) of the 
overlay.

Crawl Resolution Allows you to choose at which resolution the overlay 
will appear. Choose from:

SD (Wx48): Standard definition, width of overlay by 48 
pixels in height.

HD (Wx80): High definition, width of overlay by 80 
pixels in height.

Crawl Duration This section provides the following options for the 
duration of the text crawl:

• One Cycle: Plays the full message one time all the 
way through.

• Play xxx Seconds: Plays the message for the 
specified number of seconds (with a 5 second or 
one cycle minimum). Message will play for the 
duration that is longest: Specified value of seconds 
OR one cycle.

• Continuous: Continuously plays message until the 
Stop Crawl button is clicked.

Frequency Choose between two options for how often message 
is played:

• Once: Plays message once, either for one cycle or 
specified number of seconds (see above).

• Every: Select either 30 or 60 to play message every 
thirty or sixty minutes, either for one cycle or for 
specified number of seconds (see above) from the 
moment Start is clicked until the moment Stop is 
clicked.

Schedule Start The BNP permits you to start a message immediately 
or schedule it. 

• Now: Starts play immediately. 

• Time: Allows you to schedule start time. Click on 
the pulldown arrow to display a popup window 
(seen in Figure 63 on page 81) to set start.

Stop • Forever: If message is set to play once (see 
Frequency, above) this is the default. 

• Time: When Frequency is set to every 30 or 60 
minutes, the Scheduler popup is enabled. Click on 
the pulldown arrow to display and set (see 
Figure 63 on page 81).

Table 22. Advanced Messaging tab (Continued)

Section Field Description
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7. Click Apply to save changes and create the messaging zone.

Zone Status Start Time Read-only field. Displays the day, date, and time that 
the crawl has or will begin. 

Remaining Time Read-only field. If a limit was placed on the duration of 
the alert, the time remaining is displayed here.

Event Duration Read-only field. Displays how long the event is to take 
place.

Current Status This field is read-only and will display one of the 
following values:

• Enable

• Operator Messaging Loaded

• Operator Messaging Text On

• Advanced Messaging Loaded

• Advanced Messaging On

• Scheduled 

See Table 18 on page 70 for a complete description of 
these values.

Next Start Time Read-only field. Displays the time that the next round 
of messaging will begin.

Overlay Image Read-only field. Displays the status of the graphic 
and/or text overlay. Possible values are:

• Complete: An image or text file has been uploaded 
to the BNP.

• None: No image or text file has been uploaded to 
the BNP.

Action Buttons at bottom 
of screen

Show Program List Clicking this button will open the Show Program List 
window, which displays all programs associated for 
the specified zone. 

• This button only appears when modifying a zone, 
and not when creating a zone.

Enable Status Update / 
Disable Status Update

Clicking this button will enable real-time polling of the 
Zone Status fields as well as any Operator-defined 
text crawls.

• When the Enable Status Update button is clicked 
and real-time polling enabled, the button will 
change to Disable Status Update. Clicking the 
Disable Status Update button will disable real-time 
polling.

• This button only appears when modifying a zone, 
and not when creating a zone.

a. The Background Transparency Level setting in the Advanced Messaging tab is applicable only to ASCII and Non-ASCII 
text characters. Background Transparency Level is not applied to graphic overlays within text crawls. Alpha Channel 
Transparency settings for the graphic overlay, if present in the .PNG file, will be preserved.

b. Please see the latest Release Notes for details on the impact of enabling transparency for load time and bandwidth on 
the BNP.

c. When importing a .PNG or .TXT file for the first time, the graphic will appear in the Preview box; however, after the 
graphic has been uploaded to the BNP and the Advanced Message tab is closed, the graphic is no longer available for 
preview, even though it remains stored in the BNP. 

Table 22. Advanced Messaging tab (Continued)

Section Field Description
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To modify an Advanced Messaging Zone:

1. From the Messaging System -> Messaging Zones subtab, double-click the messaging zone you 
wish to modify, or right-click the zone and select Modify Messaging Zone from the pop-up menu 
(Figure 57 on page 71). 

2. The Operator and Advanced Messaging Zone ([Zone Index]) window opens.

3. Click on the Advanced Messaging tab.

Figure 67. Modify Advanced Zone window

4. Modify the desired fields according to the parameters listed in Table 22 on page 84.

5. Click Apply to save changes to the messaging zone.

To Delete an Operator or Advanced Messaging Zone:

1. From the Configuration -> Messaging System -> Messaging Zones menu, highlight and right-
click on the Messaging Zone you wish to delete.

2. Select Delete Messaging Zone from the pop-up menu (Figure 61 on page 77). 

3. If there are no output transport streams associated with the selected zone, you will be asked to 
confirm deletion and the zone will be deleted.
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4. If there are output transport streams associated with the selected zone, the following message 
appears:

Figure 68. Delete Output TS-associated messaging zones

5. Click Yes to delete the zone and its association to any programs.

Operator and Advanced Messaging Zones Best Practices and Considerations

The following guidelines should be used when creating and modifying Operator and Advanced 
Messaging zones:

1. Only one type of Messaging Zone (Operator or Advanced) may be loaded or actively playing as a 
crawl in each zone.

2. Anytime you wish to make changes to an actively playing or loaded Messaging Zone, you must 
stop the active crawl, make the desired changes, apply the changes to load them onto the BNP’s 
memory, and start or restart the crawl.

3. If you wish to change an actively playing Messaging Zone from one type to another (e.g., from an 
Operator Message to an Advanced Message), follow these guidelines:

• Click the Enable Status Update button and check the current status of the Messaging Zone 
(see Table 18 on page 70 for a description of status messages).

• If the current status of either Operator or Advanced Messaging is ON, stop the crawl by 
clicking Stop in the active zone’s subtab.

• Make any changes to the desired subtab (Operator or Advanced).

• Click Apply to load the new message to the BNP’s memory.

• Click the Start button to begin playing the message.

• If the Enable Status Update button has been clicked, the new status will be appear as [Operator 
Messaging Text or Advanced Messaging] On in the Current Status field.

4. If you wish to change a loaded but not actively playing Messaging Zone from one type to another 
(e.g., from an Operator Message to an Advanced Message), follow these guidelines:

• Ensure the Enable Status Update button has been clicked.

Note: Use caution when opening multiple windows with the Enable Status Update option activated 
as multiple GUI queries can place additional processing load on the BNP. 

• Confirm the current status of the Messaging Zone is not ON (see Table 18 on page 70 for a 
description of status messages).

• Make any changes to the desired subtab (Operator or Advanced).

• Click Apply to load the new message to the BNP’s memory.

• If the Enable Status Update button has been clicked, the new status will be appear as [Operator 
or Advanced] Messaging Loaded in the Current Status field.
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Logo Overlay Zones

Overview

In addition to EAS and operator messaging, the BNP Messaging System Logo Overlay option supports 
inserting graphic overlays into any MPEG-2 program being processed. Graphic overlays are based on 
importing static graphic Portable Network Graphics (PNG) files. You can preview the imported PNG 
files before starting the overlay insertion, but once the graphic has been saved and uploaded to the 
BNP, you can only see the name of the last file uploaded.

The location of the logo insertion is user configurable with positioning anywhere on the display screen 
defined by (x,y) screen coordinates based on pixels relating to program resolution (e.g., SD and HD). 
Additionally, the BNP will support alpha channel transparency inherent in the PNG file’s creation. 
logo overlay files can be created with PNG alpha channels to control transparency effects supported by 
the BNP during the insertion of the overlay.

Alpha Channel Transparency

In general, a graphics file consists of three layers, or channels: RGB for red, green, and blue. Another 
type of channel may be added to a graphics file to allow for the configuration of transparency in the 
pixels when the RGB colors are merged, or layered, one on top of the other. This is known as an alpha 
channel. Alpha channels define the importance of each pixel in the layering process so that certain 
portions of the image can either be completely or partially masked. This allows for rectangular-shaped 
images to appear as irregular-shaped by controlling the pixel opacity, which is important when 
overlaying a logo to a TV screen. 

PNG files are the most common and advanced file extension for supporting alpha channel 
transparency. The BNP will support any transparency mask inherent to the aqlpha channel of a PNG 
file as long as the Enable Mask field is checked in the Logo Overlay Zone menu.

Note: The Enable Mask field is only visible when the Enable Transparency for Overlays option is 
checked in the Configuration -> Global window.

Below are two examples of PNG files in which alpha channel transparency has been configured for 
100% background transparency. In the first example, transparency is not enabled on the BNP; in the 
second example, transparency is enabled.

Figure 69. Alpha Channel transparency examples

Alpha channel transparency has 
been configured in the PNG file but 
not enabled on the BNP

Alpha channel transparency has been configured 
in the PNG file and enabled on the BNP. 
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Overlay Zone Configuration

Note: An Advanced Overlay license must be purchased in order to view or configure a Logo Overlay 
Zone. For more information on Advanced Overlay licensing, see “The License Manager” on 
page 111.

Note: SCTE 18 EAS alerts (highest priority) and Operator and Advanced Alert messages (second 
priority) take precedence over Logo Overlays. A Logo Overlay can not be sent to a program 
that has an active SCTE 18 message or Operator and Advanced Messaging alert. An SCTE 18 
message alert sent to a zone will immediately override any current GUI generated alert 
message playout.

 From the Configuration -> Messaging System tab, click on the Logo Overlay Zones subtab.

The Logo Overlay Zones subtab (Figure 70) provides a snapshot view of all configured Logo 
Overlay zones. 

Figure 70. Configuration -> Logo Overlay Zones tab
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Table 23 describes the fields available from the Messaging Zones subtab.

Recommendations for Logo TV Screen Positioning

In order to simplify logo positioning for both SD and HD programs, the TV screen of either SD or HD 
has been divided into 4 quadrants with the X,Y coordinates positioned relative to each corner: On the 
X axis, the screen has been divided into left and right from 0 to 960 pixels (based on half the width of 
a typical HD 1920 pixel screen). On the Y axis, the screen has been divided into top and bottom from 0 
to 540 pixels (based on half the height of a typical HD 1080i screen). 

In this manner a static overlay graphic may be accurately positioned regardless of SD or HD as long as 
the X, Y coordinates for an SD program do not exceed an SD’s resolution. In order to ensure accurate 
positioning, it is recommended that the X, Y coordinates be kept to a relatively low number. 

Figure 71 shows an example of Logo Overlay positioning for an HD program (top graphic) and an SD 
program (bottom graphic). The X, Y coordinates for the green logo boxes have been set to relatively 
low numbers (x=64, y=64) so as to remain positioned closer to the corners of the TV screen for both 
HD and SD resolutions. The X, Y coordinates for the blue logo have been set to high numbers (x=900, 
y=500). As such, while the logo for an HD resolution of 1920 x 1080i is positioned in the center of the 

Table 23. Logo Overlay Zones subtab

Field Description

Zone Index The sequential index number of the created zone.This field is read-only. Up to 32 
zones can be added.

Zone Name The name of the zone. This field is read-only and is created when adding or 
modifying a new Messaging Zone.

Position Displays the X,Y position (in multiples of 16 pixels) of the logo placement and 
whether the X axis is from the Left or Right (L or R) and the Y axis is from Top or 
Bottom (T or B).

Zone Status The status of the Logo Overlay Zone. This field is read-only. Possible choices are:

• Enable: Logo Overlay zone is ready to start Logo Overlays.

• Logo Loaded: Logo is loaded on the BNP and is ready to start overlay. 

• Logo On: Logo is loaded on the BNP and is currently displaying in the zone. 

• Scheduled: Logo has been loaded and scheduled, but currently is not being 
displayed. 
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screen, the X, Y values are too large for the blue logo to be placed within the bounds of an SD screen 
at 720 x 480i resolution.

Figure 71. Logo Overlay Positioning

To configure a Logo Overlay Zone:

Note: You must be logged in as the Administrator to add, modify, or delete Logo Overlay Zone 
configuration.

1. From the Configuration -> Messaging System tab, click on the Logo Overlay Zones subtab.

2. Right-click anywhere on the white or light blue rows.

Figure 72. Logo Overlay Zone pop-up window

3. Select Add Logo Overlay Zone from the pop-up menu (Figure 72).
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4. The Add Logo Overlay Zone window of Figure 73 opens.

Figure 73. Add Logo Overlay Zone tab

5. Fill out the appropriate fields according to your desired configuration.

Table 24 provides a description of the fields available in the Add Logo Overlay Zone menu.

Table 24. Logo Overlay tab 

Section Field Description

Top Section Zone Index Read only field; indicates the index number of the 
zone. Up to 32 Logo Overlay zones may be created.

Zone Name Enter a name for a zone. Accepts alphanumeric 
characters. 
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Logo Configuration X Position (0 to 960)

(Multiple of 16 pixels)

Enter the pixel number (in multiples of 16) where the 
logo will begin for the X position (horizontal) of either 
the left or right quadrants of the TV screen.

(X Position) From Left Click this button if the logo’s X position is to start from 
the left quadrant of either the top or bottom quadrant.

For example, if the X position were set to 32 and the 
From Left button selected, the logo’s left most edge 
would start 32 pixels from the left quadrant of either 
the top or bottom quadrant (whichever is selected).

(X Position) From Right Click this button if the logo’s X position is to start from 
the right quadrant of either the top or bottom 
quadrant. 

For example, if the X position were set to 32 and the 
From Right button selected, the logo’s right most 
edge would start 32 pixels from the right quadrant of 
either the top or bottom quadrant (whichever is 
selected).

Y Position (0 to 540)

(Multiple of 16 pixels)

Enter the pixel number (in multiples of 16) where the 
logo will begin for the Y position (vertical) of either the 
top or bottom quadrants of the TV screen.

(Y Position) From Top Click this button if the logo’s Y position is to start from 
the top quadrant of either the left or right quadrants.

For example, if the Y position were set to 32 and the 
From Top button selected, the logo’s top most edge 
would start 32 pixels from the top quadrant of either 
the left or right quadrants (whichever is selected).

(Y Position) From Bottom Click this button if the logo’s Y position is to start from 
the bottom quadrant of either the left or right 
quadrants.

For example, if the Y position were set to 32 and the 
From Bottom button selected, the logo’s bottom most 
edge would start 32 pixels from the bottom quadrant 
of either the left or right quadrants (whichever is 
selected).

Enable Mask Check this box if the BNP is to display and support 
alpha channel transparency configurations inherent 
to the imported graphic. For more information, see 
“Alpha Channel Transparency” on page 90.

Table 24. Logo Overlay tab (Continued)

Section Field Description
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Zone Status Start Time Read-only field. Displays the day, date, and time that 
the crawl has or will begin. 

Remaining Time Read-only field. If a limit was placed on the duration 
of the alert, the time remaining (in a running-down 
counter) is displayed here.

Event Duration Read-only field. Displays how long the event is to 
take place.

Current Status This field is read-only and will display one of the 
following values:

• Enable

• Logo Loaded

• Logo On 

• Scheduled

See Table 23 for a complete description of these 
values.

Next Start Time Read-only field. Displays the time that the next round 
of messaging will begin.

Logo Import Section Logo Image Displays the location and name of the imported 
graphic that has been uploaded to the BNP. 

Import Graphic... Click this button to select a PNG file from the local 
computer on which the Element Manager is running. 

Logo Render Preview 
(Max logo image size is 
256x176 pixels)

When uploading a new graphic to the BNP, it will be 
displayed here. After the logo has been uploaded 
(i.e., Apply has been clicked), and the Logo Overlay 
window is closed, the graphic will not be displayed 
again, however, the file name will still be displayed in 
the Logo Image field.

Crawl Duration This section provides the following options for the 
duration of the text crawl:

• Play xxx Seconds: Displays the graphic for the 
specified number of seconds (with a 5 second or 
one cycle minimum). Logo will display for the 
duration that is longest: specified value of seconds 
OR one cycle.

• Continuous: Continuously displays logo until the 
Stop button is clicked.

Crawl Frequency Choose between two options for how often message 
is played:

• Once: Displays graphic once or for specified 
number of seconds (see above).

• Every: Select either 30 or 60 to display graphic 
every thirty or sixty minutes, either for one cycle or 
for specified number of seconds (see above) from 
the moment Start is clicked until the moment Stop 
is clicked.

Table 24. Logo Overlay tab (Continued)

Section Field Description
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To modify a Logo Overlay Zone:

1. From the Messaging System -> Logo Overlay Zones subtab, double-click the zone you wish to 
modify, or right-click the zone and select Modify Logo Overlay Zone from the pop-up menu 
(Figure 72 on page 93). 

Schedule Start (button) The BNP permits you to start a message immediately 
or schedule it. 

• Now: Starts play immediately. 

• Time: Allows you to schedule start time. Click on 
pulldown arrow to display a popup window (seen in 
Figure 63 on page 81) to set start.

Stop (button) • Forever: If message is set to play once (see 
Frequency, above) this is the default. 

• Time: When Frequency is set to every 30 or 60 
minutes, the Scheduler popup is enabled. Click on 
the pulldown arrow to display (seen in Figure 63 on 
page 81) and set.

Action Buttons at bottom 
of screen

Show Program List Clicking this button will open the Show Program List 
window, which displays all programs associated for 
the specified zone. 

• This button only appears when modifying a zone, 
and not when creating a zone.

Enable Status Update/ 
Disable Status Update

Clicking this button will enable real-time polling of the 
Logo Overlay Zone Status fields.

• When the Enable Status Update button is clicked 
and real-time polling enabled, the button will 
change to Disable Status Update. Clicking the 
Disable Status Update button will disable real-time 
polling.

• This button only appears when modifying a zone, 
and not when creating a zone.

Table 24. Logo Overlay tab (Continued)

Section Field Description
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2. The Logo Overlay Zone ([Zone Index: Zone Name]) window opens.

Figure 74. Modify Logo Overlay Zone window

Note: If a Logo Overlay is currently On (click the Enable Status Update button to see real time 
status updates of the zone), stop the overlay first before modifying desired parameters. 

3. Modify the desired fields according to the parameters listed in Table 24 on page 94.

4. Click Apply to save and upload new changes to the overlay zone.

To Delete a Logo Overly Zone:

1. From the Configuration -> Messaging System -> Logo Overlay Zones menu, highlight and right-
click on the Logo Overlay Zone you wish to delete.

2. Select Delete Logo Overlay Zone from the pop-up menu (Figure 72 on page 93). 



BNP3xr User Guide 99

Messaging System Configuration

3. If there are no output transport streams associated with the selected zone, you will be asked to 
confirm deletion of the zone and the zone will be deleted.

4. If there are output transport streams associated with the selected zone, the following message 
appears:

Figure 75. Delete Output TS-associated messaging zones

5. Click Yes to delete the zone and its association to any programs. 

Messaging System Zone Priority

At any given time there can be only one Messaging System zone active for a particular program, even 
though each type of zone (EAS, Operator and Advanced, or Logo Overlay) can be enabled or 
associated to a particular program at the same time. If all associated zones have been activated, the 
priority of message playout is as follows:

1. EAS Messaging - will always override any Operator-defined crawl or Logo Overlay for the dura-
tion of EAS playout.

2. Operator and Advanced Messaging - will override an active Logo Overlay for the duration of 
playout. If playout is continuous and Logo Overlay is also active, then no Logo Overlay will be 
seen.

3. Logo Overlay - no override.

As an example, let us assume that a program playing on Channel 2 has all three zones configured with 
EAS, Operator and Advanced, and Logo Overlay zones, with a scheduled Operator Messaging text 
crawl scheduled to playout one cycle every hour and a continuously active Logo Overlay. During the 
time that the Operator Messaging crawl is scheduled to play, the Logo Overlay will not be present, 
however, when the crawl has finished its cycle the Logo Overlay will return. If, at any time, an EAS 
message is generated, both the Operator crawl and the Logo Overlay (after the crawl has finished) will 
be overridden until the EAS messaged has completed its cycle.

Show Program List 

Within each Messaging System zone you can view which active programs have been configured and 
enabled for messaging services. 

Programs Configured for Messaging Services

When a program is groomed from an input source to an output transport stream, you can specify which 
Messaging System Settings are configured (or associated) on a per program basis. A program can be 
associated with any or all three Messaging zone types (EAS, Operator and Advanced, and Logo 
Overlay). For more information on associating programs for Messaging Zones, see “Creating MPEG-2 
Output Transport Streams” on page 131.



System Configuration

100 BNP3xr User Guide

Managing Program Activity for Messaging Service Zones

An output program may join or leave a Messaging Service zone at any time, the changes taking effect 
the next time a message event starts. 

Once a program has been associated with a Messaging Service zone, the program can then be enabled 
or disabled for the specified zone either from the Grooming -> Mapping window (see “Creating 
MPEG-2 Output Transport Streams” on page 131) or through the Show Program List window.

The Show Program List window displays all output programs across all transport streams on all ports 
(GigE and ASI) that are currently enabled for the selected zone. Through this window you can enable 
or disable Messaging Service operation for one or all programs in a zone.

There are two ways to view programs associated with Messaging System zones:

1. From the Configuration -> Messaging System -> Messaging Zones or Logo Overlay Zones 
menu, highlight the desired zone, right-click, and select Show Program List from the pop-up win-
dow (Figure 76).

Figure 76. Show Program List Pop-up windows

Or:

Messaging Zones -> Show Program List

Logo Overlay Zones -> Show Program List
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2. Click on the Show Program List button from either the Modify Messaging Zone window 
(Figure 59, Figure 64, Figure 67) or the Modify Logo Overlay Zone windows (Figure 74).

The Show Program List window for the selected zone will open.

Figure 77. Show Program List window

The Show Program List window will display all transport streams that have programs configured for 
the specific Messaging zone. To view the specific programs and whether or not they are enabled for 
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Messaging Services, you must drill down to the program level in the window by clicking the + icon 
next to each listed transport stream.

Figure 78. Show Program List window - drill down

Show Program List Options

• Enable or Disable specific programs for messaging: Highlight, then right-click on desired program 
and choose either Enable or Disable from the pop-up menu (Figure 78) or click the Enable or 
Disable button at the bottom of the window (Figure 79).

Figure 79. Show Program List pop-up menu

• Enable or Disable all configured programs for messaging: Click the Enable All or Disable All 
button at the bottom of the window (Figure 78).

• View Messaging status: View which programs under a specific transport stream are configured 
only or configured and enabled for messaging by identifying its associated program icon. 

- An icon with a dark brown line under the green arrow is configured but not enabled for 
messaging.
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- An icon with a pink line under the green arrow is configured and enabled for messaging.

Figure 80. Messaging Zone Icons

• Refresh Program list: Click the Refresh button at the bottom of the Show Program List window 
(Figure 77 on page 101).

• Scroll-over Program Status: Scroll over the program name with your mouse to view its current 
status. 

Figure 81. Scroll-over program status

Creating Messaging Zone Transport Streams and Output Programs

To create a transport stream or output program to use a Messaging Zone, see “Creating MPEG-2 
Output Transport Streams” on page 131 and “Creating Programs” on page 151.

SNMP Configuration

The SNMP (Simple Network Management Protocol) tab lets you set the IP addresses for the SNMP 
traps. These traps then issue event notifications to the network management station. SNMP is the 
network management protocol used in TCP/IP networks. You can use SNMP to monitor and control 
network devices as well as manage configurations and collect statistics. You can change the SNMP 
information at any time.

You can configure an SNMP trap agent or an SNMP community string.

Configuring an SNMP Trap Agent

Configure an SNMP agent to send traps to an SNMP manager to report significant events. Use either 
an in-band or an out-of-band IP interface to manage the system with SNMP. To configure SNMP for 
system management with SNMP, assign an IP address to an in-band Ethernet port, then set the 
destination IP address to which the traps are forwarded by the system agent.

Messaging configured and enabled program

Messaging configured but disabled program
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1. From the Element Manager, select Configuration -> SNMP Trap. The SNMP Configuration 
window appears.

Figure 82. SNMP configuration window

2. Enter the IP address for each SNMP trap desired: up to eight addresses can be specified. This 
indicates up to eight ports.

3. Click Apply Configuration to save your configuration.

Changing a Community String

SNMP community strings control read and write access to BNP configuration. To read the BNP’s 
configuration, an SNMP Network Manager must provide a community string that matches the BNP’s 
Read Community String. To change the BNP’s configuration, the SNMP Network Manager must 
provide a string that matches the BNP’s Write Community String.

To change an SNMP community string:
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1. From the Element Manager, select Maintenance -> Change SNMP Community String.

Figure 83. Modifying an SNMP Community String

2. Change either or both the Read and Write strings to the desired values (as shown above in 
Figure 83).

3. Click OK.

The BNP will prompt for a reboot:

Figure 84. SNMP reboot prompt

4. After the system reboots, log in to the Element Manager as described in “Logging In” on page 34.

Note: You will not be able to change the SNMP Community String at this point. You will need to log 
in as normal and allow the system to produce an error, thus prompting for new SNMP 
Community String entries.

5. After clicking the Log in button, the BNP will timeout and produce the following message:

Figure 85. BNP unreachable message - SNMP
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6. Click OK.

The following Log in screen will appear, with prompts for new SNMP Community Read and 
Write strings:

Figure 86. Log in - prompt for new SNMP strings

7. Enter the new Read and/or Write community strings to match the entries you changed in Step 2 
above.

Figure 87. Log in - new SNMP strings entered

8. Click the Log in button.

The BNP will log you in as normal.

Note: You will need to log in as described above for any workstation that is accessing the Element 
Manager for the first time after the SNMP Read / Write Community Strings have been 
changed.
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Upgrading Software

To upgrade to the latest BNP software, download the software from an FTP server and use the BNP 
Element Manager upgrade feature to perform the upgrade. You will receive the specific information 
about the upgrade software when you purchase an upgrade, or when you are notified that an upgrade is 
available. Upgrade support software includes upgrades for both active and standby units in a redundant 
system.

Note: Please contact RGB Networks’ customer support for assistance in performing a software 
downgrade process.

To Upgrade Software in a Single Chassis Environment

1. From the main Element Manager menu, select Maintenance -> Software Upgrade.

The Upgrade Software dialog appears.

Figure 88. Upgrade Software dialog
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2. Enter the information required to perform the upgrade as described in Table 25:

3. Click the Upgrade button to begin the upgrade procedure.

As the software is upgraded, you will see information appear in the Upgrade Log portion of the 
dialog. This helps you follow the upgrade progression.

4. After the upgrade is complete and the status shows 100%, the upgrade is installed. 

5. If you chose not to auto reboot, manually reboot the system as described in “Rebooting the System” 
on page 116.

Table 25. Upgrade Software Configuration Fields

Field Description

FTP Host Enter the IP address of the FTP server on which the upgrade software 
package resides.

User Name Enter the user name needed to access the FTP server.

Password Enter the password for the user name provided above.

Path Enter the directory and file name for the upgrade software.

Reboot chassis after 
successful software upgrade

To reboot the chassis automatically, enable this feature; otherwise, you will 
have to reboot the chassis manually.
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To Upgrade Software in a Redundant Chassis Environment

The steps for upgrading software in a redundant chassis environment are slightly different than in a 
single chassis scenario. Follow the steps below if you have an active and standby chassis you wish to 
upgrade (Figure 89 shows the Software Upgrade menu you will see with a redundant chassis):

Figure 89. Software Upgrade - Redundant chassis

Upgrade the Active chassis first

1. From the Maintenance -> Software Upgrade menu, enter the FTP Host, User Name, Password, 
Directory and File Name.

2. Select the Both Active and Standby radio button.

3. Uncheck the Reboot chassis after successful software upgrade option.

4. Click the Upgrade button at the bottom of the screen.

Shutdown the Standby, then Active chassis next

1. Log into the Standby’s Element Manager via its Virtual IP address and use the Maintenance -> 
System Shutdown menu to shutdown the system.

2. Log into the Active’s Element Manager via its Virtual IP address and use the Maintenance -> 
System Shutdown menu to shutdown the system.

1

2
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Remove power from the Standby chassis

After shutting down the Standby through the Element Manager, wait one minute (or until the Fault 
LED has stopped blinking) and unplug the power cord from the standby chassis.

Power cycle Active, then power on Standby chassis

1. Power cycle the active chassis.

2. Wait until the active chassis is accessible through the GUI and output streams are verified.

3. Replace power to the standby chassis and proceed with boot up.

Clearing the Web Start Cache

Any time that you downgrade software, you must clear the cache from the Java Web Start. Older 
versions of the Element Manager use Web Start when the BNP Element Manager is started. This is 
only needed when you change to a software version lower than the current one.

To clear the Java Web Start cache (on a Windows system):

1. From the Start Menu, select Settings -> Control Panel -> Java.

The Java Control Panel is launched.

Figure 90. Java control panel

3

4
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2. From the Temporary Internet Files section, click the Settings button.

The Temporary Files Settings screen appears.

3. Click Delete Files.

4. Ensure that the Application and Applets and Trace and Log Files boxes are checked.

5. Click OK to clear the cache and close the screen.

The License Manager

Overview

There are seven types of licenses for the BNP: Grooming with DPI, Grooming, Messaging System, 
Advanced Overlay, Program with DPI, SPTS, and DVB-CA.

The standard Grooming with DPI license enables all product features including grooming, statistical 
multiplexing, transrating, DPI (ad insertion), PSIP, all redundancy options, Gigabit Ethernet, and 
SCTE 30 to SCTE 35 conversion. 

The Grooming license offers all features except DPI, with the option to add support for these features 
with a DPI license upgrade at a later time. 

The Messaging System license enables the use of integration with an external digital SCTE 18 EAS 
server with the option for Operator-defined message alerts. The Messaging System license must be 
used in conjunction with either the Grooming with DPI or the Grooming non-DPI license. 

The Advanced Overlay license provides the ability to import external text or graphics for playout, as 
well as static logo insertion. The Advanced Overlay license must be used in conjunction with either 
the Grooming with DPI or the Grooming non-DPI license. You will also need a Messaging System 
license for the Advanced Overlay feature to work.

The Program with DPI license allows Digital Program Insertion on a per program basis. This license 
is used in conjunction with the standard Grooming license and the SPTS license which enable 
grooming, statistical multiplexing, and transrating. 

The SPTS license allows only a Single Program Transport Stream to be created on the output. 
Functionality is the same as a standard MUX license, however, the creation of an MPTS on the output 
is not allowed.

The DVB-CA license allows DVB Conditional Access on a per TS / MUX bandwidth basis. This 
license is available in 4Mbps or 40Mbps increments and is tracked at the TS level.

Functionality

The determination of what type of license is used for a particular transport stream and its bandwidth is 
made when you configure an output transport stream. A transport stream can only be assigned to a 
license type after the license has been installed. For more information on configuring various types of 
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output transport streams, see the relevant sections beginning on page 131 of Chapter 5, "Grooming and 
PSIP."

BNP licensing is based on the total bandwidth of output multiplexes where each Mux can be MPTS or 
SPTS.

An associated license allows the creation of as many Mux or programs as will fit in the licensed 
bandwidth. Example: A 40 Mbps Mux allows a MPTS with programs averaging at around 2.5 Mbps, 
or 10 CBR SPTS programs at 4 Mbps.

All license keys are tied to the serial number of the compact flash card, which allows flash portability 
and access to stored configurations.

Purchasing Licenses

The BNP will be shipped with a license key pre-loaded on the system.

To purchase an upgrade license, submit your request and PO to your reseller or to RGB if you 
purchased the product directly. Your request will then be processed and a new license key will be sent 
to you.

Please include the serial number of your compact flash card and the current number of licenses you 
have for that particular system. RGB will issue a new license key that will be for the total number of 
licenses for that system. For example, if you currently have a 4-Mux license (160 Mbps) for a single 
BNP and you are ordering two more licenses for this system, RGB will issue a new license key for 6 
Muxes (240 Mbps).

If purchasing licenses for multiple systems, you will need to indicate how many licenses per system 
with the serial number of the compact flash of each system clearly indicated. RGB will then issue 
separate license keys for each system.

Activating a License Key

Once you have received the license key, activate the license as follows: 

1. From the main Element Manager menu, select Maintenance -> License Manager.

2. Verify that the current information shown is correct. 

3. In the New License Key field, enter the license key (Figure 91). 

Note: There is only one field in which to input a license key; this field is applicable to all types of 
licenses. 

j
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Figure 91. The License Manager

4. Click Apply New License.

Note: Adding a Messaging System, Advanced Overlay, or DVB-CA license key also requires a reboot 
to take effect.

The new license is applied, and the updated information now appears in the License Manager. 

Figure 91 shows the currently installed license key and Compact Flash ID (serial number).

Hardware Capacity Status

The License Manager also shows hardware capacity information—i.e. the maximum number of 
licenses and bandwidth that the system can currently support based on the hardware installed. There 
are three fields of information that display the bandwidth status for hardware capacity: Total Installed, 
Available License, and Used License.

Total Installed shows the number of licenses residing in the compact flash and the resulting potential 
bandwidth available in each license category. This number of licenses may exceed your current 
hardware capability.
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Available License will be based on either the installed licensed bandwidth or hardware capacity 
bandwidth, which ever is less. This means that Used Bandwidth + Available Bandwidth will equal 
either the Total Installed licensed bandwidth or the Hardware Capacity depending on which one is 
lower.

Used License indicates the bandwidth actually in operation.

Flash Portability

One of the advantages of the BNP's licensing structure is flash portability. In the unlikely case that 
your system suffers a catastrophic failure and you need to replace the hardware, remove the compact 
flash from the old BNP chassis and install it into the new hardware. The new system should now 
operate just like the old system as long as the hardware in the new system can support the same 
configuration. So, if the failed system had two processor cards with two ASI cards, your new system 
would need to have the same hardware to support the same configuration.

Regrooming

Regrooming lets you reset all of the programs that are currently configured in Program Redundancy to 
their Active Programs. Once initiated, the command will check to see that the active program has been 
restored. If the active program has not been not restored, no change will occur to the current state of 
the program. 

The Regrooming feature resets all programs with a properly detected primary program available. This 
feature cannot be used to regroom a selected stream.

To reset all of the grooming to the active chassis:

1. From the main Element Manager menu, select Maintenance -> Regroom.

2. You are prompted to confirm that you want to reset the grooming. Click Apply regroom.

Figure 92. Apply regrooming
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Stopping All Services

Stopping All Services

A system shutdown will stop all video services on the BNP. You perform a system shutdown as a 
means of gracefully stopping all video services prior to a power cycle of the system. If you have 
chassis-level redundancy configured and you are stopping all services on the active BNP, the standby 
BNP will become active.

Note: The only way to restart video services following a system shutdown is to manually power cycle 
the chassis by removing and reinserting the power cord.

Note: Prior to performing the steps in this section, ensure there is a technician standing by at the 
physical location of the BNP.

1. From the main menu, choose Maintenance -> System Shutdown.

The System Shutdown confirmation (Figure 93) appears.

Figure 93. System Shutdown confirmation dialog

2. Click Yes to stop all video services, or No to cancel the process and leave all services running.

The Password Verification prompt (Figure 94) appears.

Figure 94. Password Verification prompt

3. Enter the appropriate password according to your login level.

Note: If you have Administrator privileges, enter your administrator password. If you have Operator 
privileges, enter that password. Only Administrators and Operators may shut down the 
system.

4. Click OK to stop all services.

It will take several seconds for the BNP video services to halt. An indication that the services have 
stopped will be either a solid green or off Fault LED.

5. Remove the power cord (or both cords in the case of power supply redundancy) from the power 
connector(s) on the rear of the chassis.
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6. Wait until the power supply LEDs are off.

7. Reinsert the power cord (or both cords in the case of redundancy) into the connector(s) on the rear 
of the chassis.

The BNP will proceed through its normal boot up process.

Rebooting the System

Any time you load a new software image, you must reboot the system. When a power cycle or reboot 
is performed, the BNP will retain previously saved configuration settings. Only the parameters of 
newly introduced features need to be set when the system is upgraded and rebooted. 

The BNP is rebooted using a power cycle or using the BNP Element Manager. 

The BNP does not have a power switch. To power the unit down, disconnect the power cable from the 
connector as described in “Replacing a Power Supply” on page 284. To reboot the switch from the 
BNP Element Manager:

1. From the main menu, select Maintenance -> Reboot.

2. At the prompt, enter your password (Figure 95).

Figure 95. Password Verification prompt

Note: If you have Administrator privilege, enter your administrator password. If you have Operator 
privilege, enter that password. Only Administrators and Operators may reboot the system. 

3. Click OK to proceed with the reboot. 
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Checking for the BNP Element Manager Version

4. The reboot confirmation screen appears, as shown in Figure 96.

Figure 96. Reboot dialog

5. Click Yes.

6. To reboot other units, select the unit and repeat the procedure.

Checking for the BNP Element Manager Version

To determine the currently installed version of the BNP Element Manager, from the main menu select 
Help -> About. 

Figure 97. About BNP dialog
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CHAPTER 5

Grooming and PSIP

This chapter describes how to perform grooming and Program and System Information Protocol 
(PSIP) tasks on the BNP3xr using the BNP Element Manager. 

In This Chapter:

• “Before You Begin,” next.

• “Using the Mapping Tab” on page 120.

• “Creating Input Transport Streams” on page 127.

• “Managing Input Transport Streams” on page 129.

• “Creating MPEG-2 Output Transport Streams” on page 131.

• “Advanced Transport Stream Settings” on page 135.

• “Creating ATSC Output Transport Streams” on page 137.

• “Creating SCTE Output Transport Streams” on page 141.

• “Creating DVB Output Transport Streams” on page 142.

• “Creating a FAT ASI Port Output Transport Stream” on page 148.

• “Creating Programs” on page 151.

• “Modifying and Deleting Streams or Programs” on page 156.

• “Drag and Drop Grooming” on page 163.

• “Program Redundancy” on page 175.

• “Elementary Streams” on page 179.

• “Elementary Stream Ghost PID Management” on page 193.

• “Managing PMT and ES Descriptors” on page 203.

• “Monitoring Bitrates” on page 208.

Before You Begin

Before you begin performing grooming tasks, complete the general configuration described in 
Chapter 4, “System Configuration”.

Overview

The Element Manager’s Grooming tab has three subtabs from which you can perform mapping and 
view bit rates. The tabs are: Mapping, Input Bitrate Monitor, and Input-Output Bitrate Monitor. 
This chapter focuses on the functions in these subtabs. 
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Using the Mapping Tab

The Grooming -> Mapping subtab allows you to:

• Create both input and output transport streams. See “Creating Input Transport Streams” on 
page 127.

• Create an output program. See “Creating Output Programs Manually” on page 151.

• Perform drag and drop grooming on individual programs or full transport streams. See “Drag and 
Drop Grooming” on page 163.

• Set your program schedule. See “Scheduling Grooming - One time event” on page 174.

To perform the procedures above, from the Element Manager, select Grooming -> Mapping. The 
Mapping subtab window appears (Figure 98), displaying existing transport streams, program names, 
and elementary streams for input on each appropriate port. 

Output information appears only after there is output content. This can be achieved by either creating 
an output transport stream or program, or by dragging and dropping input transport streams or 
programs to the output. 

All GigE ports are shown in the Inputs (left) portion of the window. Active ports are shown with a 
green icon, and inactive ports are shown with a gray icon. These are the ports that you configured in 
the configuration portion of the BNP as described in “GigE Port Configuration” on page 53. 
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Using the Mapping Tab

You create transport streams which are then picked up and put into the grooming window.

Figure 98. Grooming-Mapping configuration

Expand or collapse each “container” object (transport stream or program) by either double-clicking the 
object or clicking the plus or minus sign to the left of the object name.

Each input transport stream has associated PSIP information where appropriate. Other types of 
transport streams may show similar information. 

Programs appear under the transport stream in which they arrive (or to which they are outputted), and 
the elementary streams appear under the program. Each transport stream has an associated set of 
programs and PSIP tables. Each program includes video, audio, and PSIP tables.

Transport stream

Table information

Program name

Elementary Streams
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Viewing Program-Level Input Source

To view the input source of an output program, proceed as follows:

1. Right-click the desired program on the Outputs (right-hand) side of the screen (Figure 99).

2. From the pop-up box, select View Grooming Source.

3. Observe the highlighted grooming source from the Inputs (left-hand) side of the screen (Figure 99).

Figure 99. Viewing program-level input source

Highlighted source



BNP3xr User Guide 123

Using the Mapping Tab

Viewing ES-Level Input Source

To view the input source of an Elementary Stream (ES), proceed as follows: 

1. Expand the desired program whose ES you wish to view on the Outputs (right-hand) side of the 
screen (Figure 100).

2. Right-click the desired ES under the program on the Outputs (right-hand) side of the screen 
(Figure 100).

3. From the pop-up box, select View Grooming Source.

4. Observe the highlighted grooming source from the Inputs (left-hand) side of the screen 
(Figure 100).

Figure 100. Viewing ES-level input source

Highlighted source
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Interpreting the Program Status Icons

All programs on both the Inputs and Outputs sides have program status icons associated with them, 
which appear directly to the left of the word Program. These icons represent the program source. 
Table 26 shows the name of each icon.

Table 26. Program Status Icons

Symbol Name

Network Program

Messaging Services Configured, Program Disabled

Messaging Services Configured and Program Enabled

Digital Program Insertion (DPI)

Messaging Services Configured with DPI

Encrypted Program

Inactive
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Using the Mapping Tab

Interpreting Elementary Stream Status Icons

All Elementary Streams (ESs) on both the Inputs and Outputs sides have ES status icons associated 
with them, which appear directly under the program when the view is expanded. Table 26 shows the 
name of each icon.

Table 27. Elementary Stream Icons

Symbol ES Type Stream Type Description

Video MPEG2  2 (0x2) 
H.264   27 (0x1b) 
SCTE  128 (0x80)

Represents the presence of a video elementary stream 
on an input or output program.

Audio MPEG1 
MPEG2 
AC-3 (0x06) 
AC-3 (0x81) 
AAC (0x0f) 
HE-AAC (0x11)

Represents the presence of an audio elementary stream 
on an input or output programs. 

Available audio options are:

None 
Arabic 
English 
French 
German 
Hindi 
Italian 
Japanese 
Mandarin Chinese 
Portuguese 
Russian 
Spanish

Data 5 
6 Teletext 
6 Sub Title 
7 – 191 
192 
193-255

Represents the presence of a data elementary stream 
with all stream types except: 

5 EBIF 
5 EISS 
192 EBIF 
192 EISS

A blue data stream icon can be displayed on either an 
input or an output program.

Data 5 EBIF 
5 EISS 
192 EBIF 
192 EISS

Represents the presence of an EBIF or EISS data 
elementary stream.

A blue data stream icon can be displayed on either an 
input or an output program.

Data 5 
6 Teletext 
6 Sub Title 
7 – 191 
192 
193-255

Represents the presence of an ES-level groomed data 
stream with all data stream types except: 

5 EBIF 
5 EISS 
192 EBIF 
192 EISS

A green data stream icon can only be displayed on an 
output program.

Data 5 EBIF 
5 EISS 
192 EBIF 
192 EISS

Represents the presence of an ES-level groomed EBIF 
or EISS data stream. 

A green data stream icon can only be displayed on an 
output program.
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Expanding and Collapsing Mapping

You can expand and collapse the mapping views. Expanding and collapsing only affect the display; 
they do not change the underlying grooming.

Figure 101 shows an example of existing mapping.

Figure 101. Existing Mapping

To collapse mapping, select View -> Collapse Mapping (Figure 102).

Figure 102. Collapse Mapping
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Creating Input Transport Streams

To restore the expanded mapping view, choose View -> Expand Mapping. The expanded screen of 
Figure 101 is restored.

Creating Input Transport Streams

The information required to create a transport stream (TS) depends on whether you are creating a 
transport stream on an input port or an output port, and on the type of TS created. Each TS creation 
dialog is described here.

Basic Input Transport Stream Creation

To create a new input transport stream:

1. From the Inputs side of the Grooming -> Mapping subtab, choose the input port on which you 
want to create the transport stream and right-click.

2. From the pop-up menu that appears select Create Transport Stream.

3. Enter the information about the new input transport stream. 

Figure 103. Create GigE Input TS

Table 28 describes the fields available in the Create Input Transport Stream window.

Table 28. Input Transport Stream Creation

Input Transport Stream Description

GigE Port This is the read-only port ID, and is based on the selected GigE port (GigE 1, 
GigE 2, etc.)

TS Name Enter the desired name of the transport stream.

Multicast If this is a multicast stream, check this box to enable multicast.
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Multiple IP and UDP Creation

If you have chosen to create multiple transport streams, clicking Multiple TS opens the Select 
Multiple IP and UDP dialog.

Figure 104. Selecting multiple UDP/IP ports

IP Address The unicast or multicast IP address on which the stream is received. 

UDP Port Enter the UDP port to use for transmitting data.

Source IP Address The IP address of the source from which the stream is originating; the source IP 
address is optional and should only be included for IGMPv3/SSM transport 
streams.

Multiple TS Click this button if you are creating multiple transport streams. You can create 
incrementing IP addresses, incrementing UDP ports, or incrementing IP 
Addresses and UDP ports simultaneously. See the following paragraphs for 
details.

Table 28. Input Transport Stream Creation

Input Transport Stream Description

Table 29. Selecting Multiple IP and UDP

Field Description

Start IP Address A read-only field indicating the starting IP address.

End IP Address A read-only field indicating the ending IP address.

Start UDP A read-only field indicating the starting UDP port number.

End UDP A read-only field indicating the ending UDP port number.

Increment IP Address When checked, the starting IP address will be incremented by one for each 
multiple chosen.

Increment UDP When chosen, the UDP port number will be incremented by one for each 
multiple chosen.

Increment both IP Address 
and UDP

When checked both the IP address and UDP port number will be 
incremented by one for each multiple chosen.

Multiple Number The number of multiple creations, either or both, IPs or UDPs.

Excluded UDP Ports UDP ports that you want excluded from any automatic numbering.
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Managing Input Transport Streams

1. Choose to increment only the IP address, UDP port, or both simultaneously.

2. Enter the number of multiple creations desired. 

3. If you have chosen either UDP or Both, enter any UDP ports to exclude, separated by commas.

4. Click OK to apply the selections and return to the creation window.

Figure 105 shows transport streams configured under a GigE input port:

Figure 105. Input Transport Streams created

Note: Each TSID is a unique number used to identify a transport stream. It is a partition of two 16-
bit hex numbers. The lower 16 bits is the MPEG transport stream ID. The upper 16 bits (0x) is 
used strictly internally.

Note: There are no configuration parameters required for creating a transport stream on an input 
ASI port. Each input ASI port is automatically configured with one transport stream.

Managing Input Transport Streams

After an input transport stream has been created, various options are available for managing the 
stream. The options are slightly different based on whether or not you have selected a GigE port 
transport stream or an ASI port transport stream.

GigE Port Transport Stream Options

To view available options for a GigE port, proceed as follows:

1. From the Inputs side of the Grooming -> Mapping window, select a desired transport stream 
under a GigE port.

2. Right-click on the transport stream.
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3. A pop-up menu will appear as follows:

Figure 106. Input Transport Stream pop-up menu - GigE

Table 30 describes the options available from the pop-up menu.

ASI Port Transport Stream Options

To view available options for an ASI port, proceed as follows:

1. From the Inputs side of the Grooming -> Mapping window, select a desired transport stream 
under an ASI port.

2. Right-click on the transport stream.

3. The following pop-up menu will appear:

Figure 107. Input Transport Stream pop-up menu - ASI

Table 30 describes the options available from the pop-up menu.

Table 30. Input Transport Stream pop-up menu options

Menu Description

Modify Transport Stream Allows you to modify only the name of the transport stream. If 
you wish to modify any other parameter, you must delete the 
transport stream and create it again.

Refresh Transport Stream Tables When this option is selected, the internal Program Association 
Table (PAT) for this transport stream is invalidated, and the 
next incoming PAT will be used for the associated PSIP and 
DVB tables for selected transport stream.
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Creating MPEG-2 Output Transport Streams

Creating MPEG-2 Output Transport Streams

To create a new MPEG-2 output transport stream:

1. From the Outputs side of the Grooming -> Mapping subtab, choose the output port on which you 
wish to create the transport stream and right-click.

2. From the pop-up menu that appears select Create Transport Stream.

The screen will be different if the output port is an ASI (Figure 108) or a GigE port (Figure 109).

3. From the TS Type pull down menu, select MPEG-2.

4. Fill out the remaining fields of the dialog according to the parameters listed in Table 31 or Table 32, 
depending on which port is in use.

5. Click OK to save changes and create the transport stream.

The stream now appears in the Grooming -> Mapping window and can be assigned programs.

Delete Transport Stream (GigE only) Deletes the transport stream and all grooming for associated 
output programs.

• Option available for GigE port transport streams only

Recreate Input Transport Stream (ASI only) Deletes the transport stream, all grooming for associated 
output programs, and recreates the transport stream with no 
associated grooming.

• Option available for ASI port transport streams only

Create Ghost Program Used for created programs with unreferenced PIDs. See 
“Adding an Unreferenced PID as an Elementary Stream” on 
page 190 for details.

Bitrate Monitor Allows you to monitor bitrates for the selected transport 
stream.

Table 30. Input Transport Stream pop-up menu options

Menu Description
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ASI Port MPEG-2 Transport Streams

Figure 108 shows the Create Output Transport Stream window for an ASI port.

Figure 108. Creating output TS (MPEG-2, ASI port)

Table 31. MPEG-2 Output Transport Stream Creation (ASI Port)

Field Description

Port Read-only, shows either ASI or GigE depending on the port selected.

SPTS Check if the output is a single program transport stream (SPTS).

Non-DPI Check this box if the transport stream is to use a Grooming-only (Non-DPI) 
license.

TS Name The (optional) name you want to assign to this output transport stream.

Bitrate (Mbps) The bitrate at which the stream is transported.

Unique TS ID Allows you to assign a unique numeric ID to this transport stream. 

• When this option is checked, the TS ID value placed in this field will be 
reserved as unique for the entire chassis.

• When this option is unchecked, a TS ID value may still be entered, 
however the value may be the same as another TS ID as long as that TS 
ID’s value has not been reserved as a Unique TS ID. 

• Note that each TSID is a unique number used to identify a transport 
stream. It is a partition of two 16-bit hex numbers. The lower 16 bits (user-
specified in decimal and converted to hex) is the MPEG transport stream 
ID. The upper 16 bits (0x) is strictly used internally.

• Default value is “1” if no value is specified.

• Broadcasters must configure this value with a unique ID to meet FCC 
standards.

Reserved Bandwidth Enter any bandwidth value to be reserved from the total bitrate of transport 
stream.

Network PID The program ID on which network information is received.

TS Type The type of stream. The type of stream you choose determines what other 
information is required. Choices are:

MPEG-2, ATSC, SCTE, or DVB
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Creating MPEG-2 Output Transport Streams

GigE Port MPEG-2 Transport Streams

Figure 109 shows the window for a GigE port. 

Figure 109. Creating output TS (MPEG-2) - GigE port)

Table 32 describes the parameters fields available in the MPEG-2 Create Output Transport Stream 
dialog.

Enable Messaging System Check this box to allow configuration of Messaging System zones for specific 
programs in this transport stream. See “Messaging System Configuration” on 
page 69 for information on configuring Messaging Zones.

Advanced Setting Clicking this button will open a new menu that allows you to configure 
advanced settings for the selected transport stream. See “Advanced 
Transport Stream Settings” on page 135.

Table 31. MPEG-2 Output Transport Stream Creation (ASI Port)

Field Description

Table 32. MPEG-2 Output Transport Stream Creation (MPEG-2, GigE Port) 

Field Description

Port This is read-only and is used for identification purposes.

SPTS Check if the output is a single program transport stream (SPTS).

Non-DPI Check this box if the transport stream is to use a Grooming-only (Non-DPI) 
license.

Multicast Check if the output is for multicast operation.

Bitrate (Mbps) The bitrate at which the stream is transported.

Destination IP The IP address to which the output stream is routed. 

• If Multicast is checked, this must be a valid multicast IP address.

• If Multicast is unchecked, this must be a valid unicast IP address.

Reserved Bandwidth (Mbps) Enter any bandwidth value to be reserved from the total bitrate of transport 
stream. 
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UDP Port Enter the UDP port to use for transmitting data.

TS Name The (optional) name you want to assign to this output transport stream.

Subnet Mask If Multicast is unchecked, enter the subnet mask IP for the unicast IP address 
entered in the Destination IP field.

Unique TS ID Allows you to assign a unique numeric ID to this transport stream. 

• When this option is checked, the TS ID value placed in this field will be 
reserved as unique for the entire chassis.

• When this option is unchecked, a TS ID value may still be entered, 
however the value may be the same as another TS ID as long as that TS 
ID’s value has not been reserved as a Unique TS ID. 

• Note that each TSID is a unique number used to identify a transport 
stream. It is a partition of two 16-bit hex numbers. The lower 16 bits (user-
specified in decimal and converted to hex) is the MPEG transport stream 
ID. The upper 16 bits (0x) is strictly used internally.

• Default value is “1” if no value is specified.

• Broadcasters must configure this value with a unique ID to meet FCC 
standards.

ARP If Multicast is checked, this field is hidden. 

If Multicast is unchecked, this box will appear. Unchecking this box will allow 
you to disable the use of Address Resolution Protocol (ARP) and to manually 
specify a MAC address. See Figure 110.

Network PID The program ID of transport stream packets which contain the network 
information table. 

MAC Address If Multicast or ARP are checked, this field is read-only. 

If Multicast and ARP are unchecked, this field can be modified to include a 
hardcoded MAC address to be used to transport this stream. See Figure 110.

TS Type The type of stream. The type of stream you choose determines what other 
information is required. Choices are:

MPEG-2, ATSC, SCTE, or DVB.

Multiple TS Click if multiple transport streams are used. See “Multiple IP and UDP 
Creation” on page 128 for details.

Enable Messaging System Check this box to allow configuration of Messaging System zones for specific 
programs in this transport stream. See “Messaging System Configuration” on 
page 69 for information on configuring Messaging Zones.

Advanced Setting Clicking this button will open a new menu that allows you to configure 
advanced settings for the selected transport stream. See “Advanced 
Transport Stream Settings” on page 135.

Table 32. MPEG-2 Output Transport Stream Creation (MPEG-2, GigE Port) (Continued)

Field Description
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Advanced Transport Stream Settings

Hidden Fields in Create Output Transport Stream Menu (GigE)

The Create Output Transport Stream menu hides the ARP field when the Multicast box is checked. 
Figure 110 shows an example of the ARP field (checked and unchecked) as described in Table 32.

Figure 110. Create Output TS - ARP field

Advanced Transport Stream Settings

The Advanced Setting button from the Create Transport Stream menu provides the following 
additional configuration options when creating an output transport stream:

SPTS Advanced Options

Note: These options only apply when configuring a single program transport stream (SPTS) from the 
Create Transport Stream window (Figure 108 or Figure 109)

SPTS MPEG-2 Advance Rate Control

This is an MPEG-2 transrating setting for SPTS output transport streams that require more aggressive 
rate control due to severe oscillations from the input bitrate.
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To enable MPEG-2 Advance Rate Control, proceed as follows:

1. From the Create Transport Stream menu, click the Advanced Setting button.

The Advanced Transport Stream Setting window of Figure 111 is displayed.

Figure 111. Advanced Transport Stream - SPTS

2. Check the box next to MPEG-2 Advance Rate Control.

3. Click OK.

MPTS Advanced Options

Note: These options only apply when configuring multiple program transport streams (MPTSs) from 
the Create Transport Stream window (Figure 108 or Figure 109)

H.264 Alarm Bitrate Level

This setting can assist in maintaining video quality for MPEG-2 video content in the presence of other 
content, such as H.264, which bypasses the BNP’s transrater. This is done by generating an alarm 
when H.264 program bandwidth exceeds the percent of the TS bandwidth specified in this setting.

To set the H.264 Alarm Bitrate Level, proceed as follows:

1. From the Create Transport Stream menu, ensure the SPTS option is not checked.
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Creating ATSC Output Transport Streams

2. Click the Advanced Setting button.

The Advanced Transport Stream Setting window of Figure 112 is displayed.

Figure 112. Advance Transport Stream Setting - MPTS

3. Enter a percent of the transport stream’s aggregate bandwidth at which an alarm should be 
generated. Choices are: 0%, 25%, 50%, 75%, 100%.

4. Click OK.

Table 33 provides a summary of the Advanced Transport Stream Setting window parameters.

Creating ATSC Output Transport Streams

If the selected output transport stream is an ATSC type, additional information is necessary. The upper 
portion of the dialog is the same as that of the MPEG-2 type and are described in Table 31 for an ASI 
port and Table 32 for a GigE port. 

To create a new ATSC output transport stream:

1. From the Outputs side of the Grooming -> Mapping subtab, choose the output port on which you 
want to create the transport stream and right-click.

2. From the pop-up menu that appears select Create Transport Stream.

The screen will be different if the output port is an ASI or a GigE port.

Table 33. Advanced Transport Stream Settings

Field Description

SPTS: MPEG-2 Advance Rate Control When checked, the output SPTS is aggressively rate controlled.

MPTS: H.264 Alarm Bitrate Level (Mbps) Specify the percent at which an alarm will be issued when H.264 
program bandwidth of the MPTS TS exceeds this level. By 
default this rate is set to 50% of the aggregate rate of the entire 
transport stream.
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3. From the TS Type pull down menu, select ATSC.

The lower portion of both ASI and GigE port screens is used to define the PSIP tables. PSIP tables 
are described in Table 34.

4. Fill out the remaining fields of the dialog according to the parameters listed in Table 31 or Table 32, 
depending on which port is in use.

5. Click OK to save changes and create the transport stream.

The stream now appears in the Grooming -> Mapping window and can be assigned programs.

Figure 113 shows the window for an ATSC transport stream on an ASI port.

Figure 113. Create Output TS (ATSC) - ASI Port
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Creating ATSC Output Transport Streams

Figure 114 shows the window for an ATSC transport stream on a GigE port.

Figure 114. Creating output TS (ATSC) - GigE Port

Table 34 provides a description of the additional PSIP fields in the bottom portion of the Create 
Output Transport Stream window for an ATSC stream on either an ASI or GigE port. 

PSIP table fields

Table 34. ATSC TS Creation: PSIP Table Information Configuration Parameters 

PSIP Table Informationa Description

For an ASI port, all fields in the top portion of the Create Output Transport Stream window are the same as 
described in Table 31.

For a GigE port, all fields in the top portion of the Create Output Transport Stream window are the same as 
described in Table 32.

For ATSC transport types, you must include the information about PSIP tables. The PID values of major and 
minor channels are automatically numbered across the multiplex, reducing the chance of conflict.

EIT PID (0-3) The Event Information Table (EIT) packet identifier (PID) values can be set 
manually, overriding the PID in the MGT.

EIT PID Interval(ms) This value can be set manually, overriding the PID in the MGT. Value in 
milliseconds.
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MGT Interval(ms) The Master Guide Table (MGT) is highest order in the ATSC transport stream 
table hierarchy; it also provides program-identification (PID) locations so that 
receivers can locate other tables; the MGT can also inform the receiver of 
changes or table updates.

Modulation Mode Choose one of the following modes from the pull-down menu: 

Analog, SCTE 64 QAM, SCTE 256 QAM, ATSC 8 VSB, and ATSC 16 VSB.

Generate TVCT Check this box to generate TVCT tables instead of CVCT tables. A 
Terrestrial Virtual Channel Table (TVCT) is a mandatory PSIP table for 
terrestrial broadcast that lists all the virtual channels available in an ATSC 
transport stream. This feature is required for broadcasted channels.

• When Modulation Mode is set to ATSC 8 VSB or ATSC 16 VSB, you must 
enable this option. 

CVCT/TVCT Interval(ms) Specifies the interval in milliseconds at which CVCT/TVCT tables are 
generated. If the Generate TVCT option has been enabled, this field sets the 
interval for TVCT; if the Generate TVCT option has not been enabled, this 
field sets the interval for CVCT.

The Cable Virtual Channel Table (CVCT) provides information about the 
channels, such as channel name, navigation identifier, and stream 
components.

STT Source The System Time Table (STT) defines the GPS time and the daylight-savings 
time indicator to the consumer’s decoder, synchronizing the concept of "now" 
between the decoder and the broadcaster. This configuration is not 
generated by the BNP and requires a proper source to be valid on the output 
transport.

Choose an appropriate value from the pull-down menu. There must be a 
valid STT source to be ATSC compliant.

EIT Source Specifies how an EIT table is generated by the BNP. 

When Groomed Input (default) is selected, an Event Information Table (EIT) 
is generated based on that which is received from the groomed input 
program of the ATSC TS. 

Choose an appropriate value from the pull-down menu.

RRT Source The Rating Region Table (RRT) source transmits the program rating 
information

Choose an appropriate value from the pull-down menu. There must be a 
valid RRT source to be ATSC compliant.

a. PSIP (Program and System Information Protocol) is a collection of tables operating within the terrestrial broadcast Trans-
port Stream (TS) of every digital (and sometimes analog) television. PSIP settings are configured as part of the transport 
stream. 
 
These tables contain system information and program data: 
   - System information allows navigation and access of the channels within the  DTV transport stream. 
   - Program data provides necessary information for efficient browsing and event selection.  
   - Some PSIP tables contain the information to locate digital streams.  
 
If you are not sure of the PSIP guidelines, there are many good references on the Internet, including the ATSC Recom-
mended Practice: Program and System Information Protocol Implementation Guidelines for Broadcasters at http://
www.atsc.org/cms/standards/a_69-2009.pdf

Table 34. ATSC TS Creation: PSIP Table Information Configuration Parameters (Continued)

PSIP Table Informationa Description

http://www.atsc.org/cms/standards/a_69-2009.pdf
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Creating SCTE Output Transport Streams 

If the selected output transport stream is an SCTE type, the configurable parameters are the same as 
that of the MPEG-2 type and are described in Table 31 for an ASI port and Table 32 for a GigE port. 

To create a new SCTE output transport stream:

1. From the Outputs side of the Grooming -> Mapping subtab, choose the output port on which you 
want to create the transport stream and right-click.

2. From the pop-up menu that appears select Create Transport Stream.

The screen will be different if the output port is a GigE or an ASI port.

3. From the TS Type pull down menu, select SCTE.

4. Fill out the remaining fields of the dialog according to the parameters listed in Table 31 on page 132 
or Table 32 on page 133, depending on which port is in use.

5. Click OK to save changes and create the transport stream.

The stream now appears in the Grooming -> Mapping window and can be assigned programs.

Figure 115 shows the window for an SCTE transport stream on an ASI port.

Figure 115. Creating output TS (SCTE) - ASI port
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Figure 116 shows the window for an SCTE transport stream on a GigE port.

Figure 116. Creating output TS (SCTE) - GigE port

Creating DVB Output Transport Streams

If the selected output transport stream is a DVB type, additional information is necessary. The upper 
portion of the dialog is the same as that of the MPEG-2 type and are described in Table 31 on page 132 
for an ASI port and Table 32 on page 133 for a GigE port.

To create a new DVB output transport stream:

1. From the Outputs side of the Grooming -> Mapping subtab, choose the output port on which you 
want to create the transport stream and right-click.

2. From the pop-up menu that appears select Create Transport Stream.

The screen will be different if the output port is a GigE or an ASI port.

3. From the TS Type pull down menu, select DVB.

The lower portion of both ASI and GigE port screens is used to define additional information 
relative to Digital Video Broadcast (DVB) and is described in Table 35 on page 145.

4. Fill out the remaining fields of the dialog according to the parameters listed in Table 31 on page 132 
or Table 32 on page 133, depending on which port is in use.

5. Click OK to save changes and create the transport stream.

The stream now appears in the Grooming -> Mapping window and can be assigned programs.
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Figure 117 shows the window for a DVB transport stream on an ASI port.

Figure 117. Creating output TS (DVB) - ASI port
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Figure 118 shows the window for a DVB transport stream on a GigE port.

Figure 118. Creating output TS (DVB) - GigE port
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Creating DVB Output Transport Streams

Table 35 provides a description of the additional fields in the bottom portion of the Create Output 
Transport Stream window for a DVB stream on either an ASI or GigE port.

Setting Up Network Information Tables (NIT) for DVB

You can generate a NIT table using one of three methods:

• Locally generated, using the NIT editor

• NIT pass through, with editing at the output transport stream.

• Complete pass through of NIT from the input to the output transport stream.

This manual describes the first method.

To set up a NIT:

1. From the main Element Manager menu, select Maintenance -> Setup Network Information 
Table (NIT).

Table 35. DVB Output Transport Stream Configuration Parameters 

Field Description

For an ASI port, all fields in the top portion of the Create Output Transport Stream window are the same as 
described in Table 31 on page 132.

For a GigE port, all fields in the top portion of the Create Output Transport Stream window are the same as 
described in Table 32 on page 133.

Network ID Input the Network ID of the current transport stream.

Modulation Mode Use the pull-down menu to select the modulation mode used for the TS. 
Choice between SCTE 64 QAM and SCTE 256 QAM.

Original Network ID Input the Network ID from which this stream has originated.

NIT Source Use the pull-down menu to select the source for the network information 
table.

TDT/TOT Source Use the pull-down menu to select the source for the time and date table or 
the time offset table.

SDT Source Source of the service description table for this transport stream. If you select 
N/A then SDT is not generated for this output TS.

EIT Source Source of the Event Information Tabled (EIT) for the programs in this 
transport stream. If you select N/A then EIT will not be generated.
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2. In the NIT window that appears, click Add to add a new NIT or Edit to edit an existing NIT. The 
Setup Network Information Table (NIT) appears (Figure 119).

Figure 119. Setup Network Information Table screen
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3. Highlight an existing table, and choose Edit. The window of Figure 120 appears.

Figure 120. Using the Editing Feature

4. Edit the Network Information Table as described in Appendix A, “Editing the DVB NIT Table”.

5. When you are finished editing, click OK to apply any changes.

6. To view the NIT as an XML file, click View NIT in XML format.

7. To import the NIT from another BNP, click Import NIT File.



Grooming and PSIP

148 BNP3xr User Guide

Creating a FAT ASI Port Output Transport Stream

You can create a FAT ASI port with up to four groups. Proceed as follows:

1. Right click the ASI port on which to create a FAT ASI port (Figure 121).

Figure 121. Choosing a FAT ASI Transport Stream

2. Choose Create Transport Stream (FAT ASI). The window of Figure 122 appears.

Figure 122. Create Output Transport Stream (FAT ASI)
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Creating a FAT ASI Port Output Transport Stream

3. Enter the value of each parameter as described in Table 36.

Table 36. Creating a FAT ASI Transport Stream

Field Description

Port Read-only, shows either ASI or GigE depending on the port selected.

Non-DPI Check this box if the transport stream is to use a Grooming-only (Non-DPI) 
license.

TS Name The (optional) name you want to assign to this output transport stream.

Bitrate (Mbps) The bitrate at which the stream is transported.

Unique TS ID Allows you to assign a unique numeric ID to this transport stream. 

• When this option is checked, the TS ID value placed in this field will be 
reserved as unique for the entire chassis.

• When this option is unchecked, a TS ID value may still be entered, 
however the value may be the same as another TS ID as long as that TS 
ID’s value has not been reserved as a Unique TS ID. 

• Note that each TSID is a unique number used to identify a transport 
stream. It is a partition of two 16-bit hex numbers. The lower 16 bits (user-
specified in decimal and converted to hex) is the MPEG transport stream 
ID. The upper 16 bits (0x) is strictly used internally.

• Default value is “1” if no value is specified.

• Broadcasters must configure this value with a unique ID to meet FCC 
standards.

Reserved B/W (Mbps) Enter any bandwidth value to be apportioned to the transport stream.

Network PID The program ID on which the stream is received.

TS Type The type of stream. The type of stream you choose determines what other 
information is required. Choices are:

MPEG-2, ATSC, SCTE, or DVB

• For information on additional fields for ATSC transport streams, see 
Table 34.

• For information on additional fields for DVB transport streams, see 
Table 35.

Enable Messaging System Check this box to allow configuration of Messaging System zones for specific 
programs in this transport stream. See “Messaging System Configuration” on 
page 69 for information on configuring Messaging Zones.

Number of Group The number of groups you want to assign to this port. Choose from 1 to 4. 
The default is 4.

Group Name (A-D) The name you want to assign to each group.

Group Bitrate(Mbps)

(A-D)

The bitrate, in megabits per second, that you want to assign to groups. The 
value entered will be applied to all Groups. The total bitrate for all groups 
cannot exceed the value in the Bitrate field in the top portion of the window. 

Reserved B/W (Mbps) The reserved bandwidth you want to assign for each group. The total 
bandwidth for all groups cannot exceed the value in the Reserved B/W field 
in the top portion of the window.

Advanced Setting Clicking this button will open a new menu that allows you to configure 
advanced settings for the selected FAT ASI transport stream. See “Advanced 
FAT ASI Transport Stream Settings” on page 150.
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4. When you are done click OK. Figure 123 shows the result.

Figure 123. FAT ASI Ports Created

Advanced FAT ASI Transport Stream Settings

The Advanced Setting button from the Create Transport Stream (FAT ASI) menu provides the 
following additional configuration option when creating a FAT ASI transport stream:

ASI Group H.264 Alarm Bitrate Level

This setting can assist in maintaining video quality for MPEG-2 video content in the presence of other 
content, such as H.264, which bypasses the BNP’s transrater. This is done by generating an alarm 
when H.264 program bandwidth exceeds the percent of the TS bandwidth specified in this setting.

To set the each group’s H.264 Alarm Bitrate Level, proceed as follows:
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1. From the Create Transport Stream menu, click the Advanced Setting button.

The Advanced Transport Stream Setting window of Figure 124 is displayed.

Figure 124. FAT ASI - Advance Transport Stream Setting

2. Enter a percent of the transport stream’s aggregate bandwidth at which an alarm should be 
generated for each group in the FAT ASI stream. Choices are: 0%, 25%, 50%, 75%, 100%. 

3. Click OK.

Creating Programs

An input program cannot be created; it must be autodetected from the GigE or ASI port. The only type 
of input program that can be manually created is a Ghost Program. See “Elementary Streams” on 
page 179 for more information on Ghost Programs.

You can create output programs in one of two ways: manually or by drag and drop grooming. For 
either method, the program mapping configuration is the same. You can also schedule programs by 
either manual or drag and drop methods.

Creating Output Programs Manually

To create a program manually, follow this procedure:

1. From the outputs side of the Element Manager’s Grooming -> Mapping subtab, select or create 
the transport stream under which the new program will appear.
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2. Right-click the transport stream name.

Figure 125. Create Output Program popup

3. Select Create Program.

The Create Output Program dialog appears.

The image on the left displays the default Create Output Program dialog when the PIDs Priority 
setting is configured for Ad. The image on the right displays the default Create Output Program 
dialog when the PIDs Priority setting is configured for Network.

Figure 126. Create Output Program dialog

PIDs Priority set to Ad PIDs Priority set to Network
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4. Enter all of the information for the program. Some fields will be read-only.

Table 37 describes the fields available in the Create Output Program dialog for manual creation.

Table 37. Create Output Program Configuration Parameters  

Category Field Description

Port Port ID Read-only field. The GigE or ASI port on which the program 
resides.

IP Address Read-only field. The destination IP address of the transport 
stream.

UDP Port Read-only field. UDP port the program uses, based on UDP 
port of the transport stream.

TS TS ID Read-only field. The ID number of the transport stream on 
which this program streams.

TS Type Read-only field. Indicates the type of transport stream for the 
program.

Program / Channel 
Info

Program Number MPEG number assigned to this program

Program Name Name assigned to this program. Output program names 
must be unique.

PMT PID Select this option to activate the PMT ID box, into which you 
can then enter the PMT ID, or the ID of the program map 
table (PMT)

Major Channel 
Number

Operator-defined channel number: for terrestrial broadcast, 
the major channel number is limited to the range 1 to 99 for 
ATSC digital television or audio services. For cable, major 
channel numbers may range from 1 to 999. Only editable 
when ATSC is enabled.

Minor Channel 
Number

Operator-defined minor channel number: any whole number 
in the range from 0 to 999. Only editable when ATSC is 
enabled.

Enable DPIa Select this option to enable DPI for the program only, rather 
than the whole TS.

• This option is hidden unless a PROGRAM WITH DPI 
license key has been entered in The License Manager.

Allow SCTE 30- to-
SCTE 35 conversion

When checked, enables SCTE 30 to SCTE 35 conversion.
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5. Click OK to save the changes and create the program.

Program Messaging System Setting

When the Messaging System Setting button from the Create Output Program menu is clicked, the 
Program Messaging System Setting window will open (Figure 127). 

ETV Configurationb ETV PIDs Priority Indicates the source of EBIF ES data for the duration of the 
ad time and provides the option to replace or not replace the 
pre-bound EBIF ESs during ad splicing. 

• When Ad is selected, the spliced ad will provide the EBIF 
and EISS elementary streams (ESs). If the EBIF and EISS 
ESs from the ad do not match the stream type and 
descriptors of the network EBIF and EISS ESs, then the 
network EBIF and EISS ESs will be dropped. If no EBIF 
and EISS data are pre-configured at the output program or 
no EBIF and EISS data are present at the output then the 
EBIF and EISS ESs form the ad are dropped.

• When Network is selected, the EBIF and EISS ESs from 
the ad server will be ignored, even if they are present.

Default is set to Ad.

Play Preference When the ETV PIDs Priority is set to Network, the following 
three options will appear in a drop down box: 

• Play through ad: any EBIF ES data that is part of the 
output program will continue to be played during the ad.

• Drop during ad: any EBIF ES data that is part of the output 
program will be dropped during the ad.

• Play during ad only: provides the ability to select the input 
EBIF ES source that will be playing only during the ad 
time; if an EBIF ES source is not available, the EBIF ES 
that currently exists in the output program will be played.

Default setting is Play through ad. 

Late-Bind Source This option is only available when the ETV PIDs Priority is 
set to Network and the Play Preference is set to Play during 
ad only. 

• When the above two conditions have been met, an 
additional field with ellipses (. . .) will appear. Clicking on 
the ellipses will open the Late-Bind Source Dialog window, 
which will allow the option to choose a valid pair of EBIF/
EISS ES from the BNP’s input.

Messaging System Messaging System 
Setting

Click this button to open the Program Messaging System 
Setting window to configure and enable messaging zones 
for the program. See “Program Messaging System Setting,” 
below for details.

a. A GROOMING WITH DPI license key (which enables DPI for the TS) cannot co-exist with a PROGRAM WITH DPI 
license key.

b. For additional information in ETV configuration including details on various EBIF and EISS use cases, see Chapter 7, 
"ETV Binary Interchange Format (EBIF)."

Table 37. Create Output Program Configuration Parameters  (Continued)

Category Field Description
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This setting allows you to configure and enable one of each of the three types of Messaging Zones per 
program. 

Figure 127. Program Messaging System Setting window

Note: In order to select a zone from each of the three types of zone choices in the Program 
Messaging System Setting window, the zones must first be created from the Configuration -> 
Messaging System menu as described in “Messaging System Configuration” on page 69 in 
Chapter 4.

You may select one of each zone type to configure and enable per program. Only previously created 
zones will appear in the drop-down menu. Table 38 describes the fields available in the Program 
Messaging System Setting window.

Table 38. Messaging System Setting window

Field Description

EAS Zone Select an EAS zone from the pull-down menu to associate with the 
program. See “EAS Messaging Zones” on page 70 in Chapter 4 
for additional information.

Click the Enable Zone button next to the selection to enable the 
EAS messaging zone for the specified program.

Operator Messaging Zone Select an Operator or Advanced Messaging zone from the pull-
down menu to associate with the program. See “Operator and 
Advanced Messaging Zones” on page 76 in Chapter 4 for 
additional information.

Click the Enable Zone button next to the selection to enable the 
Operator or Advanced Messaging zone for the specified program.

Logo Overlay Zone Select a Logo Overlay zone from the pull-down menu to associate 
with the program. See “Logo Overlay Zones” on page 90 in 
Chapter 4 for additional information.

Click the Enable Zone button next to the selection to enable the 
Logo Overlay zone for the specified program.
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Modifying Streams or Programs

If a transport stream or a program configuration needs to be modified, use the main Grooming -> 
Mapping window to access the change options:

Modifying Input Transport Streams

The only item that can be modified on an input transport stream is the TS Name. 

1. From the inputs side of the Grooming -> Mapping window, select the transport stream that 
requires a name change.

2. Right-click on the TS and choose Modify Transport Stream from the popup menu.

The menu to modify an input TS on a GigE port will be similar to Figure 128.

Figure 128. Modify Input TS - GigE port

The menu to modify an input TS on an ASI port will be similar to Figure 129.

Figure 129. Modify Input TS - ASI port.

3. Enter a new name in the TS Name field. 

4. Click OK to save changes. 
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Modifying Output Transport Streams - GigE

The fields that can be modified on a GigE output transport stream for all TS Types are as follows:

• TS Name

• Multicast

• Destination IP

• UDP Port

• Subnet Mask

• ARP

• MAC Address

• Enable Message System

The following additional fields may be modified for an ATSC transport stream:

• Generate TVCT

• STT Source

• EIT Source

• RRT Source

The following additional fields may be modified for a DVB transport stream:

• Network ID

• Original Network ID

• NIT Source

• TDT/TOT Source

• SDT Source

• EIT Source

To modify a GigE transport stream, proceed as follows:

1. From the outputs side of the Grooming -> Mapping window, select the GigE transport stream that 
requires modification.
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2. Right-click on the TS and choose Modify Transport Stream from the popup menu.

The menu to modify an input TS on a GigE port will be similar to Figure 130.

Figure 130. Modify Output TS (MPEG-2 shown) - GigE port

3. Make any desired modifications to the editable fields. 

4. Click OK to save changes. 

Modifying Output Transport Streams - ASI

The fields that can be modified on an ASI output transport stream for all TS Types are as follows: 

• TS Name

• Enable Message System

The following additional fields may be modified for an ATSC transport stream:

• Generate TVCT

• STT Source

• EIT Source

• RRT Source

The following additional fields may be modified for a DVB transport stream:

• Network ID

• Original Network ID

• NIT Source

• TDT/TOT Source

• SDT Source

• EIT Source

To modify an ASI transport stream, proceed as follows:
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1. From the inputs side of the Grooming -> Mapping window, select the ASI transport stream that 
requires modification.

2. Right-click on the TS and choose Modify Transport Stream from the popup menu.

The menu to modify an output TS on an ASI port will be similar to Figure 131.

Figure 131. Modify Output TS - ASI port.

3. Make any desired modifications to the editable fields. 

4. Click OK to save changes. 

Modifying Input Programs

The only field that can be changed on an input program is the Program Name.

1. From the inputs side of the Grooming -> Mapping window, select the program that requires a 
name change.
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2. Right-click on the program and choose Modify Program Name from the popup menu. 
(Figure 132).

Figure 132. Program Pop-Up menu - Modify Program

The menu to modify an input program on a GigE or an ASI port will be similar to Figure 133.

Figure 133. Modify Input program - GigE or ASI port

3. Enter a new name in the Program Name field. 

4. Click OK to save changes. 

The Program Name is changed (Figure 134).

Figure 134. Program Name Changed
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Modifying Output Programs

The fields that can be changed on an output program are as follows:

• Program Name

• Any relevant ETV Configuration fields: 

- PIDs Priority

- Play Preference

- Late-Bind Source

• Any relevant Messaging System Setting fields:

- EAS Zone

- Operator Messaging Zone

- Logo Overlay Zone

Note: Any other attributes that you wish to change on a program must be changed on the program’s 
Elementary Stream(s). 

1. From the outputs side of the Grooming -> Mapping window, select the program that requires a 
name change.
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2. Right-click on the program and choose Modify Program from the popup menu. (Figure 135).

Figure 135. Program Pop-Up menu - Modify Program

The menu to modify an output program on a GigE or an ASI port will be similar to Figure 136.

Figure 136. Modify Output program - GigE or ASI port

3. Make any desired modifications to the editable fields.

4. Click OK to save changes. 
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Deleting Streams and Programs

Deleting grooming items is similar to modifying them.

To delete an item:

1. Navigate to the Grooming -> Mapping window. 

2. Select the item to be deleted and right-click. 

The options that appear on the right-click menu differ depending on the item selected. In each case, 
if the item can be deleted, the Delete option appears on the menu.

3. Choose Delete from the popup menu.

4. Click Yes in the confirmation window to confirm that you want to delete this item.

5. Type the new Program Name and click OK. 

Drag and Drop Grooming

You can drag and drop transport streams, programs, or data elementary streams. When you drag an 
input transport stream to the output transport stream, all of the programs are moved to the new output 
stream with it. You can drag a transport stream to a port, or over an existing transport stream. You can 
drag a program to a transport stream, or over an existing program. You can also drag an elementary 
stream to a program or to an existing elementary stream. 

Drag and drop grooming details are shown in Table 39.

Caution!  If you replace one transport stream with another, the original will be completely deleted. 

Table 39. Drag and drop grooming

When you drag: The grooming behavior:

Transport Stream to Transport Stream Deletes all current programs and replaces them with the 
dragged Transport Stream

Transport Stream to GigE Port The entire Transport Stream is copied to the output port

Program to Transport Stream The program is created in the Transport Stream; the 
Configure Program Mapping window appears, allowing you 
to modify the program mapping information

Program to Program Deletes the existing program and replaces it with the 
dragged program

Elementary Stream to Elementary Stream For EBIF, EISS, and regular data streams only; deletes 
existing ES and replaces it with the dragged ES. Opens the 
Configure Elementary Stream Mapping window. Only 
supports replacing the ES, not modification.

Elementary Stream to Program For EBIF, EISS, and regular data streams only; adds the 
dragged ES to the program. If the ES already exists in the 
program, the dragged ES will replace the existing ES.
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Drag and Drop Grooming Options

Following are configuration explanations of the various drop grooming options available from the 
Element Manager’s Grooming -> Mapping window.

Program to Transport Stream Grooming

1. Drag the desired input program and drop it onto the desired output transport stream. 

Figure 137. Drag input program to output TS

All of the PSIP tables and schedules that are part of the program will be set to the specified output 
port.

2. As soon as you drop the program, the Configure Program Mapping window appears.

Figure 138. Configure Program Mapping window
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3. Make any changes necessary as described in Table 40, below.

If this is a backup program, click the Program Redundancy tab and enter the input ports, transport 
streams, and programs. (See “Program Redundancy” on page 175 for details)

4. Click OK to finalize the output program information.

Program to Program Grooming

1. Drag the desired input program and drop it into the desired output program.

2. The Configure Program Mapping window appears (Figure 139).

Figure 139. Configure Program Mapping window - program to program

3. Make any changes necessary as described in Table 40 below.

If this is a backup program, click the Program Redundancy tab and enter the input ports, transport 
streams, and programs. (See “Program Redundancy” on page 175 for details)

4. Click OK to finalize the output program information.

The descriptions in Table 40 are applicable to both the program-to-transport stream and program-to-
program procedures described above.

Note: If you are using the drag and drop method of program creation and you wish to configure or 
enable Messaging System Settings for this program, you must modify the program after drag 
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and drop and then associate zones for the program as described in “Program Messaging 
System Setting” on page 154.

Table 40. Configure Program Mapping 

Category Field Description

Source 

Port Read-only. Specifies the input GigE or ASI port used for the 
input program. 

The GigE port to use, transport stream ID, program name and 
number for both the source and the destination of this program 
must be defined. For input streams, you can choose to 
Forward SCTE 35 Cue. For output streams, you can enable 
and specify PMT PID, and enable SCTE 30 to 35 Conversion.

TS ID Read-only. Specifies the input Transport Stream ID used for 
the input program.

Program Number Read-only. Specifies the program number for the input 
program.

Program Name Read-only. Specifies the program name (if one was given) for 
the input program.

Synchronize input 
and output program 
names

Check this box to synchronize the input program name with the 
output program name,

Forward SCTE 35 
Cue

Check this box to forward SCTE 35 cue tones from the input 
program. 

You cannot select this option and SCTE 30 to 35 Conversion 
for the same output program.

Destination

Port Displays the destination GigE or ASI port of the output port to 
which the program will be groomed.

TS ID Displays the destination Transport Stream ID of the output TS 
to which the program will be groomed.

Program Number Displays the destination program number of the output 
program to which the program will be groomed.

Program Name Displays the destination program name of the output program 
name to which the program will be groomed.

PMT PID Select this option to activate the PMT ID box, into which you 
can then enter the PMT ID, or the ID of the program map table 
(PMT)

Enable DPIa Select this option to enable DPI for the program only, rather 
than the whole TS.

• This option is hidden unless a PROGRAM WITH DPI license 
key has been entered in The License Manager.

SCTE 30 to 35 
Conversion

When checked, converts SCTE 30 messages to SCTE 35 
cues for transport to the destination.

You cannot select this option and Forward SCTE 35 Cue for 
the same output program.
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ETV Configurationb

ETV PIDs Priority Indicates the source of EBIF ES data for the duration of the ad 
time and provides the option to replace or not replace the pre-
bound EBIF ESs during ad splicing. 

• When Ad is selected, the spliced ad will provide the EBIF 
and EISS elementary streams (ESs). If the EBIF and EISS 
ESs from the ad do not match the stream type and 
descriptors of the network EBIF and EISS ESs, then the 
network EBIF and EISS ESs will be dropped. If no EBIF and 
EISS data are pre-configured at the output program or no 
EBIF and EISS data are present at the output then the EBIF 
and EISS ESs form the ad are dropped.

• When Network is selected, the EBIF and EISS ESs from the 
ad server will be ignored, even if they are present.

Default is set to Ad.

Play Preference When the ETV PIDs Priority is set to Network, the following 
three options will appear in a drop down box: 

• Play through ad: any EBIF ES data that is part of the output 
program will continue to be played during the ad.

• Drop during ad: any EBIF ES data that is part of the output 
program will be dropped during the ad.

• Play during ad only: provides the ability to select the input 
EBIF ES source that will be playing only during the ad time; 
if an EBIF ES source is not available, the EBIF ES that 
currently exists in the output program will be played.

Default setting is Play through ad. 

Late-Bind Source This option is only available when the ETV PIDs Priority is set 
to Network and the Play Preference is set to Play during ad 
only. 

• When the above two conditions have been met, an 
additional field with ellipses (. . .) will appear. Clicking on the 
ellipses will open the Late-Bind Source Dialog window, 
which will allow the option to choose a valid pair of EBIF/
EISS ESs from the BNP’s input.

Grooming Schedule

Now or Start Time To specify the time the program should start, or to continue 
until either manually stopped or to stop at a specified time, 
enable these features. If you choose to specify a start or stop 
time, enable the feature and type the time directly into the 
appropriate field. A check mark appears when the feature is 
active.

See “Scheduling Grooming - One time event” on page 174 for 
additional information.

Never or Stop Time To tell the program the time to start, or to continue until either 
manually stopped or to stop at a specified time, enable these 
features. If you choose to specify a start or stop time, enable 
the feature and type the time directly into the appropriate field. 
A check mark appears when the feature is active.

See “Scheduling Grooming - One time event” on page 174 for 
additional information.

Table 40. Configure Program Mapping (Continued)

Category Field Description
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Quality of Service 

Service Level This sets bit rate adaptation techniques applied to MPEG-2 
encoded streams to further enhance bandwidth efficiency.

Valid values for this field are as follows:

• Any integer from -8 to +8 

• 0 for off

• Bypass Transraterc

• Handle as Datad

• No Rateshaping

For additional configuration parameters on each of these 
values, see Table 41, “Service Level Configuration Details,” on 
page 169.

Max Video Bitrate Sets the limits for the maximum bitrate (in Mbps) for this 
program. Choosing a specific max rate will bypass automatic 
transrating based on priorities. 

Component PIDs

For this program input, this category allows stream grooming 
by deselecting specific input PIDs.

Input Type Specifies the stream type of the input ESs for this program.

PID Specifies the PID of the input ESs for this program.

Output Type If clicking in the blue space under this field, opens the Select 
Elementary Stream window, which will allow you to change the 
PID of the chosen ES.

PID If clicking in the blue space under this field, opens the Select 
Elementary Stream window, which will allow you to change the 
PID of the chosen ES.

Stay Unreferenced If the input program is a Ghost Program, the Stay 
Unreferenced option will appear in this section. Check this box 
if the PIDs in this stream are to remain unreferenced in any 
PSI tables. See “Adding an Unreferenced PID as an 
Elementary Stream” on page 190 for more information.

Treat As Async Data If the input program is a data-only program or all video and 
audio streams in the Component PIDs section are unchecked, 
the Treat as Async Data option will appear in this section. 
Check this box to disable PCR timing information for this 
program. 

Placeholder ETV 
ESs

If the input program does not contain EBIF and EISS 
elementary streams, a drop down box for the Placeholder ETV 
ES field will be displayed and editable. This option allows 
preconfiguration of an EBIF and EISS ES pair with a stream 
type of 5 or 192. When selecting either EBIF/EISS 5 or EBIF/
EISS 192 the system will automatically generate the following:

• 1 new ES with a Preconfigured for PMT setting of Yes for 
each EBIF and EISS stream. 
(See “Elementary Streams” on page 179.)

• 2 new Descriptor Rules for each new EBIF and EISS ES.  
(See “Managing PMT and ES Descriptors” on page 203.)

Table 40. Configure Program Mapping (Continued)

Category Field Description
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Configure Program Mapping Service Level Configuration Options

The Service Level field allows the assignment of transrating priorities and conditions for each 
program. Table 41 provides additional details for configuring the Service Level field. 

TS Type

TS Type The type of stream: MPEG-2, ATSC, SCTE, or DVB.

Major Channel 
Number

Operator-defined channel number: for terrestrial broadcast, the 
major channel number is limited to the range 1 to 99 for ATSC 
digital television or audio services. For cable, major channel 
numbers may range from 1 to 999. Only editable when ATSC is 
enabled.

Minor Channel 
Number

Operator-defined minor channel number: any whole number in 
the range from 0 to 999. Only editable when ATSC is enabled.

a. A GROOMING WITH DPI license key (which enables DPI for the TS) cannot co-exist with a PROGRAM WITH DPI 
license key.

b. For additional information on ETV configuration including details on various EBIF and EISS use cases, see Chapter 7, 
"ETV Binary Interchange Format (EBIF)."

c. This option should not be selected when grooming a DPI-enabled program.
d. This option should not be selected when grooming a DPI-enabled program.

Table 41. Service Level Configuration Details

QoS Service Level 
Configuration Video Processing

Can DPI be 
performed?

Effect on Video Output 
Bandwidth

Transrating Service 
Level Values

Video elementary stream 
(ES) is processed through the 
transrater.

• -8: highest transrating, 
lowest quality.

• +8: lowest transrating, 
highest quality. 

YESa

a. DPI sessions carry same QOS settings as network.

Transrated output video ES 
requires less bandwidth than 
input video ES.

No Rateshaping Video ES processing is 
limited through the transrater 
with null packet removal.

• Video quantization level is 
unchanged

YESb

b. DPI sessions carry same QOS settings as network.

Output video ES bandwidth will 
vary depending on level of ES 
null packet removal.

Bypass Transrater Video ES is not processed 
through the transrater. 

• Video can be displayed.

YES Output video ES uses the same 
bandwidth as input video ES. 

• Can not use more than the 
bandwidth of output TS.

Handle As Data Video ES is not processed 
through the transrater.

• Video cannot be displayed.

NO Output data ES is treated as 
data and will therefore use the 
same bandwidth as input video 
ES. 

• Can not use more than the 
bandwidth of output TS. 

• Total bandwidth should not 
exceed 4Mbps per TS.

Table 40. Configure Program Mapping (Continued)

Category Field Description
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Elementary Stream Grooming

You can groom an elementary data stream from the input of a program to another program in the 
output or to replace an existing elementary data stream within an output program.

To groom an ES from an input program to an output program, proceed as follows:

1. From the Inputs side of the Grooming -> Mapping window, select either the generic data or the 
EBIF / EISS elementary streams you wish to groom. 

Note: For information on the various data stream types and their icons, see Table 27 on page 125.

2. Drag the ES to the desired output program on the Outputs side of the Mapping window.

Figure 140. ES to Program Drag and Drop

The Configure Elementary Stream Mapping window will open.

Figure 141. Configure Elementary Stream Mapping window

All fields in the Configure Elementary Stream Mapping window are read-only except for the 
Output Type and corresponding PID value. For a description of the fields in this window as relates 
to ES mapping, see Table 42.

Data ES to groom

Data ES dragged 
onto output Program
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3. If desired, you can change the PID value of the ES by clicking in the blue space under Output 
Type or PID. This will open the following window:

Figure 142. ES Grooming - Reserved PID

4. Enter the desired New Reserved PID.

5. Click OK to save changes.

The new ES PID will be displayed in the Configure Elementary Stream Mapping window. 

Figure 143. Configure ES Mapping - Reserved PID

6. Click OK to complete grooming the ES to the output program.

Table 42 describes the fields available in the Configure Elementary Stream Mapping window.

Table 42. Configure Elementary Stream Mapping 

Category Field Description

Source

Port Displays the source GigE or ASI port of the elementary 
stream’s input program.

TS ID: Displays the source Transport Stream ID of the ES’s input 
TS.

Program Number Displays the source program number of the ES’s input 
program.

Program Name Displays the source program name of the ES’s input 
program.
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To groom an ES from an input program directly onto an output ES, proceed as follows:

1. From the Inputs side of the Grooming -> Mapping window, select either the generic data or the 
EBIF / EISS elementary streams you wish to groom. 

2. Drag the ES to the desired output ES on the Outputs side of the Mapping window.

Destination

Port Displays the destination GigE or ASI port of the output port 
to which the ES will be groomed.

TS ID: Displays the destination Transport Stream ID of the output 
TS to which the ES will be groomed.

Program Number Displays the destination program number of the output 
program to which the ES will be groomed.

Program Name Displays the destination program name of the output 
program name to which the ES will be groomed.

PMT PID Displays the Program Map Table PID assigned to the 
output program.

SCTE 30 to 35 
Conversion

Displays whether or not SCTE 30 to 35 Conversion has 
been enabled for the output program to which the ES will 
be groomed. 

Component PIDs

Input Type & PID 
Output Type & PID

Displays the ES Input Type and PID, Output Type and PID. 
For Input Type, the options that will be seen are as follows:

• Data

• EBIF

• EISS

Click the blue space under Output Type or PID to enter a 
reserved PID for this ES.

Treat as Async Data When grooming a data, EBIF, or EISS ES to an output 
program, the Treat as Async Data option will always be 
enabled. 

When data is treated as Async Data, then the timing 
information in the data stream is not processed. 

Table 42. Configure Elementary Stream Mapping (Continued)

Category Field Description

Input Data ES to groom Drag input ES to output ES
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Note: An elementary stream may only be groomed on top of an existing ES-level groomed 
elementary stream (not a program-level groomed stream), and the Stream Types of the input 
ES and the output ES must match.

The following ES confirmation message will appear:

Figure 144. ES Grooming Replacement window

3. Click Yes to replace the output ES.

Elementary Stream Grooming Icon Colors

When grooming an ES from an input program to an output program or directly onto an output ES, the 
icon representing that data stream will be displayed in green on the Outputs side of the Grooming -> 
Mapping window.

When grooming a complete program (and therefore all of its ESs) to an output TS or to replace an 
existing output program, the icons representing the data ESs will remain blue on the Outputs side of 
the Grooming -> Mapping window.

See Table 27 on page 125 for additional information.

Viewing Grooming Details

1. In the Outputs side of the Grooming -> Mapping window, select the transport stream or program 
whose details and schedule you want to see.

2. Right-click and select Display Grooming.

The BNP Element Manager will display the currently defined mapping and scheduling window. If 
you chose to view grooming for the whole TS, all grooming for the programs in that TS will be 
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displayed; if you chose to view grooming for a specific program, only the grooming for that 
program will appear.

Figure 145. Grooming detail display - TS

The presence of ES-level grooming is indicated by a black asterisk (*) next to the relevant ES in the 
Component PIDs section of the Current Program Mapping and Schedule window.

3. Click Refresh to refresh the view, or Cancel to close the window.

Note: In Figure 145, the times specified in the Grooming Schedule section (see Figure 146 for a 
sample) are from the NTP server. Your PC that is used for configuration may show a different 
time. This “PC time” should be disregarded; the start and stop times you enter will be 
referenced to the NTP server.

Scheduling Grooming - One time event

Note: It should be noted that proper use of BNP’s scheduled grooming feature depends on an NTP 
server as an accurate timing source. Additionally, when scheduling grooming, only a single 
event can be scheduled, rather than an ongoing occurrence. 

Indicates ES-level grooming
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To schedule grooming at a specific time for a one-time occurrence, perform steps 1 through 4 in the 
last section, “Creating Output Programs Manually” above in order to open the Configure Program 
Mapping window. Then proceed as follows:

1. From the Configure Program Mapping window, uncheck Now or Start time and click on the 
pull-down menu that appears. The following dialog opens:

Figure 146. Grooming schedule

2. If you want to start grooming immediately, click OK. If you want to start at a later time, set the time 
and date and then click OK.

3. To set the stop time, uncheck Never or Stop Time. The grooming schedule of Figure 146 appears. 
If you don’t want to stop grooming, click OK. To set a stop time, set the time and date for grooming 
to stop and click OK.

4. Click OK to apply the mapping to the program.

Program Redundancy

The BNP supports program level redundancy on all the output services. Program level standby is 
configurable using the Element Manager. The BNP allows the user to designate any input service as a 
“standby program” with the exception of the same service. The BNP returns back to the primary 
program from the standby program when the primary program recovers from the interruption.

The health of the standby program will be checked before failover, and the BNP will not perform the 
switch if the standby is degraded.

Modes of Program Redundancy Operation

The BNP supports two modes of Program Redundancy operation—one offering automatic recovery 
from the backup program to the primary program while the other allows the user to manually select 
when the recovery process should occur.
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Table 43 describes the various modes of operation for program redundancy.

Figure 147. Program Redundancy

To Configure Program Redundancy

1. From the Grooming -> Mapping window, drag and drop an input program to either an output 
transport stream or an output program.

The Configure Program Mapping window will open.

2. Click the Program Redundancy tab.

3. Check the Specified Program Backup box at the top of the screen.

4. Drill down in the input grooming window and select the program which is to be the backup for the 
output program.

5. Under the Selected Program Redundancy Mode section, select whether or not this program is to 
act as Automatic Failover / Automatic Recovery or Automatic Failover / Manual Recovery.

Table 43. Program Redundancy Modes of Operation

Category  Primary to Backup Backup to Primary

Automatic Failover to Backup 
Program / Automatic Recovery 
to Primary Program

Automatic failover operation is based 
on two conditions detected, either one 
will trigger a failover to the designated 
backup program:

• Video ES failure detection

or

• Missing PAT/PMT detection.

Automatic recovery operation is 
based on two conditions detected, 
both are required to trigger a 
recovery to the primary program: 

• Video ES recovery detection

and

• PAT/PMT detection.

Automatic Failover to Backup 
Program / Manual Recovery to 
Primary Program

Automatic failover operation is based 
on two conditions detected, either one 
will trigger a failover to the designated 
backup program: 

• Video ES failure detection,

or

• Missing PAT/PMT detection.

Manual recovery operation is 
based on the user selecting when 
a single program or all programs 
should be recovered to their 
respective primary programs.
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Figure 147 shows an example of program redundancy in which the backup is selected as GigE 2, 
Transport Stream ID 0x5c, and Program Number 1.

Figure 148. Configure Program Mapping - Program Redundancy

Manual Recovery Procedures

The BNP supports the ability to manually switch between the Primary and Backup program. Follow 
this procedure for manual recovery:
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1. From the Outputs side of the Grooming -> Mapping window, right-click the desired program and 
select Display Grooming from the pop-up menu.

The Current Program Mapping and Schedule window opens (Figure 149).

Figure 149. Program Redundancy - Manual Recovery

2. Select the scheduled program and right-click.

3. From the pop-up menu, select Switch to Backup.

The Switch to Backup option is available when the selected program is already in the Manual 
Recovery to Primary Program operation mode. (The Automatic Recovery to Primary Program mode 
does not allow staying in the Backup Program.)

Figure 149 above illustrates the Manual Recovery selection for program redundancy operation on 
individual programs. This can be used for the Manual Recovery Primary Program procedure 
following an Automatic Failure to Backup Program, or for toggling between primary and backup 
programs for test purposes.

To recover all programs, from the main Element Manager window, select Maintenance -> Regroom. 
See “Regrooming” on page 114 for additional information. 
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Elementary Streams

Creating an Elementary Stream

To add a new elementary stream to an output program:

1. From the Outputs side of the Grooming -> Mapping subtab, select the program to which you 
want to add an elementary stream.

2. Right-click and select Manage Elementary Streams from the pop-up window. The window of 
Figure 150 appears (The stream entries will vary per program).

Figure 150. Manage Elementary Streams

3. Click Add ES. 

4. A new elementary stream entry will appear below the last stream. 

By default, the new stream is an AC-3 Audio stream. See Figure 151 for an example.

Note: An ES Type, Stream Type, PID number, Dummy value, and Preconfigured for PMT value 
can only be modified when the word “New” appears next to it in the Stream Order column. 
Once you click OK to save changes, you will not be able to modify any of these parameters for 
this particular stream without deleting the stream and adding it again.
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Figure 151. Manage Elementary Streams - New

5. Modify the ES Type, Stream Type, PID, and Dummy status (if applicable) by clicking or double-
clicking on each field under the respective column. (See Table 44 for details.)

For ES Type, a drop down box will be displayed with applicable choices:

Figure 152. Manage Elementary Streams - ES Type choices

Stream Order must 
display “New” in order 
to modify the stream.
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For Stream Type, if the ES Type is Video, a drop down box will appear with applicable choices:

Figure 153. Manage Elementary Streams - Stream Type, drop down

If the ES Type is Audio, the following selection window will appear:

Figure 154. Manage Elementary Streams - Audio Selection

If the ES Type is Data, the following selection window will appear:

Figure 155. Manage Elementary Streams - Data Selection
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Note: When Stream Type is EBIF, EISS or EBIF and EISS, two new descriptor rules will be 
automatically added for each new EBIF or EISS stream. See “Managing PMT and ES 
Descriptors” on page 203 for additional information.

For PID, double-clicking the field will render it editable and you can type in the new PID:

Figure 156. Manage Elementary Streams - PID

Note: When entering a PID you must enter its decimal conversion from its hex listing in the Outputs 
side of the Grooming -> Mapping window. For example, if you are creating a Dummy PID 
based on an input data stream that has been groomed to a program on an output TS whose 
PID is 0xf05 (note, the “0x” portion of the PID is for internal reference only), the decimal 
conversion would be as follows: 
 
hex: F05 converts to decimal: 3845.

Edit PID field.
Convert hex to 
decimal
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If the ES Type field is Data, clicking on the Dummy field will produce a drop down box with the 
choice of Yes or No.

Figure 157. Manage Elementary Streams - Dummy

Clicking on the Preconfigured for PMT field will produce a drop down box with the choice of Yes 
or No.

Figure 158. Manage Elementary Streams - Preconfigured for PMT
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6. Click OK when you are done modifying the elementary stream to save all changes. The new stream 
will be displayed in the Outputs side of the Grooming -> Mapping window.

Table 44 provides a description of the fields from the Manage Elementary Streams menu.

Table 44. Manage Elementary Streams menu

Field Description

Stream Order Read-only. Displays the order of the stream in the program mapping table 
(PMT).

Grooming Status Read-only. Displays whether or not the stream is currently groomed.

ES Type Read-only if changes have been saved (i.e., OK has been clicked).

If the changes to the stream have not yet been applied, clicking this field will 
open a drop down menu with the following options from which to choose:

Audio, Data, or Video.

Stream Type Read-only if changes have been saved (i.e., OK has been clicked).

If the changes to the stream have not yet been applied, and depending on 
the selection from ES Type, clicking this field will open variable options:

• If Stream Type is Audio, a new window will open allowing you to choose 
Audio Type and Language Selection.

• If Stream Type is Dataa, a new window will open with two drop down boxes 
as follows: 
 
Stream Type: choice of decimal values from 5 to 255b.  
Stream Sub Type: choice of Data, EISS, EBIF, and EBIF and EISS 

• If Stream Type is Video, a drop down box will appear with choice of 
MPEG2 Video, H.264 Video, or SCTE Video.

PID Read-only if changes have been saved (i.e., OK has been clicked).

If the changes to the stream have not yet been applied, double-clicking this 
field allow you to modify the PID associated with the new elementary stream.

• You must enter this value as a decimal conversion of the hex format which 
appears in the Grooming -> Mapping window.

Dummy Read-only if stream is groomed; only applicable for data stream.

Clicking this field will bring up a drop down box with the following options:

• Yes: Select this if the elementary stream is a dummy stream and the 
associated data stream with the same PID is carried by another program 
in the same transport stream. 

• No: This is a read-only value which will appear if the PID is “non-dummy” 
and therefore treated as a regular stream.

Note: The Preconfigured for PMT and Dummy fields are mutually exclusive; 
therefore, when one is set to Yes, the other will be automatically set to No
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Reordering an Elementary Stream

You can reorder an elementary stream to change the order of the stream in the PMT. (If, for example, 
you wish to change the order a stream is placed in the PMT when sent to the end-user’s STB.)

1. Highlight the stream you want to reorder (Figure 159).

Figure 159. Reordering an Elementary Stream

Preconfigured for PMT Read-only if stream is groomed; applies to all stream types, but most useful 
for EBIF / EISS streams.

• Provides the ability to preconfigure the ES by creating associated 
descriptor rules, regardless of whether or not the data for the 
corresponding ES is present in the MPEG stream. When the 
Preconfigured for PMT option is set to Yes, the BNP will not update the 
PMT, as the assumption is the data is already included in the PMT. 

Note: The Preconfigured for PMT and Dummy fields are mutually exclusive; 
therefore, when one is set to Yes, the other will be automatically set to No. 

Reserved Read-only. If the stream is a reserved PID, Yes will appear; if the stream is 
not a reserved PID, the field will be empty.

a. When Stream Type is EBIF, EISS or EBIF and EISS, two new descriptor rules will be automatically added for each new 
EBIF or EISS stream. See “Managing PMT and ES Descriptors” on page 203 for additional information.

b. This number appears as hex in the Grooming -> Mapping window; you will need to perform hex to decimal conversion 
when selecting this value

Table 44. Manage Elementary Streams menu

Field Description

Stream to be reordered



Grooming and PSIP

186 BNP3xr User Guide

2. Click Up or Down as required to put the stream in its proper place.

Figure 160. ES Reordered

3. When you are done, click OK.

Elementary Stream Remapping

You can create a reserved PID or select any specific PID from existing output PIDs, while doing 
grooming in the Configure Program Mapping screen, as an outgoing PID.

You have the flexibility of selecting any PID value for an outgoing PID. When you select from an 
existing PID then it should be of the same ES Type and language (for audio) as the corresponding 
Input ES. If there is no exact match then you cannot select that existing output PID.

You can’t create a Reserved PID for Video if there is an existing video PID in the output program on 
which you are grooming.

Reserved PIDs

Reserved PIDs allow you to create PIDs under output programs which will maintain PID values and 
ES Type and Subtype across reboots and regrooming even when the PID is not groomed. These types 
of output elementary streams are called Reserved PIDs.

The Manage Elementary Streams screen can be used to add the ES and to specify its PID and 
subtype, as well as the language for the audio ES. The subtype of the reserved video stream will be 
overwritten by the input Video Subtype but the PID value will be maintained. You can delete any 
reserved ES if it is not groomed from the main screen by right-clicking the ES, and choosing Delete.

Stream reordered
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See “Unreferenced PID Mapping” on page 196 for steps on creating reserved PID mapping.

Dummy PIDs

To configure a Dummy PID:

1. Groom the actual data stream which you wish to create a dummy PID for from an input program to 
a desired output program. 

In this example, we wish to create a dummy data PID that is associated to the real data stream:  
Data [PID: 0x21 Data 0xc2] in Program 6975 BBC HD

Figure 161. Dummy PID: Real data stream groomed

2. Select the program under which you wish to create a Dummy PID, right-click, and select Manage 
Elementary Streams from the pop-up menu. 

In this example, we will use Program 6904 BBC 1 C1.

Dummy PID will be associated to this Data stream.
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3. From the Manage Elementary Streams window, click the Add ES button.

A new audio ES will appear as the last entry to the list of streams.

Figure 162. Manage ES - New ES for Dummy PID

4. From the ES Type column, change the ES Type from Audio to Data from the drop-down window.

Note: See the section, “Creating an Elementary Stream” on page 179 for complete details on 
manipulating the fields in the Manage Elementary Streams window.

5. From the Data Selection window, select the decimal number that matches the actual data stream’s 
hex ID (this is NOT the PID). 

In this case, we will choose the number “194” as it matches the hex number “c2” from the data 
stream: 
Data [PID: 0x21 Data 0xc2] in Program 6975 BBC HD.

6. Double click in the PID column and enter the decimal value that corresponds to the hex value from 
the actual data stream.

In this case, we will enter the number “33” as it corresponds to the hex value of “21” in the data 
stream: 
Data [PID: 0x21 Data 0xc2] in Program 6975 BBC HD.
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7. From the Dummy column, select Yes from the drop down box to indicate this is a dummy PID.

The Manage Elementary Streams window should now look like this:

Figure 163. Manage Elementary Streams - Dummy PID fields completed

8. Click OK to save changes and add this stream to the Outputs side of the Grooming -> Mapping 
window.

The data stream (grayed out to indicate dummy PID reference) with associated dummy PID will 
show up under the appropriate program as seen in Figure 164 below.

Figure 164. Dummy Data PID in Grooming -> Mapping window

Dummy Data ES greyed out, 
matching with real Data ES
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9. Repeat Step 2-Step 8 for each additional program (within the same transport stream) under which 
you wish to create a dummy PID reference.

Dummy PID Configuration Guidelines

The following guidelines should be taken into account when configuring data streams that use dummy 
PIDs:

1. You cannot configure a Dummy PID data stream unless an actual data stream has been groomed to 
a program in the relevant transport stream.

2. You cannot delete a program with a data stream to which other dummy PID streams point.

3. If you are creating multiple dummy PIDs under one program, they must all point to the original data 
streams from a single program. You cannot create multiple dummy PIDs in one program that point 
to data streams from multiple programs.

4. You can only reference a dummy PID data stream to a data stream in a program that is within the 
same transport stream. 

5. A dummy data PID referenced in a output program will be used regardless of the input source, such 
as the originally groomed network program source, during program redundancy or program 
substitution service, or during a DPI ad insertion.

6. You cannot configure the value in an ES as “Yes” for the Dummy field and “Yes” for the 
Preconfigure in PMT field at the same time.

Deleting Dummy PIDs

To delete a dummy PID:

1. From the Grooming -> Mapping window, select the dummy PID data stream.

2. Right-click and select Delete.

Adding an Unreferenced PID as an Elementary Stream

You can add an unreferenced PID to an input transport stream. This allows you to manage 
unreferenced PID inputs for various applications in the BNP output. Unreferenced PID streams are 
those MPEG-2 elementary streams encapsulated in the MPEG-2 SPTS or MPTS, whose PIDs are not 
referenced in any PSI (PAT and PMT) tables. These unreferenced PID streams may be purposely 
inserted for some special control and applications; they could also result from the stream originator's 
error. 

Unreferenced PIDs can come from the program inputs from GigE interfaces or from ASI inputs. In 
some applications, these unreferenced PIDs need to be routed to the appropriate output GigE ports or 
ASI ports as pass-through or with or without the PIDs being remapped. In other cases, these 
unreferenced PIDs need to be dropped, either because such unreferenced PIDs are not needed or the 
streams are corrupted. 

To add unreferenced PIDs as Elementary Streams:

1. From the Inputs side of the Grooming -> Mapping subtab, select the transport stream to which 
you want to add one or more unreferenced PIDs.
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2. Right click the transport stream and choose Create Ghost Program from the pop-up window 
(Figure 165).

Figure 165. Choosing a Ghost Program

3. The Create Ghost Program screen of Figure 166 appears.

Figure 166. Create Ghost Program

4. Enter the Ghost Program Name. Click OK. A new program stream appears (Figure 167).

Figure 167. New Program Stream
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Figure 168. Adding an Elementary Stream

5. Right click the new Ghost Program you have created, and choose Add Elementary Stream 
(Figure 169).

Figure 169. Adding Elementary Stream: Single ES left, Multiple ES right

6. From the pull-down menus, select the Stream Category, Stream Type, and PID. 

If you check Multiple ES, you can simultaneously define sequential unreferenced PIDs by entering 
the number of Elementary Streams (Number of ES) and the Start PID.
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7. Click OK. The new PID appears (Figure 170).

Figure 170. New Unreferenced PID

Elementary Stream Ghost PID Management

Ghost programs and PIDs are extra input and output streams not referenced in a Program Association 
Table (PAT). The BNP allows you to manage elementary stream (ES) Ghost PIDs in three ways:

• Unreferenced PID Pass Through. The PID output is unreferenced in the Program Mapping Table 
(PMT) nor is there any mapping to any other program or transport stream table. Typical 
applications are Data PID transport and grooming.

• Unreferenced PID Mapping. This has no reference in the PMT, but is mapped as a table entry in 
the PAT at the transport stream level. This is used in various electronic program guide (EPG) 
applications.

• Referenced PID Mapping. The PID output is referenced as a PMT entry. A typical application 
might be to associate EPG data with one or more programs. 

Unreferenced PIDs streams are those MPEG-2 streams encapsulated in the MPEG-2 SPTS or MPTS 
but their PIDs are not referenced in any PSI (PAT and PMT) tables. These unreferenced PID streams 
may be purposely inserted for some special control and applications; they could also result from the 
stream originator's error. 

Unreferenced PIDs can come from the program inputs from GigE interfaces or from ASI inputs. In 
some applications, these unreferenced PIDs need to be routed to the appropriate output GigE ports or 
ASI ports as pass-through without or with PIDs remapping. In other cases, these unreferenced PIDs 
need to be dropped, either because such unreferenced PIDs are not needed or the streams are 
corrupted.

The BNP allows you to add and drop the unreferenced PIDs in its inputs from both GigE and ASI 
ports.

The BNP can groom the unreferenced PIDs from the inputs to the appropriate output transport stream 
(SPTS or MPTS) with or without PID remapping using the GUI configuration for the unreferenced 
PIDs.

Unreferenced PIDs associated with program inputs are usually known in advance, so they can be 
configured through the GUI for pass-through or drop. The GUI enables the user-configurable 
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remapping as an output PID for the input unreferenced PID; the output PID can also be referenced in 
the output TS when necessary through GUI configuration. 

For input ASI ports, the TS is automatically created for the input ASI port. User-configured 
unreferenced PID streams are routed based on grooming rules.

The BNP guarantees there is no conflict between the unreferenced PIDs and the referenced PIDs in its 
output MPTS or SPTS. If there are unreferenced PIDs causing conflict in the output MPTS or SPTS, 
then the groomed unreferenced PID causing the conflict is dropped. This could happen when an 
unreferenced PID is not allowed to be remapped for output.

Unreferenced PID Pass Through

To add an unreferenced PID:

1. Start by creating a ghost program with a data ES, and mapping the unreferenced PID from a pro-
gram input such as that shown in Figure 171.

Figure 171. Ghost Program With Unreferenced PID.
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Elementary Stream Ghost PID Management

2. Drag and drop the ghost program from the Inputs side of the Grooming -> Mapping window to 
the desired output transport stream. 

The Configure Mapping Window appears (Figure 172).

Figure 172. Ghost Program Dragged and Dropped to Output TS

3. Note the PID number of the component PID, in this case 115. You will need this when you want to 
create a referenced PID mapping.

4. Be sure that the Stay Unreferenced box is checked, and click OK.

The Ghost Program and its Data Transport stream with PID of 0x73 (hex conversion from decimal) 
appears on both the input and output (Figure 173) showing the stream has been passed through.

Figure 173. Ghost Program Passed Through
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Unreferenced PID Mapping

We start with a window as shown in Figure 174.

Figure 174. Starting Unreferenced PID Mapping
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Elementary Stream Ghost PID Management

1. Highlight the appropriate output port and choose Create Output Transport Stream (Figure 175).

Figure 175. Create Output Transport Stream

2. Enter the Destination IP address and the UDP Port number, choose DVB as the TS Type and click 
OK.
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3. Drag the Ghost Program from the input of Figure 174 and drop it on the DVB transport stream you 
just created. The Configure Program Mapping window (Figure 176) appears.

Figure 176. Configure Program Mapping Window

4. Be sure that the Stay Unreferenced box is checked.

5. Click the empty space to the right of the Component PIDs. The Select Elementary Stream 
window of Figure 177 appears.

Figure 177. Select Elementary Stream Window

6. Enter the new reserved PID number and click OK. 

7. Click OK in the Configure Program Mapping window. The unreferenced PID is mapped.
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Elementary Stream Ghost PID Management

Referenced PID Mapping

Input Ghost ES PIDs can be groomed by the BNP and referenced as ES PIDs in one or more program 
in the output TS. To add a referenced PID to two programs:

Figure 178 shows the starting window with the unreferenced data PID ES created under a Ghost 
Program on the input.

Figure 178. Starting Window for Referenced PID Mapping

1. Drag and drop the input ghost program (in this case: Ghost-Program-1) to the output transport 
stream. Be sure the Stay Unreferenced box is checked (Figure 179).

Unreferenced data PID 
in Ghost Program Output program to 

which the Ghost PID 
will be referenced.
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Note: The ghost program must be groomed to the output TS first (Step 1) before creating a dummy 
PID as described in Step 4.

Figure 179. Mapping the Transport Stream

2. Click OK.

The ghost program and its unreferenced PID appear in the Outputs side of the Mapping window.
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Elementary Stream Ghost PID Management

3. Highlight the output program (from Figure 178) you wish to reference the data PID to, right click 
and choose Manage Elementary Streams.

Figure 180. Manage Elementary Streams

4. Click Add ES and fill in the new row (Figure 181) as described in “Dummy PIDs” on page 187. 
You will need to know the PID reference, which, in this case, is 115. Be sure to select Yes in the 
Dummy column.

Figure 181. New ES filled In
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5. Click OK.

The new ES will appear under the program. The mapping window shows the same PID in both 
programs, with the (dummy) PID in Program 1 grayed out.

Figure 182. Dummy data PID in Program grayed out

Clicking on the program of the grayed out data PID and selecting Manage Elementary Streams 
will show the Dummy PID status of Yes and a Reserved PID status of Yes as well:

Figure 183. Manage ES - Dummy and Reserved status
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Managing PMT and ES Descriptors

The Element Manager provides the ability to create program descriptor rules that the BNP will apply 
when it sends out a Program Management Table (PMT) for a specified output program. The rules 
allow for the appending or removal of output stream descriptors on the PMT level and will remain 
persistent upon program regrooming. 

To manage program descriptor rules, proceed as follows:

1. From the Outputs side of the Grooming -> Mapping window, right-click over the program whose 
descriptor rules you wish to modify.

2. Select Manage Descriptor Rules from the pop-up menu.

Figure 184. Manage Descriptor Rules pop-up

The Manage Descriptor Rules window opens.

Figure 185. Manage Descriptor Rules window
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To Add a Program Descriptor Rule

1. From the Manage Descriptor Rules window, click the Add Rule button.

Figure 186. Add Descriptor Rule window

2. Fill in the fields according to the parameters described in Table 45 on page 205.

3. Click OK to create the rule.

A “New” status will appear for the descriptor in the Manage Descriptor Rules window. This means 
that the new rule has not yet been applied to the BNP.

Figure 187. Add Descriptor Rule - New status

0x
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Managing PMT and ES Descriptors

4. Click OK in the Manage Descriptor Rules window to apply the new rule change to the BNP, 
which will remove the “New” status from the far left of the menu (Figure 188).

Figure 188. Manage Descriptor Rules - Rules Added

5. Click Cancel to close the window. 

Table 45 describes the fields available in the Add Descriptor Rule menu.

Table 45. Manage Descriptor Rules fields  

Field Description

TS This field is read-only. Displays the Transport Stream ID and type for which 
the rule will apply.

Program This field is read-only. Displays the name of the program for which the rule 
will apply.

Name For reference use only when appending (or adding) an output program 
descriptor. Do not enter data in this field when removing a descriptor.

Action Specify which action is to occur for this rule. Choices are:

• Append Descriptor: adds the specified descriptor to the PMT of the output 
stream. The descriptor is appended to the end of the program descriptor 
loop if the PID is 0, or the ES descriptor loop if the configured PID matches 
the elementary stream PID.

• Remove Descriptor: removes the specified descriptor from the PMT of the 
output stream. If the BNP doesn’t find a match descriptor in the PMT, no 
action is taken.
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Figure 189 shows an example of the DEC to HEX toggle view in the Add Descriptor Rule window.

Figure 189. Add Descriptor Rule - DEC to HEX toggle

PID Specifies the PID of the stream. Valid range is from 0 to 8190. If the 
descriptor is a program descriptor, enter a value of 0. Otherwise, enter the 
elementary stream (ES) PID value; the descriptor rule is applied to this ES.

• Clicking the green DEC button in this field will toggle the field from decimal 
to hex view. 

• Clicking the green HEX button in this field will toggle the field from hex to 
decimal view.

• See Figure 189 for an example of the DEC to HEX toggle view.

TAG Specifies the TAG of the stream. First 8 bits of the descriptor packet as 
viewed from an MPEG analyzer. 

Valid range is from 0 to 255 (decimal) or 0 to FF (hex), up to 8 bits.

• Clicking the green DEC button in this field will toggle the field from decimal 
to hex view. 

• Clicking the green HEX button in this field will toggle the field from hex to 
decimal view.

• See Figure 189 for an example of the DEC to HEX toggle view.

Descriptor Data(Hex Data): Enter the hex value program descriptor to be appended or removed to or 
from the PMT of the output stream.

• This value must be an even numbered hex value.

• This value must be an exact match for the program descriptor as known or 
discovered through an MPEG analyzer. The BNP will not discover or 
display the descriptors from the actual TS.

• When the rule applies to an input stream, the Descriptor Data field is 
passed through based on information from the input program. 

Table 45. Manage Descriptor Rules fields  (Continued)

Field Description
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To Edit a Program Descriptor Rule

1. From the Manage Descriptor Rules window, highlight the descriptor rule you wish to edit.

2. Click the Edit Rule button.

The Add Descriptor Rule window will open for the highlighted rule.

3. Edit the fields for the descriptor rule, following the guidelines listed in Table 45 on page 205.

If the rule you wish to edit has already been applied to the BNP, you will only be able to edit the 
Descriptor Data field.

4. Click OK to save changes.

The status field at the far left of the Manage Descriptor Rules window will show a status of 
“Changed.”

Figure 190. Edit Descriptor Rule - Changed status

5. Click OK in the Manage Descriptor Rules window apply the new rule change to the BNP, 
removing the “New” status from the far left of the menu. 

6. Click Cancel to close the window. 

To Delete a Program Descriptor Rule

1. From the Manage Descriptor Rules window, highlight the descriptor rule you wish to delete. 

2. Click the Delete Rule button.
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3. You will be asked if you are sure you want to delete the rule.

Figure 191. Manage Descriptor Rules - Rules Deleted

4. Choose Yes.

5. The rule is deleted from the Manage Descriptor Rules window, as well as removed from the BNP.

Monitoring Bitrates

The second tab on the Grooming window is used to monitor input bitrates, and the third tab is used to 
monitor input-output bit rates. The BNP Element Manager shows real-time bit rates.

To change the information displayed for the second tab, use the buttons on the lower left panel. To 
change the information for the third tab, use the selectors across the top of the window. Select a port 
and a transport stream. 

To select the direction in which to view streaming, move to the upper right of the window. Select 
Input, Output, or both. A checkmark appears beside the stream direction. The selected direction 
streams appear in the bar graph beside each other for easy comparison. If only one direction is 
selected, no comparison is performed.

Input and output bit rates are shown in a bar graph. For the percentage of total output bit rate for each 
program, use the lower portion of the window. The bar on the lower right shows the total input rate 
compared to the assumed output rate. You can change the output bitrate by typing a new rate into the 
Output bitrate field. By default, output bitrate is set to 38.7. 
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The BNP can simultaneously monitor only 14 programs. If the total selected number of programs 
exceeds 15, the programs in the earlier monitoring list will be shifted out, and the new selected 
programs will be added to the bottom of the list. The bit rate monitor window only keeps up to 14 
programs.

Each program is shown as a percentage of the total. 

Figure 192. Input Monitoring bitrates

Select the port or transport stream from the dropdown menus at the top, and choose input, output, or 
quantization level (level at which an analog signal is sampled as determined by the resolution of the 
analog-to-digital converter) to view. You can view any or all simultaneously.
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The bar shows the total input rate compared to the assumed output rate. You can change the output 
rate. If the input rate exceeds the output rate, the total estimated transrating is displayed as shown in 
Figure 193.

Figure 193. Input bitrate exceeds output

The estimated transrating percentage is computed as follows:

% Rate Control=(input rate - output rate)/input rate

To stop real-time polling and freeze the bar graph, click Stop in the lower right corner. The button 
changes to Start when real-time polling is stopped. To restart the polling, click Start.
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Each selected counter displays in a separate graph: in the figure below, the top graph shows output 
quantization levels, while the lower graph shows input and output bitrates.

Figure 194. Input-Output Bit Rate Monitor tab

Start/Stop 
button

Selectors
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CHAPTER 6

Digital Program Insertion (DPI)

This chapter describes digital program insertion and how it relates to the BNP3xr. 

To implement DPI on the BNP3xr, you need either a GROOMING WITH DPI license key or a 
PROGRAM WITH DPI license key. See “The License Manager” on page 111 for additional 
information. 

In This Chapter:

• “Digital Program Insertion,” next.

• “Connecting an Ad Server to the BNP” on page 214.

• “Setting SCTE 30 and SCTE 35 Message Handling” on page 215.

• “Setting Postblack Options for DPI” on page 217.

Digital Program Insertion

The BNP supports industry standard digital program insertion (DPI) applications, such as program 
substitution and ad insertion. 

The BNP is fully interoperable with industry compliant ad servers through the SCTE 30 interface. 
When a successful SCTE 30 initialization has been established with the BNP, the Element Manager 
indicates such with an arrow icon on the Input/Output window of the Grooming -> Mapping tab.

The BNP is fully compliant with the SCTE 30 and SCTE 35 standards. A common DPI / ad insertion 
application deployment using SCTE 30 and 35 (the latter carrying in-band availability cue messages) 
may be represented by the following regional ad zone insertion illustration:

Figure 195. Regional Ad Zone Insertion Illustration
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The BNP receives ads along with SCTE 30 splice messages from an ad server. Receiving these 
messages triggers the BNP to splice the ad. The ad is then treated the same as other objects in the BNP 
configuration.

Note: It is highly recommended that you use an NTP server with the BNP. An NTP server is required 
if you are performing Digital Program Insertion (DPI) and dynamic grooming. You must have 
the NTP server up and running prior to booting up your BNP.

Note: When configuring a DPI-enabled program, do not use Bypass Transrater or Handle as Data 
Quality of Service levels when grooming a program. See Table 41 on page 169 for additional 
information. 

Connecting an Ad Server to the BNP

Figure 196 shows how the ad server is connected to the BNP. Other connections may be possible, but 
this figure shows the general connection.

Figure 196. Ad server - BNP connection

10/100BT
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Setting SCTE 30 and SCTE 35 Message Handling

Setting SCTE 30 and SCTE 35 Message Handling

The BNP is capable of receiving SCTE 30 messages from an ad server and converting those messages 
into SCTE 35 messages.

Figure 197. SCTE 30 to SCTE 35 Conversion

The BNP is also capable of forwarding SCTE 35 messages from input streams to output streams 
during network time and ad time.

To set SCTE 30 and 35 message handling options:

1. Launch the Element Manager and log in as the administrator as described in “Launching the BNP 
Element Manager” on page 32.

2. Select the Grooming -> Mapping window.

3. Groom an input program to an output transport stream as described in “Drag and Drop Grooming” 
on page 163.

The Configure Program Mapping window appears.
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4. From the Configure Program Mapping window, check either the Forward SCTE 35 Cue or the 
SCTE 30 to 35 Conversion box. 

Figure 198. Configure Program Mapping window

5. Click OK.

Note: You can either forward SCTE 35 cues from the input stream or convert SCTE 30 messages 
from an ad server, but not both.

Note: Once SCTE 30 to 35 Conversion is enabled, the BNP only performs conversion; no splicing is 
performed.

When you choose Forward SCTE 35 Cue or SCTE 30 to 35 Conversion on an output program, the 
BNP automatically allocates a PID for the cue (splice information) table, even if the input program 
contains no cue table. Figure 199 shows an example of an input program with no cue table groomed to 
an output program selected to forward SCTE 35 cues. Notice the allocation for the cue table in the 
output program.

Figure 199. Allocated PID for Cue Table

Input program with
no cue table

Cue table added
in groomed 
output program
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Setting Postblack Options for DPI

Postblack refers to insertion of black video and muted audio at the end of a spliced ad. Postblack might 
be necessary if the ad is shorter than the specified duration or if there are transmission errors. The BNP 
offers the following configuration options for postblack.

• Postblack in ad server requests — Determine whether to accept or ignore postblack settings in 
SCTE 30 Splice Request messages from ad servers. 

• Postblack for ad underflows — Determine whether to insert postblack after ads that are shorter 
than the time specified in the SCTE 30 Splice Request message. If enabled, postblack is inserted at 
the end of the ad for the remaining time.

Postblack handing is a global setting on the BNP. To view and configure postblack settings:

1. From the Element Manager, select Configuration -> Global.

The Global chassis configuration window appears.

Figure 200. Global chassis configuration
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2. Set your postblack options according to the following table:

3. Click Apply Configuration.

Table 46. Postblack Enable Options

Category Field Description/Values

Postblack Enable 
Options

AD Server Request Check this to play postblack that an ad server 
specifies be played at the end of an ad. Left 
unchecked, the BNP will ignore any postblack 
requests from ad servers.

AD Underflows Check this to insert postblack at the end of an ad that 
is shorter than the duration specified by the ad server.
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CHAPTER 7

ETV Binary Interchange Format (EBIF)

This chapter describes how the BNP can be configured to process Enhanced Television (ETV) Binary 
Interchange Format (EBIF) content for delivery of interactive data in the video processing network. 

In This Chapter:

• “Overview,” next.

• “Functionality” on page 219.

• “Prerequisite Reading” on page 219.

• “Use Case Configuration Examples” on page 220.

Overview

The CableLabs EBIF standard provides a solution for the delivery of interactive data to existing set-top 
boxes (STBs), including older models of STBs. EBIF condenses interactive applications in order to 
use the minimal STB resources available for interactive data delivery. Since ETV can make use of 
scant resources, the MSO has the ability to deliver interactive broadcasts and advertisements to the 
widest possible audience, including the STB user who still relies on legacy hardware. Because ETV 
applications are very compact and can be downloaded to the STB rapidly, the ETV format is 
particularly suitable for authoring interactive commercials.

Prerequisite Reading

In order to better understand the Use Cases described in this chapter, you should familiarize yourself 
with the concepts and steps described in Chapter 5, “Grooming and PSIP.” In particular, the following 
sections will be useful:

• “Viewing ES-Level Input Source” on page 123.

• “Interpreting Elementary Stream Status Icons” on page 125.

• “Creating Programs” on page 151.

• “Drag and Drop Grooming” on page 163.

• “Elementary Streams” on page 179.

• “Managing PMT and ES Descriptors” on page 203.

Functionality

ETV is interpreted by a User Agent: a software application that runs on the set-top box that is installed 
remotely by the MSO. 
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When ETV is downloaded to the STB, it uses a pairing of data elementary streams, which consist of 
the following: 

• ETV Binary Interchange Format (EBIF) data ES — carries the application data.

• ETV Integrated Signaling Stream (EISS) data ES — carries timing signals that trigger events 
associated with the application.

ETV applications are typically "bound" (or Pre-bound) to particular pieces of content, and packaged 
in a program together with video and audio while being broadcast to the STB. This content can be a 
30-second ad or a network stream (a dedicated channel or program with EBIF content coded into it). 
Another possible source of ETV data is a local EBIF streamer: a server that provides pre-packaged 
EBIF content, allowing the BNP to enhance a video or audio program (network stream or ad) with 
additional ETV data. The process of adding EBIF enhancement to an existing network stream or ad is 
referred to as Late-binding.

Figure 201 shows the basic ETV data source flow.

Figure 201. ETV EBIF Data Source flow

Use Case Configuration Examples

The BNP can groom, splice or filter ETV data streams, including, but not limited to, the Use Case 
examples listed below: 

1. Pre-Bound Ad Splice.

2. Pre-Bound EBIF Passthrough (no DPI).

3. Pre-Bound EBIF Drop.

4. Pre-Bound EBIF Passthrough and Keep During Ad Splice.

5. Pre-Bound Network EBIF; Late-Bind EBIF During Ad.

Note: In all of the following Use Cases (except as specified as “Non-DPI”) it is assumed that the 
BNP is configured for DPI. See Chapter 6, “Digital Program Insertion (DPI)” for details on 
configuring DPI.
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Use Case Configuration Examples

Pre-Bound Ad Splice

In pre-bound ad splicing, the input network (or program) stream does not contain ETV data; rather, an 
ad containing ETV data ESs is spliced in later. In this case, the BNP would be configured to play the 
ad’s ETV streams on the output during the ad splice.

Figure 202 shows an example of pre-bound ad splice.

Figure 202. Pre-bound Ad Splice flow

Configuration Steps:

To configure pre-bound ad splice, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.

2. Create an output transport stream, if necessary. (See the section that begins with, “Creating 
MPEG-2 Output Transport Streams” on page 131 for additional information.)

3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 
transport stream (oTS), as seen in Figure 203, for example.
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Note: In this use case, the input program does not contain any ETV elementary streams.

Figure 203. Input program (without ETV data) groomed to oTS

The Configure Program Mapping window will open.

4. In the ETV Configuration section, the PIDs Priority setting should remain at the default of Ad. 

5. In the Component PIDs section under Placeholder ETV ESs, select the appropriate type of EBIF 
and EISS elementary stream placeholders from the drop down box. The type of ESs selected here 
should match those of the ETV ESs in the ad.

6. If necessary, change the PID values of the EISS and EBIF ESs by clicking the blue space under the 
Output Type or PID columns next to the appropriate input ES. 

Figure 204 shows the Configure Program Mapping window with the above options filled in.

Figure 204. Configure Program Mapping window - EBIF/EISS Placeholder
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7. Click OK.

The Grooming -> Mapping window will now show the groomed program with two Data EBIF/
EISS ESs grayed out.

Figure 205. Program with placeholders groomed - ESs grayed out

Note: When creating Placeholder ETV ESs, two new descriptor rules with default values will be 
created for each ES used as a placeholder. The Descriptor Data information in these rules 
may be edited, if necessary. In this case, there will be 4 new descriptor rules (2 for EISS and 2 
for EBIF) that are created in the Manage Descriptor Rules window. 

To view the descriptor rules created with the placeholder ESs, proceed as follows:
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1. From the Outputs side of the Grooming -> Mapping window, right-click on the program you just 
groomed and select Manage Descriptor Rules from the pop-up menu.

The Manage Descriptor Rules window will open, showing two descriptor rules for each ES 
placeholder:

Figure 206. Manage Descriptor Rules - EISS & EBIF additions

2. Click Cancel to close the Manage Descriptor Rules window.

Pre-Bound EBIF Passthrough (no DPI)

In pre-bound EBIF passthrough on a non-DPI program, the network stream contains the pre-bound 
ETV data streams, and the BNP is configured to play the input ETV streams on the output.

Figure 207 shows an example of pre-bound EBIF passthrough.

Figure 207. Broadcast EBIF enabled
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Configuration Steps:

To configure pre-bound EBIF passthrough, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.

2. Create an output transport stream, if necessary. (See the section that begins with, “Creating 
MPEG-2 Output Transport Streams” on page 131 for additional information.)

3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 
transport stream (oTS), as seen in Figure 208, for example.

Note: In this use case, the input program does contain two ETV elementary streams.

Figure 208. Input program (with ETV data) groomed to oTS
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The Configure Program Mapping window will open.

Figure 209. Configure Program Mapping - EBIF/EISS defaults

4. In the ETV Configuration section, leave the PIDs Priority set to the default of Ad. 

5. In the Component PIDs section, leave the EISS and EBIF ESs checked. You may change the PID 
values or leave them at their defaults. 

6. Click OK.

The Grooming -> Mapping window will now show the groomed program with the data EBIF/
EISS ESs passed through to the output.

Figure 210. Program with ETV ESs passed through 
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Pre-Bound EBIF Drop

In pre-bound EBIF drop, the network stream contains pre-bound ETV data streams and the BNP is 
configured to not play (to drop) the network ETV streams on the output.

Figure 211 shows an example of pre-bound EBIF where the ETV streams are dropped.

Figure 211. Broadcast EBIF disabled

Configuration Steps:

To configure pre-bound EBIF to be dropped, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.

2. Create an output transport stream, if necessary. (See the section that begins with, “Creating 
MPEG-2 Output Transport Streams” on page 131 for additional information.)

3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 
transport stream (oTS), as seen in Figure 208 on page 225, for example.

Note: In this use case, the input program does contain two ETV elementary streams.

The Configure Program Mapping window will open.

4. In the ETV Configuration section, leave the PIDs Priority set to the default of Ad. 



ETV Binary Interchange Format (EBIF)

228 BNP3xr User Guide

5. In the Component PIDs section, uncheck the EISS and EBIF ESs. 

The Configure Program Mapping window will look similar to Figure 212. 

Figure 212. Configure Program Mapping - EBIF/EISS unchecked

6. Click OK.

The Grooming -> Mapping window will now show the groomed program with the data EBIF/
EISS ESs dropped from the output.

Figure 213. Program with ETV ESs dropped

Pre-Bound EBIF Passthrough and Keep During Ad Splice

In this example, the network stream contains pre-bound ETV data streams and the ads are un-
enhanced. When the network stream is groomed to the output the BNP is configured to continue 
playing (keep) the network ETV streams during ad splices.
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Figure 214 shows an example of broadcast EBIF groomed as Splice/Keep. 

Figure 214. Broadcast EBIF groomed as Splice/Keep

Configuration Steps:

To configure pre-bound EBIF to play through and be kept during an ad splice, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.

2. Create an output transport stream, if necessary. (See the section that begins with, “Creating 
MPEG-2 Output Transport Streams” on page 131 for additional information.)

3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 
transport stream (oTS), as seen in Figure 208 on page 225, for example.

Note: In this use case, the input program does contain two ETV elementary streams.

The Configure Program Mapping window will open.

4. In the ETV Configuration section, click on the PIDs Priority drop-down box and select Network.

When Network is selected in PIDs Priority, the Play Preference drop-down box will be 
displayed.
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5. In the Play Preference drop-down box, leave the setting at the default of Play through ad.

The Configure Program Mapping window will look similar to Figure 215.

Figure 215. Configure Program Mapping - Play through ad

6. Click OK.

The Grooming -> Mapping window will now show the groomed program with the data EBIF/
EISS ESs passed through to the output.

Figure 216. Program with ETV ESs passed through (Splice/Keep)

To verify that the ETV ESs are configured for Play through ad, highlight the program and select 
Modify Program from the pop-up menu.
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Pre-Bound Network EBIF; Late-Bind EBIF During Ad

In this example, the network stream contains pre-bound ETV data streams and a local streamer or 
another source (such as another input program) streams another pair of ETV ESs (late-bind source). 
The BNP is configured to play the network ETV streams when the network stream is played, then to 
switch to the late-bind source during the ad.

Figure 217 shows an example of pre-bound network EBIF and late-bind EBIF during an ad.

Figure 217. Pre-bound Network EBIF, late-bind EBIF during ad

Configuration Steps:

To configure a late-bound EBIF ad to play through a pre-bound program, proceed as follows:

1. From the BNP Element Manager, click on the Grooming -> Mapping tab.

2. Create an output transport stream, if necessary. (See the section that begins with, “Creating 
MPEG-2 Output Transport Streams” on page 131 for additional information.)

3. Use the Drag and Drop Grooming feature to groom a desired input program to the desired output 
transport stream (oTS), as seen in Figure 218, for example.
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Note: The input program should contain at least two ETV elementary streams and there should be 
an additional two ETV ESs available for the late-bound streams.

Figure 218. Input program (with ETV data) groomed to oTS; Late-bound

The Configure Program Mapping window will open.

4. In the ETV Configuration section, click on the PIDs Priority drop-down box and select Network.

When Network is selected in PIDs Priority, the Play Preference drop-down box will be 
displayed.

Additional ETV 
ESs to be used for 
Late-bound 
source
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5. In the Play Preference drop-down box and select the Play during ad only option.

The Configure Program Mapping window will look similar to Figure 219.

Figure 219. Configure Program Mapping - Play during ad only

When the Play during ad only option is selected, the Late Bind Source field will be displayed.

6. Click on the ellipses (. . .) on the right-hand side of the Late Bind Source field to open the Late-
Bind Source Dialog window.

Click the “...” 
to select a late-
bind source
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Note: This window displays the Inputs side of the Element Manager’s Grooming -> Mapping 
window.

Figure 220. Late-Bind Source Dialog window

7. In the Late-Bind Source Dialog window, drill down to the program level.
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8. Select the desired program with ETV ESs that will be used to play during the ad; this is also called 
the late-bound ETV source.

Figure 221. Late-Bind Source selected

9. Click OK to return to the Configure Program Mapping window, which will look similar to 
Figure 222:

Figure 222. Configure Program Mapping window - Late-bound selected
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10.Click OK to complete the grooming process.

The Grooming -> Mapping window will now show the groomed program with the late-bound data 
EBIF/EISS ESs in the output.

Figure 223. Program with late-bound ETV ESs

To view which late-bound ETV source is configured for Play during ad only, highlight the 
program and select Modify Program from the pop-up menu.

Figure 224. View Late-Bind Source in output program
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CHAPTER 8

DVB Conditional Access

This chapter describes the functionality and configuration parameters for the BNP3xr DVB 
Conditional Access (DVB-CA) feature. 

In This Chapter:

• “Overview,” next.

• “DVB-CA Required Components” on page 238.

• “DVB-CA Configuration” on page 238.

• “DVB-CA Best Practices and Considerations” on page 274.

Overview

The BNP3xr supports the DVB-CA Common Scrambling Algorithm (CSA) and DVB SimulCrypt 
protocols (ETSI TS 103 197 V1.5.1) for Conditional Access System (CAS) which interfaces with 
DVB systems. This allows for encryption of MPEG-2 and H.264 programs in both SD and HD 
resolutions. The embedded SimulCrypt Engine is a low cost, high density, scalable encryption and 
management control implementation that is fully DVB-CA compliant. The BNP3xr provides two 10/
100 Ethernet management ports, allowing one of these port to be dedicated to the DVB-CA network. 

The DVB-CA encryption feature includes the following functionalities:

• SimulCrypt Synchronizer (SCS).

• Control Word Generation (CWG).

• Common Scrambling Algorithm (CSA).

• ECM / EMM insertion.

• CA-related PSI / SI generation and insertion.

RGB’s SimulCrypt engine interfaces with the following devices:

• Entitlement Control Message Generator (ECMG).

• Entitlement Management Message Generator (EMMG).

• Optional external Event Information Scheduler (EIS)1.

1. The BNP may be configured to use an external EIS server or the internal EIS server provided by the BNP software. 
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Figure 225 shows the BNP3xr in a deployed DVB-CA network.

Figure 225. BNP3xr in a DVB-CA network

DVB-CA Required Components

The following components are necessary for a fully functioning DVB-CA system for the BNP3xr:

1. BNP3xr running software version 3.0 or higher.

2. DVB Transport Streams (TSs) configured on the output of the BNP3xr.

3. Conditional Access System (CAS) with the following components:

• Entitlement Control Message Generator (ECMG);

• Entitlement Management Message Generator (EMMG);

• Optional external Event Information Scheduler (EIS);

• Valid NTP server.

4. Determination of whether or not External EIS mode or Internal EIS mode will be used. 

DVB-CA Configuration

This section describes the required configuration steps necessary for the DVB-CA feature. These steps 
require an Admin login level from the Element Manager. The steps are as follows: 

1. Verify DVB-CA License.

2. Set Up an NTP Server.

3. Configure Ethernet Control Port for DVB-CA.

4. Configure GigE or ASI Port(s) for DVB-CA System.

5. Create Input TS(s) for DVB-CA System.

6. Create Output DVB TS(s) for DVB-CA System.

7. Groom Input Program(s) to Output DVB TS.

8. Create Input PSI/SI Table Grooming.
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9. Groom the Ghost Program to Output DVB TS.

10.Configure DVB-CA Global Parameters.

11.Configure DVB-CA Tab: External and Internal EIS Mode.

12.Complete DVB-CA Tab Configuration for Internal EIS Mode.

Verify DVB-CA License

In order to view or configure any DVB-CA parameters in the Element Manager, you must first have a 
valid DVB-CA license. See “The License Manager” on page 111 for details on obtaining or verifying a 
DVB-CA license. When a valid DVB-CA license is present, an additional DVB-CA menu option will 
appear on the main Element Manager menu as well as an additional DVB-CA tab (Figure 226). 

Figure 226. DVB-CA Element Manager additions

DVB-CA menu additions to the 
Element Manager with a valid DVB-
CA license.
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Set Up an NTP Server

In order for the DVB-CA feature to properly interact with the CAS, a network time protocol (NTP) 
server must be set up in the Element Manager such that the IP Address of the NTP server is from the 
same source as that used by the CAS. 

1. From the Global Chassis Configuration menu (Configuration -> Global), enter one IP address 
that will be used for NTP by the DVB-CA system.

Figure 227. DVB-CA - NTP server setup

2. Click the Apply Configuration button at the bottom right of the window to save the changes.

Configure Ethernet Control Port for DVB-CA

There are two 10/100 Base T Ethernet management ports for the BNP3xr. 

Only Ethernet Port 2 is available for management access to the CAS. You must configure an IP 
address for both Ethernet Port 1 and Ethernet Port 2 for proper DVB-CA functionality. 

To configure IP parameters for Ethernet Port 2, proceed as follows: 

1. From the Ethernet Control Port Configuration menu (Configuration -> Ethernet Control Port) 
under the Ethernet Port 2 section, enter the IP Address, Subnet Mask, Gateway, and DNS 
Server (optional) to which the CAS will connect.

Note: If you have configured the BNP3xr in a 1:1 redundancy environment, the Gateway IP Address 
for Ethernet Port 2 must be configured.

2. Click the Apply Configuration button to save the changes.

3. The BNP will prompt for a reboot.
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Ethernet Port: GUI Display to Chassis Mapping

In the BNP3xr the naming scheme and physical layout of the two management Ethernet ports differs 
from the Ethernet Control Port menu in the Element Manager to the labels and layout on the actual 
chassis. Figure 228 below provides a mapping of the port layout.

Figure 228. DVB-CA - Ethernet Control Port mapping

Configure GigE or ASI Port(s) for DVB-CA System

GigE Port Input and Output Interface Configuration

1. From the GigE Port Configuration menu (Configuration -> GigE Ports) enter the IP Address, 
Subnet Mask, Gateway, and Auto-negotiation information for the input and output GigE port(s) 
that are to be used for encryption.

10/100-1 -->  
Ethernet Port 2

10/100-0 -->  
Ethernet Port 1
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Note: A GigE port may be used for simultaneous input and output.

Figure 229. Configure GigE - DVB-CA

2. Click Apply Configuration to save changes.

And / Or:

ASI Port Input and Output Configuration

1. From the Configuring ASI Ports menu (Configuration -> ASI Ports) select which ports will be 
used for input and which ports are to be used for output. 
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Note: An ASI port may not be used for simultaneous input and output; only one direction per port 
may be selected. 

Figure 230. Configure ASI - DVB-CA

2. Click Apply Configuration to save changes.

Create Input TS(s) for DVB-CA System

If you have not yet done so, create an input transport stream for which programs are to be encrypted. 

1. From the Creating Input Transport Streams menu (from Grooming -> Mapping window, right 
click on the Input GigE or ASI port and select Create Transport Stream), enter the TS Name, IP 
Address, and UDP Port of the Input TS for the programs to be encrypted. 

Figure 231. Create Input TS - DVB-CA

2. Click OK to create the TS.
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Create Output DVB TS(s) for DVB-CA System

1. Follow the steps in the section titled, “Creating DVB Output Transport Streams” on page 142 to 
create a new DVB Transport Stream for either a GigE or an ASI port.

Figure 232. Create Output TS - DVB-CA: GigE port (left); ASI port (right)

2. Ensure that the following parameters are configured as specified below in Table 47 for proper 
encryption functionality: 

Table 47. Output DVB TS parameters for DVB-CA configuration 

Output TS Parameter Description Required DVB-CA Value

Unique TS IDa Allows you to assign a unique numeric ID to this 
transport stream.

• When this option is checked, the TS ID value 
placed in this field will be reserved as unique 
for the entire chassis.

• When this option is unchecked, a TS ID value 
may still be entered, however the value may be 
the same as another TS ID, as long as that TS 
ID’s value has not been reserved as a Unique 
TS ID.

This field must be checked.

The value in this field must 
match that of the CAS.

TS Type The type of stream. The type of stream you 
choose determines what other information is 
required. Choices are:

MPEG-2, ATSC, SCTE, or DVB.

This field must be set to DVB.

Network ID The Network ID of the current transport stream. The value in this field must 
match that of the CAS.

Original Network ID The Network ID from which this stream has 
originated.

The value in this field must 
match that of the CAS.
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3. Click OK to create the output transport stream.

Groom Input Program(s) to Output DVB TS

1. From the Grooming -> Mapping window, drag the desired input program(s) to the output DVB TS 
you just created. See the section titled, “Drag and Drop Grooming” on page 163 for details on pro-
gram dragging and dropping.

After grooming the input program to the DVB output TS, the Configure Program Mapping 
window opens:

Figure 233. Configure Program Mapping - DVB-CA

2. In the Destination section, change the Program Number to the number assigned and provided by 
the CAS. 

3. If you are using an external EIS server, you may need to reserve the elementary stream PIDs per the 
CAS configuration to match those from the external EIS server. 

If you are using an internal EIS server, reserving a PID is optional and you may proceed to Step 6 
below.

In the Component PIDs section, double click on the Output Type or PID fields for each 
elementary stream to assign a new reserved PID 

Modulation Mode Use the pull-down menu to select the modulation 
mode used for the TS.

• The Modulation Mode information is carried in 
the Network Information Table (NIT) of the 
input from the CAS vendor. 

• Choice between SCTE 64 QAM and SCTE 256 
QAM.

The selection in this field must 
match that of the CAS, unless 
NIT is passed through.

SDT Source Source of the service description table for this 
transport stream. If you select N/A then SDT is 
not generated for this output TS.

This field must be set to N/A if 
SDT is originating from an 
external source.

EIT Source Source of the Event Information Tabled (EIT) for 
the programs in this transport stream. If you 
select N/A then EIT will not be generated.

This field must be set to N/A if 
EIT is originating from an 
external source.

a. The DVB-CA standard requires a unique pair value of the TS ID and Network ID fields. 

Table 47. Output DVB TS parameters for DVB-CA configuration (Continued)

Output TS Parameter Description Required DVB-CA Value
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4. The Select Elementary Stream window open.

In the example above and below in Figure 233 and Figure 234, the Input SCTE Video PID of 
16 will be changed to 3011 and the AC-3 Audio PID of 17 will be changed to 3012:

Figure 234. Reserve ES PIDs - DVB-CA

Note: When entering elementary stream PID values in the BNP Element Manager, the values must 
be entered in decimal format, however in the Grooming -> Mapping window, these values will 
always appear in hexadecimal format. It will be necessary to perform hex to decimal and vice 
versa conversion during the DVB-CA configuration.

5. Select the New Reserved PID radio button and enter the PID which the CAS vendor has provided 
for the appropriate elementary stream.

6. Click OK to save changes and return to the Configure Program Mapping window. (Figure 235) 

Figure 235. Configure Program Mapping - PIDs & Program changed - DVB-CA

7. Repeat Step 3 through Step 6 for every elementary stream in the Configure Program Mapping 
window.
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8. Click OK in the Configure Program Mapping window to complete the grooming process.

The program with the new reserved PIDs (in hexadecimal format: bc3=3011; bc4=3012) will 
appear in the Grooming -> Mapping window as seen in Figure 236 below:

Figure 236. Reserved PIDs to Output (in hex) - DVB-CA

Create Input PSI/SI Table Grooming

1. From the Creating Input Transport Streams menu (from Grooming -> Mapping window, 
right-click on the Input GigE or ASI port where PSI/SI table information may be found and select 
Create Transport Stream). 

2. Enter the IP Address, and UDP Port for the PSI/SI table information. 

Figure 237. Create Input TS for PSI/TS - DVB-CA

3. Click OK to create the transport stream.

4. Right click the TS that you just created and select the Create Ghost Program option from the 
popup menu as described in the section titled, “Adding an Unreferenced PID as an Elementary 
Stream” on page 190.
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5. The Create Ghost Program screen of Figure 238 appears.

Figure 238. Create Ghost Program - DVB-CA

6. Enter the Ghost Program Name. Click OK. A new program stream appears under the TS.

Figure 239. Ghost Program in GigE - DVB-CA

7. Right-click the new ghost program and select the Add Elementary Stream option from the popup 
menu.

8. In the Add Element Stream window, change the Stream Category to Data, match the Stream 
Type and PID number provided by the CAS.

Figure 240. Add Elementary Stream PIDs - DVB-CA

9. Click OK to add the elementary stream to the Ghost program
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10.Repeat Step 7 and Step 9 for every elementary stream provided by the CAS vendor for which a PSI/
SI table must be generated.

When finished, the elementary streams in the ghost program will look similar to Figure 241. 

Figure 241. Ghost Program Elementary Streams - DVB-CA

Groom the Ghost Program to Output DVB TS

1. Groom the Ghost Program you just created above by dragging the program from the Inputs side of 
the Grooming -> Mapping window to the output DVB TS from “Create Output DVB TS(s) for 
DVB-CA System” on page 244. 

2. In the Configure Program Mapping window that opens, check the Stay Unreferenced box.

Figure 242. Configure Program Mapping - Ghost Program - DVB-CA
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3. Click OK to complete the grooming process.

The Grooming -> Mapping window will look similar to Figure 243 below:

Figure 243. Output grooming window with ghost program added - DVB-CA

Configure DVB-CA Global Parameters 

Before configuring the DVB-CA global parameters, determine if you will be using an external EIS 
server or the BNP’s internal EIS server. External EIS mode requires different setup and menus that are 
determined in the DVB-CA Global Configuration menu. Changing from an external EIS to an 
internal EIS or vice versa will require a reboot of the BNP and will remove all previously configured 
DVB-CA encryption streams. 

To configure the DVB-CA global parameters, proceed as follows:
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1. From the main Element Manager window, select DVB-CA -> Global Configuration. 

The DVB-CA Global Configuration window of Figure 244 opens:

Figure 244. DVB-CA Global Configuration - Internal EIS mode default
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If an external EIS server is being used (i.e., the Enable button in this window checked), the 
DVB-CA Global Configuration window of Figure 245 will appear as follows:

Figure 245. DVB-CA Global Configuration - External EIS mode default

2. Fill out the fields of this window according to the descriptions listed in Table 48.

3. Click Apply to save any changes.

4. If the Enable button next to the External EIS Port Number field has been checked or unchecked, 
the system will prompt for a reboot. Click Yes to accept the reboot.

Table 48 describes the fields available in the DVB-CA Global Configuration window.

Table 48. DVB-CA Global Configuration fields  

Field Description
Internal EIS mode or 
External EIS mode

Scramble Level Specifies the default scramble level for the BNP 
chassis. The default is set to TS (transport 
stream). This field is read-only.

Common to both

Crypto Period Duration 
(100ms)

Specifies the default crypto period for the BNP 
chassis in 100 millisecond increments.

• The default is set to 200 (which is 20,000 
msecs, or 20 seconds).

Common to both
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CW Mode Specifies the Control Word mode to be used for 
the BNP chassis. Choose one of the following 
options from the pull-down menu:

• Conformance 64-bits, Non-conformance 
64-bits, Fixed 0, or Fixed 1.

• Default is Conformance 64-bits.

Common to both

CAS Mode Specifies the CAS mode for the BNP chassis. 

Default is Broadcast mode; this field is read-only.

Common to both

External EIS Port Number

Enable button

Specifies the TCP port number that the BNP will 
use to connect to the external Event Information 
System (EIS) server.

• This field is for an External EIS server to 
communicate with the BNP.

• Default value is 1; valid range is from 1 to 
65535.

External EIS mode 
only

Checking this button will do the following: 

• Switch the DVB-CA system from an internal 
CAS to an external CAS.

• Allow editing of the External EIS Port Number, 
EIS Test Timeout, and EIS Test Interval fields.

Unchecking this button will do the opposite of the 
above. 

Determines if system 
uses External EIS 
mode or Internal EIS 
mode

EIS Test Timeout Specifies the testing timeout (in seconds) for the 
external EIS server.

Default is 5 seconds.

External EIS mode 
only

EIS Test Interval Specifies the interval (in seconds) in which the 
EIS test timeout will occur. 

Default is 20 seconds.

External EIS mode 
only

ECM Test Timeout Specifies the testing timeout (in seconds) for the 
Entitlement Control Message Generator (ECMG).

Default is 5 seconds.

Common to both

ECM Test Interval Specifies the interval (in seconds) in which the 
ECMG test timeout will occur. 

Default is 20 seconds.

Common to both

EMM Test Timeout Specifies the testing timeout (in seconds) for the 
Entitlement Management Message Generator 
(EMMG).

Default is 5 seconds.

Common to both

EMM Test Interval Specifies the interval (in seconds) in which the 
EMMG test timeout will occur. 

Default is 20 seconds.

Common to both

EMMG TCP Control Port 
Number

Specifies the TCP control port number for the 
EMMG.

Default is 0; valid range is 1 to 65535.

Common to both

Table 48. DVB-CA Global Configuration fields  (Continued)

Field Description
Internal EIS mode or 
External EIS mode
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Configure DVB-CA Tab: External and Internal EIS Mode

Depending on whether or not you have set up your DVB-CA system to use an external EIS server or 
the BNP’s internal server, the menus in the DVB-CA tab are slightly different. The following section 
provides instructions that are common to both external and internal EIS modes; the end of this section 
provides instructions on configuration that only applies to internal EIS mode.

Create CA System

1. From the main Element Manager menu tabs, click on the DVB-CA tab to view the CA System and 
SCG subtabs.

Figure 246. DVB-CA tab

EMMG Data Port Number Specifies the UDP number for the EMMG.

Default is 0; valid range is 1 to 65535.

Common to both

EMM Multicast IP Specifies the multicast IP address on which 
Ethernet Port 2 will receive EMM packets. 

• Enter a valid multicast IP address in this field to 
enable Ethernet Port 2 for receiving EMM 
packets.

• Enter all 0’s (or leave field at the default of all 
0’s) to not send EMM traffic via Ethernet Port 2.

Common to both

Update Timer (secs) Specifies the amount of time (in seconds) before 
the BNP should begin to transmit video services 
in order to allow for encryption processing.

• Default is 30.

• The higher the number, the longer it will take 
the end user to receive a video signal. If the 
number is too low, programming will be 
transmitted in the clear until the encryption 
engine takes over. The recommendation is to 
choose a number that will be an acceptable 
level of delay for the end user while still 
providing the minimum amount of clear data 
transmission.

Common to both

Table 48. DVB-CA Global Configuration fields  (Continued)

Field Description
Internal EIS mode or 
External EIS mode

1

No “+” indicates no CA Systems configured
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2. Click the CA System subtab. 

If no CA System has been configured, there will be no “+” expansion icon to the left of the folder 
icon, as seen in Figure 246.

3. Right-click the CA Systems folder and select Create CA System from the pop-up menu.

Figure 247. Create CA System popup

4. The Create CA System dialog opens:

Figure 248. Create CA System dialog

5. In the CAS Name field, enter the desired name for this CAS. This name should be unique across 
the chassis.

6. In the CAS ID field, enter the ID number provided by the CAS.

7. Click Apply to save changes.

The new CAS is added to the CA Systems list.

Figure 249. New CAS Added
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Create ECMG 

1. Click the “+” icon next to the name of the CAS you just created (or double-click the name of the 
CAS) to expand the list:

Figure 250. Expand CAS Name

2. Right-click on the ECMG List folder and select the Create ECMG option from the pop-up menu:

Figure 251. Create ECMG pop-up

The Create ECMG dialog opens:

Figure 252. Create ECMG

3. Fill out the fields according to the descriptions in Table 49.

4. Click Apply to save changes and create the ECMG.

2
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5. The new ECMG is added to the ECMG List:

Figure 253. ECMG Added to ECMG List

Table 49 describes the fields available in the Create ECMG dialog: 

Table 49. Create ECMG dialog fields

Field Description Info Provided by:

CAS Name Specifies the name of the CAS created in the CA Systems 
subtab. This field is read-only.

CAS

CAS ID Specifies the CAS ID number created in the CA Systems 
subtab. This field is read-only.

CAS

Sub CAS ID Enter the Sub CAS ID for this ECMG.

• Valid range is 0 to 65535; enter 0 if this field is to be ignored.

• This field is optional.

CAS

ECMG IP Address Enter the IP address of the ECMG CAS

ECMG Port Enter the UDP number of the ECMG CAS

Channel Start Offset Specifies the first channel for the ECMG.

• This field is optional.

• Valid range is any integer.

• Default is 0.

CAS

Channel Count Specifies the total number of channels this ECMG is currently 
maintaining.

• This field is optional.

• Valid range is any integer.

• Default is 10.

CAS

Second CAS ID Enter the second CAS ID (if provided with one) from the CAS.

Range is 0 to 65535; enter 0 if not using a second CAS ID.

• This field is optional.

CAS
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Create EMMG

1. Under the CAS Name folder, Right-click on the EMMG List folder and select the Create EMMG 
option from the pop-up menu:

Figure 254. Create EMMG pop-pop

The Create EMMG dialog opens:

Figure 255. Create EMMG

2. Enter the Client ID number in decimal format.

Note: If this value is being provided by the CAS, you will most likely receive this number in 
hexadecimal format. You will need to convert the format from hex to decimal in order for this 
value to properly populate the field. 

3. Click Apply to save changes and create the EMMG.

The new EMMG will appear under the CAS Name folder:

Figure 256. EMMG Created

3
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Note: A maximum of 4 EMMGs may be created per CAS.

Create EMM

1. Under the CAS Name folder, Right-click on the Client ID folder and select the Create EMM 
option from the pop-up menu:

Figure 257. Create EMM pop-up

The Create EMM dialog opens:

Figure 258. Create EMM dialog

2. Fill out the fields according the descriptions listed in Table 50.

3. Click Apply to save changes and create the EMM.

The new EMM is added under the Client ID folder:

Figure 259. EMM Created

4
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Table 50 describes the fields available in the Create EMM dialog:

Join TS to EMM

1. In the CA Systems subtab, drill down to:

CAS Name -> EMMG List -> Client ID.

Table 50. Create EMM dialog descriptions

Field Description Provided by:

Client ID Displays the value created in the Create EMMG dialog.

This value is read-only.

CAS

Data ID Specifies the unique identification of an EMM / private data 
stream of a Client ID.

Range is 0 to 65535

CAS

Private Data Enter additional data into the CA descriptor in the PMT. 

• For a service, add private data into the program level’s CA 
descriptor.

• For an ES, add private data into the ES level’s CA 
descriptor.

• Default is blank.

• Format must be hex.

CAS

Second CAS ID Enter the second CAS ID (if provided with one) from the CAS 
vendor.

Range is 0 to 65535; enter 0 if not using a second CAS ID.

CAS (optionally)

Max Bandwidth (kbps) Enter the maximum bandwidth that will be allocated by the 
MUX.

CAS

5
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2. Right-click the desired EMM (preceded by the label, “Client ID” and select the Join/Disjoin TS 
option from the pop-up menu:

Figure 260. Join/Disjoin TS - external

The Join/Disjoin TS to EMM window opens:

Figure 261. Join/Disjoin TS to EMM window

3. From the right side of the window, expand the GigE or ASI port (by clicking on the + icon or 
double-clicking the port) in which you created the original DVB TS (See “Create Output DVB 
TS(s) for DVB-CA System” on page 244.)

4. Highlight the TS and click the left arrow button (<<) next to the port list. 

Figure 262. Join/Disjoin TS - port expanded
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5. The TS is added to the left side of the window with a PID value of 0, which you will need to 
change.

Figure 263. Join/Disjoin TS - TS added to EMM - No PID

6. Click on the TS just added on the left side of the window.

The PID field at the bottom of the screen becomes editable.

7. Type in a PID value for this TS. The PID value may be any valid PID.

Leaving the PID value as 0 will automatically generate a default PID for the entry.

Figure 264. Join/Disjoin TS - PID entry

8. After typing in the value, you must tap the <Enter> key in order to apply the PID change to the TS 
entry above.

PID not yet modified
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9. The new PID is then reflected in the Pid column at the top of the window.

Figure 265. Join/Disjoin TS - PID modified

10.Click Apply to complete the process of joining the TS to the EMM.

11.A new EMM program will appear under the TS to which the EMM was joined in the Grooming -> 
Mapping window:

Figure 266. EMM Program joined to TS

PID modified

EMM Program added to TS 
after TS is joined to EMM

CAT added to TS after TS 
is joined to EMM
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This completes the process for configuring a DVB-CA system when using an external EIS server. If 
you are using an internal EIS server, see the section “Complete DVB-CA Tab Configuration for 
Internal EIS Mode” on page 265 for additional steps necessary for program scrambling. 

Verify Scrambling

The best way to verify scrambling is to confirm encrypted streams through the use of an analyzer, 
however, other methods from the Element Manager may be useful. 

For example, You can view the channel information being received on the BNP by selecting the 
following menu path from the DVB-CA tab:

CA System -> CAS Name -> ECMG List -> Sub CAS ID -> Channel.

If scrambling is taking place, you may see stream IDs for each program showing a “connected” status 
(Figure 267).

Figure 267. Stream IDs connected

Depending on the configuration of the DVB-CA system, you may be able to view the elementary 
stream(s) joined to the SCG in the Service List folder under the SCG tab. Select the following menu 
path (as seen in Figure 268) from DVB-CA tab: 

6
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SCG -> SCG Group -> SCG -> Service List -> ES Type

Figure 268. SCG List - ESs Scrambled

This completes the DVB-CA configuration process in external EIS mode. See the next section, 
“Complete DVB-CA Tab Configuration for Internal EIS Mode” for additional steps required in 
configuring an internal CAS.

Complete DVB-CA Tab Configuration for Internal EIS Mode

The following steps are additional configuration requirements necessary when setting up a DVB-CA 
system that uses the BNP’s internal EIS. 

Create Access Criteria List

Note: An Access Criteria List is CA system-specific information needed by the ECMG to build an 
ECM. This is only required for configuration when in internal EIS mode.

1. From the CA System tab, drill down to CAS Name -> Access Criteria List.

1
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2. Right-click over the Access Criteria List folder and select Create Access Criteria from the pop-
up menu (Figure 269).

Figure 269. Create Access Criteria pop-up

3. The Create Access Criteria dialog of Figure 270 opens.

Figure 270. Create Access Criteria dialog

The CAS Name and CAS ID fields are read-only and based on the information already entered in 
the Create CA System section on page 254.

4. In the AC Name field, enter a desired name that is unique to the chassis.

5. In the AC Data field, enter the hexadecimal number provided by the CAS.

The AC Data field is a hex number; the following format is an example of the type of number you 
may receive from the CAS. 

[vendor #] [Unique TS ID] [ECM PID]

For example:

0b04 0003 0bc6

6. Click Apply to create the Access Criteria List.

To view the total count of Conditional Access systems:

1. From the DVB-CA menu click on the CA Systems tab.

2. Expand the CA Systems folder to display a list of CA Systems.
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3. Highlight the Access Criteria List folder. The TOTAL ACs pop-up will give a count of the total 
number of ACs, as in the example in Figure 271:

Figure 271. Access Criteria List - Total ACs

Create SCG

Note: When the DVB-CA system is configured to use an external EIS server, an SCG is automatically 
created for every program to be encrypted; you can only display the SCG for external EIS 
mode, not create one.

Note: When the DVB-CA system is configured to use an internal EIS server, an SCG must be 
manually created. One SCG must be created for every program to be encrypted.

1. From the SCG tab, right-click on the SCG Group folder and select Create SCG from the pop-up 
menu.

Figure 272. Create SCG pop-up

2
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2. The Create SCG dialog of Figure 273 opens:

Figure 273. Create SCG dialog

3. Fill out the information according to the descriptions provided in Table 51.

4. Click Apply to create the SCG.

5. Repeat Step 1 through Step 4 for every program to be encrypted.

Table 51 describes the fields available in the Create SCG dialog.

Table 51. Create SCG dialog - Internal EIS mode

Field Description

SCG ID Specify a unique number that will identify an SCG within the system.

Range is 1 to 65534; default is blank.

Transport Stream Use the Select TS button to select the TS under which the desired 
programs are to be encrypted.

This TS must be a DVB TS. 

See “Create Output DVB TS(s) for DVB-CA System” on page 244.

CP Duration (100ms) Specify the Crypto Period for this SCG. Specifies the default crypto period 
for the BNP chassis in 100 millisecond increments.

• Check the Use global config box to follow the default parameter as 
specified in the DVB-CA Global Configuration fields table.

• Uncheck the Use global config box to specify a different Crypto Period 
for the SCG. 

• Default is set to Use global config.



BNP3xr User Guide 269

DVB-CA Configuration

Monitor SCG

The CP Counter can display a Basic or Extension view of CP counters. The Basic view displays data 
between the SCS and the MUX. The Extension view additionally displays counters that are collected 
between the SCS and the ECMG. 

To monitor the SCG:

1. From the DVB-CA screen click on the SCG tab.

2. Right-click on a selected SCG. A popup menu offers the choice to modify, delete, or monitor an 
SCG. Click on Monitor SCG.

3. The Monitor SCG dialog appears. Use the pull-down menu to choose the Basic or Extension view, 
as seen in Figure 274:

Scramble Level Specifies the default scramble level used to configure the scrambler for 
this SCG.

• TS is currently the only option.

• This field is read-only.

• Use global config box is read-only and defaulted to checked.

Disable Checking this button will disable all scrambling on the SCG, changing all 
scrambled programs to clear.

• Default is unchecked.

Table 51. Create SCG dialog - Internal EIS mode

Field Description
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Figure 274. Monitor SCG dialog

Create ECM

Note: When the DVB-CA system is configured to use an internal EIS server, the ECM must be 
manually created.

Note: When the DVB-CA system is configured to use an external EIS server, an ECM is 
automatically created for each SCG.

1. From the SCG tab, drill down to SCG Group -> SCG -> ECM Groups.

3
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2. Right-click on the ECM Groups folder and select Create ECM from the pop-up menu.

Figure 275. Create ECM pop-up

The Create ECM dialog of Figure 276 opens:

Figure 276. Create ECM dialog

3. Fill out the fields according to the descriptions in Table 52.

4. Click Apply to create the ECM.

Table 52 describes the fields available in the Create ECM dialog.

Table 52. Create ECM dialog

Field Description

ECM ID Enter a unique PID (allocated by the MSO) to identify the ECM stream for a Super 
CAS ID. The combination of the Super CAS ID and the ECM ID uniquely identifies 
the ECM stream in the system as a whole.

• Default is blank

• Valid range is up to a 10-digit number and must be equal to or greater than 0.

CAS ID Select the CAS ID from the drop-down box. This value should have been provided 
by the CAS and configured in the CA System tab.

Sub CAS ID Select the Sub CAS ID from the drop-down box. This value should have been 
provided by the CAS and configured in the CA System tab.
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Join Program and ES to the SCG

Note: When the DVB-CA system is configured to use an internal EIS server, each elementary stream 
or program must be joined to the SCG. 

Note: When the DVB-CA system is configured to use an external EIS server, the elementary 
stream(s) or program are automatically joined to an SCG. 

1. From the SCG tab, drill down to SCG Group -> SCG -> Service Lists.

Private Data Enter additional data into the CA descriptor in the PMT. 

• For a service, add private data into the program level’s CA descriptor.

• For an ES, add private data into the ES level’s CA descriptor.

• Default is blank.

• Format must be hex.

Access Criteria Select the name of the Access Criteria from the drop-down menu created from the 
Access Criteria List menu. 

PID Enter the PID to use for the ECM.

• Default is blank.

• Valid range is 52 to 8175.

Table 52. Create ECM dialog

Field Description

4
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2. Right-click on the Service Lists folder and select Join Program and ES from the pop-up menu.

Figure 277. Join Program and ES pop-up

The Select service list and ES list Objects dialog of Figure 278 opens:

Figure 278. Select service list and ES list Objects dialog
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3. Select the program you wish to encrypt from the list of programs available for this TS. Programs 
unavailable for encryption will be grayed out.

Additionally, you may select an ES to encrypt by drilling down on the program level and selecting 
the desired ES as seen in Figure 279. 

Figure 279. Select service list and ES list Objects - ES level

4. Click Apply to join the program or ES to the SCG.

Verify Scrambling

To verify programs are being scrambled, follow the steps in the previous section, “Verify Scrambling” 
on page 264.

DVB-CA Best Practices and Considerations

The following guidelines should be taken into consideration when setting up a DVB-CA system:

• In a BNP redundancy configuration only the primary BNP is connected to the EIS, ECMG, and 
EMMG servers.

• During switchover the old primary (now standby) disconnects to CA servers and the new primary 
reconnects to them.

• The Update Timer is used to avoid sending clear streams during boot up & switchover because the 
boot up time and CAS reconnection time vary from configuration to configuration.

• It is recommended that Ethernet Port 2 be connected downstream of an IP switch such that 
multicast traffic does not spill onto the CAS network and flood the EMM and ECM traffic.

• The BNP can optionally be configured to receive EMM traffic via a multicast socket on Ethernet 
Port 2. 

• Virtual IP configuration for Ethernet Port 2 must be configured when using 1:1 chassis redundancy; 
this virtual IP address must be used by CA servers (external EIS and ECMG configuration).

5
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CHAPTER 9

Monitoring the BNP

This chapter describes information about the system that you can monitor to ensure that the system is 
always healthy. The Alarms & Events tab provides system information and health status.

To view other information about the BNP3xr, use the other BNP Element Manager windows. A 
complete discussion of the BNP Element Manager begins in “Using the Element Manager” on 
page 34.

In This Chapter:

• “Selecting the Elements to View,”  next.

• “Viewing Alarms and Events” on page 275.

• “The Status Bar” on page 277.

Selecting the Elements to View

The upper portion of the Alarms & Events tab lets you define the information you want to see on the 
screen. You can select as many options as you choose. The information is cumulative. To sort alarms 
and events, click the table header. The BNP Element Manager re-sorts the information according to 
your selection.

Once you have selected the events to display, click Apply Filter to accept the changes and refresh the 
window.

Types of alarms and events that can be displayed include:

• All shows all alarms and events, regardless of severity

• Raised shows all alarms that have been raised, but not cleared

• Cleared shows all alarms that have been raised and cleared

• Critical shows only critical severity alarms; these are alarms that must be dealt with immediately

• Major shows major alarms; these are alarms that may not require immediate intervention but 
cannot be allowed to continue indefinitely

• Minor shows minor alarms that will not disrupt the system

Viewing Alarms and Events

After you have set the types of alarms to display, you can tab to Alarms & Events at any time to see the 
current state of the system. Figure 280 shows a typical alarms window.
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For each alarm, you see a description, status, severity, source, cleared time (if the alarm has been 
cleared), any comment, and the user who cleared the alarm.

Note: Only those alarms whose levels have been checked (Figure 280) will be displayed. The others 
will be hidden until checked.

Cleared events remain in the list for historical purposes.

Figure 280. Alarms & Events tab

Alarms and Events

The following alarms are available:

• Video underflow 

• PID missing

• Grooming failed

• Missing input-Missing PAT/PMT, this could be caused by: 

• A disconnected cable 

• A TS packet missing or lost 
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• Input GigE not operational

• Cooling system failure

• Failure of ad insertion/splicing

• Postblack duration from ad server ignored or greater than four seconds

The four severity levels include info, minor, major, and critical.

The Status Bar

The status bar is visible regardless of the tab selected. This ensures that you can see if there are any 
critical alarms that need attention. The bottom portion of the window displays the IP address to which 
the BNP Element Manager is connected and the highest-priority current alert. The information is 
color-coded. A green IP address section indicates that the connection is active.

For alarms, the color-coding is one of the following:

• Green indicates that the alert or event displayed is informational.

• Yellow indicates a situation that might need operator action.

• Pink indicates a major alarm requiring operator attention. 

• Red indicates a critical error has occurred and immediate operator intervention is needed.

Figure 281. The status bar
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CHAPTER 10

Troubleshooting

This chapter describes error detection and correction procedures. 

In This Chapter:

• “LED Indicators,” next.

• “Event Log Analysis” on page 280.

• “Software Upgrade” on page 280.

• “Contacting RGB Customer Support” on page 280.

LED Indicators

The LED indicators are fully described in “LED Indicators” on page 17. These should be your first line 
of inquiry if any BNP3xr component is not performing correctly.

Figure 282. LED Indicator Locations

P3xr

Cfg/Pwr     Fault     Backup
Compact Flash

10/100-1

GigE 1-8 Port Status
(SFPs)

10/100-0

PSU1    PSU2

Table 53. LED Indications 

Indication Possible Solution

An LED indicator for one of the GigE ports is off. Verify that the module is installed correctly and has 
power.

The LED indicator for the 10/100 BaseT port is 
off.

Verify that the module is installed correctly and the 10/
100 BaseT port cable is connected correctly.
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Event Log Analysis

If asked to do so by technical support, access the event log. You will be instructed on this procedure by 
the technical support engineer.

Software Upgrade

Use the Element Manager to upgrade any software image of the BNP3xr. See “Upgrading Software” 
on page 107 for details about upgrading software.

Contacting RGB Customer Support

Note: For BNP products or software purchased through other distribution partners, please contact 
their customer service for product support.

Before you contact Customer Support, have the following information handy:

• Serial number of the AC power supply.

• A clear description of the problem.

• Steps to reproduce the problem, if applicable.

Customers who purchased their product directly from RGB Networks, or have purchased extended 
product support directly from RGB Networks should contact Customer Support via one of the 
following methods: 

The system power LED indicator is off. Verify that the power cord is correctly installed and that 
the power is turned on.

The LED indicator for the compact flash is 
blinking red

 Install a compact flash card.

The LED indicator for the compact flash is solid 
red.

 A flash error has occurred or the flash module is 
corrupted and needs to be reformatted or replaced.

Table 53. LED Indications (Continued)

Indication Possible Solution

Table 54. Contacting Customer Support

Method Details

Phone +1 (877) RGB-NETW (877-742- 6389) or +1 (408) 701-2800

Customer Portal http://support.rgbnetworks.com

Email support@rgbnetworks.com

mailto://support@rgbnetworks.com
http://support.rgbnetworks.com
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Searching the RGB Customer Portal

To search the RGB Customer Portal for a specific document or solution, proceed as follows:

1. Log in to the RGB Customer Portal site.

Figure 283. RGB Customer Portal home page

2. From the Customer Portal homepage, click on the Knowledge Base tab:

Figure 284. Customer Portal home page - Direct and Reseller

3. From the Knowledge Base homepage, enter the desired search term in the Search box and tap 
the[Enter]key:

Figure 285. Knowledge Base search - Direct and Reseller

Direct Customers - RGB Customer Portal home Resellers - RGB Customer Portal home

Direct Customers - Knowledge Base search Resellers - Knowledge Base search

http://support.rgbnetworks.com
http://support.rgbnetworks.com
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CHAPTER 11

Field-replaceable Units

This chapter provides instructions on replacing the Field-replaceable Units (FRUs). 

In This Chapter:

• “Overview,” next.

• “Replacing a Power Supply” on page 284.

• “Replacing a Fan Tray” on page 287.

• “Replacing a Gigabit Ethernet Processor (GBP3) Module” on page 289.

• “Replacing a Processor Module (PROC3) or an ASI Module” on page 290.

Overview

There are four replaceable units on the BNP3xr, shown in Figure 286. The removal and replacement 
procedure is provided for each. 

Figure 286. Top view of chassis, with FRUs visible
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The GBP3 module is located underneath the fan trays; its design is shown below in Figure 287

Figure 287. Gigabit Processor - 3 Module

Always wear an ESD wristband or use an electrostatic mat when working with electronic components.

The chassis does not need to be removed from the rack to replace a FRU, but the system must be 
powered down before beginning any replacement process.

Warning:  Never replace any FRU while the chassis is still connected to the power source.

If replaced items need to be configured, see Chapter 4, “System Configuration.”

Warning:  Do not replace any component (such as fuses) not specifically described here. For 
replacement beyond the FRU level, contact your technical support representative for 
instructions on returning the component. (See “Contacting RGB Customer Support” on 
page 280.) 

Replacing a Power Supply

The power supplies are located at the rear of the BNP3xr chassis. Any time that the chassis is not 
receiving adequate power, as indicated by the system LEDs and performance, verify that power is 
reaching the chassis. 

If power is reaching the power supply but not getting to the system, you might need to replace one or 
both power supplies. 

Note: The BNP3xr operates in normally with just one power supply; the addition of a second power 
supply allows for redundancy support and is either a field or factory upgrade option.

Removing a Power Supply

The basic procedure for removing a power supply is similar regardless of whether the power supply is 
for AC or DC power.

To remove a failed power supply:

1. Ensure that you have a replacement power supply ready to reinsert.

2. If you have installed dual redundant power supplies, skip Step 3 and proceed to Step 4.
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Replacing a Power Supply

3. Ensure that there is no power to the unit: 

• AC power supply units - Shut down the unit by removing the power cable from the power 
supply connector.

• DC power supply units - Toggle the circuit breaker to the OFF position. Disconnect the cables 
from the power connector.

4. Loosen the power supply unit by turning the safety screw clockwise. 

Note: Turning the screw counterclockwise tightens the screw. Use a slotted screwdriver to tighten or 
loosen the screw, then use your fingers to further turn the screw, if necessary.

5. Firmly grasp the power supply by the handle, shown in Figure 288.
.

Figure 288. Power supply handle (AC power supply)

Figure 289. Power supply handle (DC power supply)

Safety screw

Power connector

Power supply insertion/
removal handle

Power supply insertion/
removal handle

Disconnect cables from 
power connector

Safety screw

Power connector
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6. Pull gently but firmly, sliding the power supply out of the bay as shown in Figure 290. 

Figure 290. Power supply removal (AC power, left; DC power, right)

Inserting a Power Supply

Once you have removed the failed power supply, install a replacement:

1. Remove the replacement power supply from its packing and carefully inspect it for damage.

Do not install a visibly damaged power supply.

Rear of chassis

Rear of chassis
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Replacing a Fan Tray

2. Slide the replacement power supply into the slot

Figure 291. Power supply insertion (AC power, left; DC power, right)

3. Turn the screw counterclockwise to tighten it, securing the power supply to the BNP3xr chassis.

4. Connect power to the power supply:

• For AC power supplies, refer to “Connecting AC Power to the BNP3xr” on page 26.

• For DC power supplies, refer to “Connecting DC Power to the BNP3xr” on page 27.

Replacing a Fan Tray

The two fan trays in the BNP3xr are redundant and hot-swappable; however, normal BNP3xr 
operation is such that both fan trays should be operational at all times. A fan tray may be safely 
removed or replaced as long as the BNP3xr remains within the normal operating temperature range 
(see the section, titled “Environmental” on page 296 for details on operating temperature). 

To replace a fan tray, proceed as follows:

Note: The front bezel does not need to be removed when replacing a fan tray.

Rear of chassis

Rear of chassis
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1. Using a slotted or Phillips screwdriver, loosen the captive screw located above the fan tray handle. 

Figure 292. Fan tray removal

2. Use the handle to pull out the fan tray assembly.

3. Insert the new fan tray assembly provided by RGB.

4. Tighten the captive screw using a slotted or Phillips screwdriver.

Figure 293. Fan tray replacement

Loosen screw

Tighten screw
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Replacing a Gigabit Ethernet Processor (GBP3) Module

Replacing a Gigabit Ethernet Processor (GBP3) Module

When you have determined that a GBP3 module must be replaced, follow this procedure to remove 
and replace the module. You do not need to remove the chassis from its rack mount to replace a 
module.

Removing a GBP3 Module

1. Ensure that you have a replacement module available, then shut down the unit by removing the 
power cable from the power supply connector.

2. Remove all cabling from the module.

3. Grasping it firmly with your fingers, gently remove the bezel on the front of the chassis, as shown 
in Figure 294.

Figure 294. Front bezel removal

4. Using a Phillips screwdriver, loosen—but do not remove—the screws that secure both sides of the 
GBP3 module to the chassis. They act as handles to assist with the module’s removal.

Figure 295. Loosen the GBP3 module release screws

Front of chassis

Loosen the 
release 
screws
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5. Firmly grasping the screws, slide the GBP3 module out of the bay, as shown in Figure 296.

Figure 296. GBP3 module removal

Replacing a GBP3 Module

After you have removed the failed GBP3 module, replace it with the new one:

1. Grasp the module firmly by the edges only and slide it into the chassis, using the plastic guide rails 
to ensure proper seating.

2. Push until the module is firmly seated.

3. Using a Phillips screwdriver, tighten the insertion/removal screws to secure the GBP3 module to 
the BNP3xr chassis.

4. Replace the front bezel by snapping it in place.

5. Restore any cabling and power up the unit.

Replacing a Processor Module (PROC3) or an ASI Module

Note: The BNP3xr supports both ASI and ASI2 modules.

Removing and replacing either a PROC3 module or an ASI module uses the same procedure.

• If you are adding a new PROC3 or ASI module to an existing but underpopulated chassis, insert the 
card into the next designated slot.

• If you are replacing a failed unit, simply replace that unit regardless of the slot it occupies.
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Replacing a Processor Module (PROC3) or an ASI Module

Removing a PROC3 or ASI Module

1. Shut down the unit by removing the power cable from the power supply connector.

2. Using a Phillips screwdriver, loosen—but do not remove—the insertion/removal screws, shown in 
Figure 297.

Figure 297. Loosen the insertion/removal screws

3. Using the handles on either side of the module as a grip, gently but firmly slide the module out of 
the chassis, as shown in Figure 298.

Figure 298. Remove the module

Replacing a PROC3 or ASI Module

After a PROC3 module has been removed, replace it as soon as possible, or install a blank slot cover to 
ensure proper air flow.

If you are leaving an empty slot, any empty slot should be fitted with a blank cover.

Caution! ASI modules should always be replaced; no filler should be used.

Loosen the screws

Rear of chassis



Field-replaceable Units

292 BNP3xr User Guide

To install a PROC3 or ASI module:

1. Firmly hold the card by the edges or the handles and slide it into the chassis, using the plastic guide 
rails to ensure proper seating.

2. Press firmly until the module seats in the chassis.

Figure 299. Install the ASI or PROC3 module (ASI shown)

3. Using a Phillips screwdriver, tighten the insertion/removal screws to attach the card to the chassis.

4. Restore any cabling and power up the unit.

5. Reboot the system as described in “Rebooting the System” on page 116.

Rear of chassis
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CHAPTER 12

Specifications

This chapter provides the system specifications for the BNP3xr.

In This Chapter:

• “Input Interfaces/Output Interfaces,” next.

• “MPEG Processing” on page 293.

• “Video Formats” on page 294.

• “Audio Formats” on page 294.

• “Regulatory Compliance” on page 296.

• “Electrical/Mechanical” on page 296.

• “Environmental” on page 296.

Input Interfaces/Output Interfaces

MPEG Processing

Table 55. Input/Output Interfaces

Interface Type

Gigabit Ethernet 8 SFP interfaces (copper or optical) configured

Fast Ethernet 2 10/100BaseT control and management interface

ASI Up to 18 ASI ports per chassis

Up to 3 ASI modules with 6 ASI ports each

Software configurable as input or output

213 Mbps data rate/port

Table 56. MPEG Processing 

MPEG Supported Format

Transrating SD and HD MPEG-2 video streams

VBR and CBR support

QoS - Ability to set priority for the level of transrating desired



Specifications

294 BNP3xr User Guide

Video Formats

Audio Formats

Multiplexing and Table 
Processing 

MPEG-2and MPEG-4 H.264/AVC multiplexing and re-multiplexing

MPTS, SPTS, multicast and unicast support

CBR and VBR support

PID filtering and remapping

PCR restamping and de-jitter

Generation and pass-through of PSIP tables

PAT and PMT generation

DPI Seamless SD and HD splicing

SCTE 30 (DVS-380, DVS-638) and SCTE 35 (DVS-253) compliant

SCTE 30 to SCTE 35 conversion

Text and graphical crawl messages and graphical logo overlays

SCTE 18 (Emergency Alert Message for cable)

SCTE 21 to SCTE 20 conversion

Jitter Tolerance +/- 100 ms

Table 56. MPEG Processing (Continued)

MPEG Supported Format

Table 57. Video Formats

Video Supported Format

MPEG Profile and Level MPEG-2 MP@ML (SD) and MP@HL (HD)

MPEG-4 H.264/AVC (all profiles supported)

All SD and HD resolutions SD – 720 x 576, 720 x 480, 704 x 480, 544 x 480, 528 x 480, 352 x 480

HD – 1080i x 1920, 1080i x 1440, 1080i x 1280, 720p x 1280,

480p x 720, 480p x 704, 480p x 640

Frame Rates 24, 25, 29.97, 30, 50, 59.94, 60

Table 58. Audio Formats

Audio Supported Format

Audio Format Dolby AC-3, MPEG-1 Layer 2 (Musicam) and MPEG-2, MPEG-2 AAC, 
MPEG-4 HE-AAC
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Elementary Stream Types & Conversions

Elementary Stream Types & Conversions

Digital Broadcast

Table 59. Elementary Stream Types & Conversions

Output Transport 
Stream (TS) Type Videoa

a. For H.264 video, the stream type will be passed through regardless of input or output TS type.

Audiob

b. For AAC and HE-AAC audio, the stream type will be passed through regardless of input or output TS type.

Data

MPEG2 MPEG2 video (0x2) 
Converts to 0x2 if input video has 
type 0x80.

H.264 (0x1B)

MPEG1 audio (0x3)

MPEG2 audio (0x4)

ATSC AC-audio (0x81)

DVB AC-3 audio (0x6)

AAC (0x0f)

HE-AAC (0x11)

0x5 ~ 0xff

ATSC MPEG2 video (0x2) 

SCTE video (0x80) 

H.264 (0x1B)

MPEG1 audio (0x3)

MPEG2 audio (0x4)

ATSC AC-audio (0x81) 
Converts to 0x81 if input AC-3 
audio has type 0x6.

AAC (0x0f)

HE-AAC (0x11)

0x5 ~ 0xff

SCTE SCTE video (0x80)  
Converts to 0x80 if input video has 
type 0x2.

H.264 (0x1B)

MPEG1 audio (0x3)

MPEG2 audio (0x4)

ATSC AC-audio (0x81) 
Converts to 0x81 if input AC-3 
audio has type 0x6.

AAC (0x0f)

HE-AAC (0x11)

0x5 ~ 0xff

DVB MPEG2 video (0x2) 
Converts to 0x2 if input video has 
type 0x80.

H.264 (0x1B)

MPEG1 audio (0x3)

MPEG2 audio (0x4)

DVB AC-3 audio (0x6) 
Converts to 0x6 if input AC-3 
audio has type 0x81.

AAC (0x0f)

HE-AAC (0x11)

0x5 ~ 0xff

Table 60. Digital Broadcast

DVB Supported Format

Digital Broadcast ATSC PSIP, (A/52B, A/53E, A/58, A/65) 
DVB (DVB-SI, DVB-SUB, DVB-TXT, CSA and Simulcrypt)
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Regulatory Compliance

Electrical/Mechanical

Environmental

Table 61. Regulatory Compliance

Regulatory Type Compliance 

Safety UL 60950-1:2007; CAN/CSA-C22.2 No. 60950-1-07; TUV/GS, cTUVus: IEC 
60950-1:2005, EN 60950-1:2006+ A11

Electromagnetics FCC - Title 47 CFR Part 15 Subpart B; Canada ICES-003, Issue 2, April 
1995

Hazardous Substances RoHS-compliant (Restricted use of Hazardous Substances)

Table 62. Electrical and Mechanical 

Specification Limits

Maximum Input Power Limits AC: 100-240V; 8.8A; 50/60Hz; Class 1

DC: 36-72V;15.7A; Class 1

Line Frequency 50-60 Hz

Power consumption 400 W maximum, fully loaded chassis at 110 V AC

Dimensions 2RU (3.5˝ H x 19˝ W x 23.25˝ L) (88 H x 444 W x 590.4 L mm)

Weight 38.7 lbs. (17.6 kg)

Cooling Front to back; BTU: 2900 BTU/hour maximum

Table 63. Environmental Ranges

Condition Value Range

Storage Temperature -40° C to 70° C

Operating Temperature 0° C to 40° C

Humidity 5% to 95% (non-condensing)

Noise Emissions 
(In accordance with ISO 9296)

LWAd (iB=10dB) 7.2 B 6.9 B 
LpAm (TBD) 58.1 dBA 55.3 dBA
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APPENDIX A

Editing the DVB NIT Table

This appendix shows you how to edit, make additions to, and delete items from the NIT table, one of 
the DVB tables. To understand the meaning and context of the various values in the table, consult one 
or both of the following documents:

• Digital broadcasting systems for television, sound and data services; Allocation of Service 
Information (SI) codes for Digital Video Broadcasting (DVB) systems, ETSI Technical Report, 
ETR 162, European Telecommunications Standards Institute, October 1995.

• Digital Video Broadcasting (DVB); Specification for Service Information (SI) in DVB systems, 
ETSI EN 300 468 V1.5.1 (2003-05), European Telecommunications Standards Institute.

In This Appendix:

• “NIT Values Supported,” next.

• “Naming, Viewing, Deleting and Editing NIT Configuration Files” on page 300.

• “Suggestions for Editing the NIT Table” on page 311.

NIT Values Supported

Table 64 shows the NIT values Mandatory values are indicated with an asterisk (*).

Table 64. Values Supported 

NIT Section Value Name Default Range

nit_section network_id 100

Version_ Number 1

*current_next_indicator 1

Array of 
network_name:

*name my network 
name

Any name

Array of linkage: *Transport stream ID 1 Any value that fits in 16 bits

*original_network ID 129 Any value that fits in 16 bits

*service_id 16642 Any value that fits in 16 bits

*linkage_type 9 Any value that fits in 16 bits

Array of 
private_data_byte:

data private1 Array of bytes of hex integers (if type is 8 or 9). 
Else it is char string
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Array of Freqency List *coding_type 2 0 (not defined), 1(Satellite), 2 (cable) and 3 
(terrestrial)

*Center_frequency: 3300000 32 bit unsigned integers

*Private_data: private_data_1 32 bit unsigned integer (currently defined 
values are) 1 (SES), 2 (BSKYB1), 3(BSKY2), 
4(BSKY3) BE (BetaTechnik), 0x6000 (News 
DataCom), 0x6001(NDC1), 0x6002(NDC2), 
0x6003(NDC3) 0x6004(NDC4), 
0x6005(NDC5), 0x6006(NDC6) 
0x362275(Irdeto) 0x4E544C(NTL) 
0x532D41(SFA) 0x44414E59(NEWS 
DATACOM), 0x46524549(NEWS 
DATACOM) 0x53415053 (SFA)

Array of Transport 
Stream

*transport stream id 769 Any value that fits in 16 bits

*original network id 1920 Any value that fits in 16 bits 

Array of service: id 16398 Any value that fits in 16 bits

type 1 1 to 0x10 and 0x80 to FE 1(digital television 
service)

*id 16403 Any value that fits in 16 bits

*type 1 1 to 0x10 and 0x80 to FE 1(digital television 
service)

Cable delivery 
system:

*frequency 6312500 Up to 8 digit (decimals) value in MHz

*FEC_Outer 2 4 bit integer 0,1, 2

*modulation 4 8 bit integer (00, 01, 02,03, 04 and 05)

symbol_rate 68750 7 digit (decimals) integer specifying symbols/
second

*FEC_Inner 5 4 bit integer 0 (not defined),1 (1/2 conv code rate), 
2(2/3), 3 (3/4), 4 (5/6), 5 (7/8), 6 (8/9), F (no conv 
Coding

Satellite Delivery 
System

*frequency 1208400 up to 8 digits (decimal) value in GHz

orbital_position 970 up to 4 digit (decimal) value orbital position. A 
decimal occurs after the third character

west_east_flag 0 0 or 1 (0 indicates western, 1 indicates eastern)

polarization 1 0 (linear horizontal), 1 (linear vertical), 2 (circular 
left) or 3 (circular right)

modulation 1 0 (not defined), 1 (QPSK), 2 (8 PSK) or 3 (16 
QAM)

symbol_rate 220000 7 digit value specifing mega symbol/sec (decimal 
(imaginary) occurs after third digit)

FEC_Inner 3 4 bit integer 0 (not defined),1 (1/2 conv code 
rate),2 (2/3), 3 (3/4), 4 (5/6), 5 (7/8), 6 (8/9), F(no 
conv Coding

Table 64. Values Supported (Continued)

NIT Section Value Name Default Range
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NIT Values Supported

Terrestrial Delivery 
System

centre_frequency 739000000 32 bit integer (expressed in multiple of 10Hz)

bandwidth 0 0 (8 MHZ), 1 (7 MHZ) or 2 (6 MHZ) (3 bit field)

constellation 2 0 (QPSK), 1 (16 QAM), 2 (64 QAM) (2 bit field)

*hierarchy_information 0 0 (non hierarchical),1 (alpha = 1), 2 (alpha = 2), 3 
(alpha=4) (3 bit field)

code_rate-HP_stream 0 0 (1/2),1 (2/3), 2 (3/4), 3 (5/6), 4 (7/8) (3 bit field)

code_rate-LP_stream 0 0 (1/2), 1 (2/3), 2 (3/4), 3 (5/6), 4 (7/8) (3 bit field)

*guard_interval 3 0 (1/32), 1 (1/16), 2 (1/8) or 3 (1/4) (2 bit field)

transmission_mode 1 0 (2k mode) or 1 (8k mode) (2 bit field)

*other_frequency_flag 1 0 (no other frequency in use) or 1 (more than one 
frequency in use)

Array of Private Data data 1 32 bit unsigned integer (currently defined values 
are) 1 (SES), 2 (BSKYB1), 3 (BSKY2), 4 (BSKY3) 
BE (BetaTechnik), 0x6000 (News DataCom), 
0x6001 (NDC1), 0x6002 (NDC2), 0x6003 (NDC3) 
0x6004 (NDC4), 0x6005 (NDC5), 0x6006 (NDC6) 
0x362275 (Irdeto) 0x4E544C (NTL) 0x532D41 
(SFA) 0x44414E59 (NEWS DATACOM), 
0x46524549 (NEWS DATACOM) 0x53415053 
(SFA)

Array of Frequency 
List

coding_type 2 0 (not defined),1 (Satellite),2 (cable) and 3 
(terrestrial)

Center_Frequency 1300000

Table 64. Values Supported (Continued)

NIT Section Value Name Default Range
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Naming, Viewing, Deleting and Editing NIT Configuration Files

Naming a Configuration File

An opening window with no files named is shown in Figure 300. The default configuration file is 
present.

Figure 300. Window With No Arrays

To name a configuration file:
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Naming, Viewing, Deleting and Editing NIT Configuration Files

1. Click Edit. The default configuration file appears (Figure 301).

Figure 301. Default Array

2. Now enter a name for the file in the Name space, in this case Array2.

3. Click Apply. 

The configuration file is named as Array2. (Figure 302).

Figure 302. Array2 Added
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Viewing a Configuration File

You can view an configuration file in XML format. 

1. In Figure 302, choose View NIT in XML Format. A window similar to Figure 303 appears.

Figure 303. NIT Configuration File Viewed in XML Format

2. Navigate to where the arrays are stored and click Open. The window of Figure 304 appears.

Figure 304. Assigning a Name to a Configuration File
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Naming, Viewing, Deleting and Editing NIT Configuration Files

3. Assign the name you want to the Array. In this example, we chose Array2.

Deleting a Configuration File

1. To delete an array, highlight the array to be deleted in Figure 302.

2. Click Delete.

3. The delete confirmation box appears (Figure 305).

Figure 305. Delete Confirmation

4. Click Yes if you want to delete the configuration file

The Array is deleted.
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Editing a Configuration File

1. Highlight the configuration file you want to edit (Figure 306).

Figure 306. Setup Network Information Table screen

2. Click Edit. The window of Figure 307 appears.

Figure 307. Editing Window
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Naming, Viewing, Deleting and Editing NIT Configuration Files

Icon Menu

Figure 308 shows the icons appearing at the top of the window.

Figure 308. Icon Menu

Insert Node Before

Insert Node After

Remove Node

Move Node Up

Move Node Down
Open Namespace Qualifier Window

Find Invalid Node

Search

XML Editor XML Viewer
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Figure 309 shows the Namespace Qualifiers window, obtained when you click the Namespace 
Qualifier icon

Figure 309. Namespace Qualifier Window

Figure 310 shows the Search window, obtained when you click the Search icon.

Figure 310. Search Window
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Naming, Viewing, Deleting and Editing NIT Configuration Files

Expanding the NIT Edit Window

The vertical bars shown in the window of Figure 307 on page 304 are used to toggle between an 
expanded and reduced view. through show three layers of expansion. Clicking the large vertical bar 
compresses the display as shown in Figure 311.

Figure 311. Large Vertical Bar Clicked Fully Compress

Figure 312 shows the first level of expansion from Figure 307 on page 304, obtained by clicking all of 
the small bars to the right of the large bar.

Figure 312. First Level of Expansion
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Clicking all of the smaller bars in Figure 312 creates the second level of expansion shown in 
Figure 313.

Figure 313. Second Level of Expansion

Clicking the smaller bars in Figure 313 creates the third level of expansion shown in Figure 314.

Figure 314. Third Level of Expansion
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Naming, Viewing, Deleting and Editing NIT Configuration Files

Inserting a Node

To insert a node, select the node and click Insert Node Before (Figure 315).

Figure 315. Inserting a Node Before

Figure 316 shows the result.

Figure 316. Node Inserted Before
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In the node that was added, we attempted to change the value of the transport stream to an alpha value, 
‘a.” An error message resulted (Figure 317).

Figure 317. Error Message from Wrong Type of Data Character

Using the proper data types we changed the values so they are different from the original (Figure 318).

Figure 318. Data Type Mismatch Corrected
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Suggestions for Editing the NIT Table

Deleting a Node

You can delete a node. In the example, highlight the linkage to be deleted and click Remove Node. The 
node is deleted (Figure 319).

Figure 319. Linkage Deleted

Suggestions for Editing the NIT Table

The following are some suggestions that may prove helpful in editing the NIT table:

• In editing fields, go to the next tab to apply.

• When adding new nodes or fields, it is easiest to right click on the node to be added, then choose 
Insert.

• Uncheck optional fields if they are not needed.
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APPENDIX B

Localized Cautions and Warnings

This appendix provides all of this manual’s Caution and Warning statements in French and German.

Page number Statement type Statement

Page 16 Warning Whenever computer components are handled (especially during 
installation), the equipment can be damaged by the buildup of static 
electricity. Take precautions before touching any internal components 
or boards by wearing an ESD wrist strap or working on an antistatic 
mat. Always hold system modules by the edges and avoid touching 
any electronic circuitry on the cards.

Avertissement Lors de la manipulation de composants électroniques ou 
informatiques (en particulier pendant l'installation) l'équipement peut 
être endommagé par l'accumulation d'électricité statique. 

Prenez des précautions avant de toucher tout circuit ou toute carte 
interne, soit en portant un bracelet antistatique, soit en travaillant sur 
un tapis de sol antistatique.

Tenez toujours les modules du système par leurs bords et évitez de 
toucher tout circuit électronique sur les cartes.

Warnung Bei der Handhabung von Computerbauteilen (insbesondere beim 
Einbau) können diese durch elektrostatische Aufladung beschädigt 
werden. Treffen Sie Vorsichtsmaßnahmen, indem Sie ein 
Erdungsarmband anlegen oder auf einer antistatischen Matte 
arbeiten, bevor Sie Bauteile oder Leiterplatten im Inneren des Geräts 
berühren. Halten Sie Systemmodule immer an den Kanten, und 
berühren Sie die elektronischen Bauteile auf den Leiterplatten nicht.

Page number Statement type Statement

Page 21 Caution

Attention EQUIPEMENT SENSIBLE A L'ELECTRICITE STATIQUE 

PRENEZ DES PRECAUTIONS

Vorsicht Elektrostatisch empfindliches Gerät 

Vorsichtsmaßnahmen beachten
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Page number Statement type Statement

Page 22 Caution Please install the BNP3xr so as to be easily accessible and as close 
to a power socket outlet as possible.

Attention Installez le BNP3xr dans un endroit accessible et aussi près que 
possible d'une prise de courant.

Vorsicht Der BNP3xr muss möglichst leicht zugänglich und in der Nähe einer 
Netzsteckdose aufgestellt werden.

Page number Statement type Statement

Page 22 Caution Be sure that the BNP3xr is mounted in a location that meets the 
environmental conditions shown in Table 3.

Attention Vérifiez que le BNP3xr est installé dans un lieu qui satisfait aux 
conditions environnementales présentées dans le tableau 3.

Vorsicht Vergewissern Sie sich, dass der Aufstellort des BNP3xr den in 
Tabelle 3 aufgeführten Umgebungsbedingungen entspricht.

Page number Statement type Statement

Page 24 Warning The BNP3xr must be properly grounded to ensure safe operation. 
Before you connect power or turn on the BNP3xr, ground the chassis. 
This section provides one method of grounding. There may be others: 
check your network configuration for details.

Avertissement Le BNP3xr doit être correctement relié à la masse pour assurer un 
fonctionnement sécurisé.

Avant de connecter le courant ou de mettre en marche le BNP3xr, 
reliez le châssis à la masse. 

Cette section indique une méthode de mise à la masse. Il peut y en 
avoir d'autres : vérifiez la configuration de votre réseau pour plus de 
détails.

Warnung Für einen sicheren Betrieb muss der BNP3xr vorschriftsmäßig 
geerdet sein. Erden Sie das Chassis des BNP3xr, bevor Sie das 
Gerät an die Stromversorgung anschließen oder einschalten. Dieser 
Abschnitt erläutert eine Erdungsmethode. Eventuell gibt es auch 
andere Möglichkeiten. Prüfen Sie ihre Netzwerkkonfiguration, um 
diesbezügliche Einzelheiten festzustellen.
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Localized Cautions and Warnings

Page number Statement type Statement

Page 24 Warning If you are installing dual redundant power supplies, only ground one 
of the two power supplies.

Avertissement Si vous installez des doubles alimentations redondantes, ne reliez 
qu'une seule des alimentations à la masse.

Warnung Wenn Sie zwei redundante Netzteile einbauen, erden Sie nur eines 
der beiden Netzteile.

Page number Statement type Statement

Page 26 Caution The power cord is the disconnect device for the BNP3xr. There is no 
power switch: once connected to the power outlet, the unit powers up 
immediately.

Attention Le cordon d'alimentation constitue le mécanisme de déconnexion du 
BNP3xr. Il n'y a pas d'interrupteur : une fois connecté à la prise de 
courant, le système est immédiatement mis sous tension.

Vorsicht Der BNP3xr wird mit dem Netzkabel ein- und ausgeschaltet. Es gibt 
keinen Netzschalter. Beim Einstecken des Netzkabels in die 
Steckdose wird das Gerät unmittelbar eingeschaltet.

Page number Statement type Statement

Page 27 Caution Only trained personnel should install or replace this equipment.

Attention Seul un personnel qualifié devrait installer ou remplacer cet 
équipement.

Vorsicht Dieses Gerät darf nur von qualifiziertem Personal aufgestellt und 
ausgetauscht werden.
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Page number Statement type Statement

Page 27 Caution Make sure that the safety screws are in the locked position (turned 
counterclockwise) after the power supplies are installed, but before 
connecting power (Figure 22). Note that the locked position may be 
different than that of similar units. This ensures that the power 
supplies cannot be accidentally disconnected, causing possible 
damage.

Attention Assurez-vous que la vis de sécurité est en position bloquée (tournée 
dans le sens contraire des aiguilles d'une montre) après avoir installé 
l'alimentation, mais avant d'avoir connecté le courant (figure 22). 

Notez que la position bloquée peut être différente de celle d'unités 
similaires.

Ceci constitue la preuve que l'alimentation ne peut pas être 
déconnectée par accident, et ainsi causer de possible dommages.

Vorsicht Vergewissern Sie sich, dass sich die Sicherheitsschraube in der 
verriegelten Position befindet (gegen den Uhrzeigersinn), nachdem 
das Netzteil eingebaut wurde, aber bevor das Gerät an die 
Stromversorgung angeschlossen wird (Abbildung 22). Beachten Sie, 
dass die verriegelte Position anders als bei ähnlichen Einheiten sein 
kann. So wird sichergestellt, dass das Netzteil nicht versehentlich 
getrennt wird, was zu Beschädigungen führen kann.

Page number Statement type Statement

Page 27 Caution These are +48V DC power supplies, not -48V. Please connect 
accordingly.

Attention Il s'agit d'une alimentation +48V, et non -48V. Connectez en fonction.

Vorsicht Die Netzteile weisen Anschlusswerte von +48 V DC (Gleichstrom) 
auf, nicht -48 V. Bitte schließen Sie diese entsprechend an.

Page number Statement type Statement

Page 30 Caution Your license is attached to the compact flash (CF); do not discard it. 
Even if a CF card fails, keep the device and contact RGB technical 
support for instructions on repair or obtaining a working replacement.

Attention Votre licence se trouve sur la carte mémoire Compact Flash. Ne 
l'égarez pas. 

Au cas où la carte mémoire Compact Flash serait déficiente, 
conservez-la et contactez le support technique RGB pour obtenir des 
instructions concernant la réparation ou le remplacement.

Vorsicht Ihre Lizenz ist auf der Compact Flash-Karte enthalten. Entsorgen Sie 
diese nicht. Selbst wenn eine CF-Karte ausfällt, bewahren Sie diese 
auf, und wenden Sie sich an den technischen Kundendienst von 
RGB, um Anweisungen für die Reparatur oder den Austausch durch 
eine funktionsfähige Karte zu erhalten.
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Localized Cautions and Warnings

Page number Statement type Statement

Page 50 Caution Care is needed when selecting this action: forcing a redundancy 
change will temporarily (and briefly) interrupt services during the 
failover process.

Attention Sélectionnez cette action avec précaution : forcer un changement de 
redondance interrompt temporairement (et brièvement) les services 
pendant le processus de basculement.

Vorsicht Gehen Sie bei diesem Vorgang mit Bedacht vor. Das Erzwingen einer 
Redundanzänderung führt zu einer vorübergehenden (kurzen) 
Dienstunterbrechung während des Failover-Vorgangs.

Page number Statement type Statement

Page 163 Caution If you replace one transport stream with another, the original will be 
completely deleted.

Attention Si vous remplacez un flux de transport par un autre, le flux original 
sera complètement détruit.

Vorsicht Beim Ersetzen eines Transportstroms durch einen anderen wird der 
ursprüngliche Strom vollständig gelöscht.

Page number Statement type Statement

Page 284 Warning Never replace any FRU while the chassis is still connected to the 
power source.

Avertissement Ne remplacez jamais une unité remplaçable sur site si  le châssis est 
toujours connecté à l'alimentation.

Warnung Tauschen Sie kein vor Ort austauschbares Teil aus, während das 
Chassis mit der Stromversorgung verbunden ist.
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Page number Statement type Statement

Page 284 Warning Do not replace any component (such as fuses) not specifically 
described here. For replacement beyond the FRU level, contact your 
technical support representative for instructions on returning the 
component. (See “Contacting RGB Customer Support” on page 280.)

Avertissement Ne remplacez aucun composant (tel que les fusibles) qui ne soit pas 
spécifiquement décrit ici.

Pour des remplacements au-delà des unités remplaçables sur site, 
contactez le représentant du support technique pour connaître les 
instructions à suivre si vous souhaitez renvoyer le composant. (Voir 
“Contacting RGB Customer Support” on page 280).

Warnung Tauschen Sie keine Komponenten (wie Sicherungen) aus, die hier 
nicht ausdrücklich genannt sind. Beim Austausch von Komponenten, 
die keine vor Ort austauschbaren Teile sind, wenden Sie sich an den 
für Sie zuständigen Mitarbeiter des technischen Kundendiensts, um 
Anweisungen zum Zurücksenden der Komponente zu erhalten. 
(Siehe “Contacting RGB Customer Support” on page 280.)

Page number Statement type Statement

Page 291 Caution ASI modules should always be replaced; no filler should be used.

Attention Les modules ASI doivent toujours être remplacés. N'utilisez jamais de 
bouche-trou.

Vorsicht ASI-Module müssen immer ersetzt werden. Verwenden Sie keine 
Blindblenden.
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Information to Users

United States

DECLARATION OF CONFORMITY

Responsible Party Name: RGB Networks, Inc.
Address: 390 West Java Drive

Sunnyvale, CA 94089, U.S.A.
Telephone: (877) 742-6389
Declares that product: Broadcast Network Processor—BNP3xr

Complies with Part 15 of the FCC Rules.

This device complies with Part 15 of the FCC Rules. Operations are subject to the following two conditions: 
(1) This device must not be allowed to cause harmful interference; (2) This device must accept any interference 
received, including interference that may cause undesired operation.

Modifying the equipment without RGB Networks’ authorization may result in the equipment no longer 
complying with FCC requirements for Class A or Class B digital devices. In that event, your right to use the 
equipment may be limited by FCC regulations, and you may be required to correct any interference to radio or 
television communications at your own expense.

For Class A Equipment

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

Canada

This Class A digital apparatus complies with Canadian ICES-003.
Avis de conformité à la réglementation d’Industrie Canada.
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.
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Information to Users

European Declaration of Conformity

RGB Networks, Inc., declares that the product Broadcast Network Processor, BNP3xr to which this declaration 
relates is in conformity with the following standards:

• CISPR 22:2005

• EN55022:2006

• EN55024:1998 + A1:2001 + A2:2003

• EN61000-4-2: ESD immunity

• EN61000-4-3: Radiated RF field immunity

• EN61000-4-4: Immunity to electrical fast transients

• EN61000-4-5: Surge immunity

• EN61000-4-6: RF conducted immunity

• CB/UL 60950-1:2007; CAN/CSA-C22.2 No. 60950-1-07

This product follows the provisions of the EMC Directive 2004 / 108 / EC and carries the CE marking 
accordingly.

Support Tel: 877-RGB-NETW
FAX: (408) 701-2710
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Glossary

This glossary defines the acronyms common in the video industry, and used in this guide. It is not all-
inclusive but serves as a reference.

Numeric

A

C

3DES Triple Data Encryption Standard. A mode of DES that encrypts data three 
times. Three 64-bit keys are used, for an overall key length of 192 bits.

AES Advanced Encryption Standard. AES is a privacy transform for IPSec and 
Internet Key Exchange, and is replacing the Data Encryption Standard (DES). 
AES offers a larger key size and a variable key length.

Alpha Channel In reference to editing image files, an alpha channel stores selections as 
grayscale images. Adding alpha channels to an image allows the creation and 
storing of masks in order to manipulate or protect parts of an image.

ARP Address Resolution Protocol. ARP broadcasts a packet containing the IP 
address that the sender specifies to all hosts attached to an Ethernet connection. 
When the target recognizes that the IP address is its own, it returns a response. 

ASI Asynchronous Serial Interface. ASI extends the functionality from strictly a 
video/audio-bounded device to a transport stream-based system that can store 
data in either a single program stream or a set of multiple program streams.

ATSC Advanced Television Systems Committee. ATSC is working to coordinate 
television standards among different communications media. ATSC is also 
developing digital television implementation strategies. 

CA Conditional Access. Conditional access is an encryption/decryption 
management method by which a broadcaster controls a subscriber's access to 
services. 

CAS Conditional Access Systems. These are systems that ensure broadcast service 
is accessible only to those entitled to access, usually by scrambling or 
encrypting the service.

CBR Constant Bit Rate. Constant bit rate encoding ensures that the rate at which a 
codec's output is consumed is constant. Because it is the maximum bitrate that 
matters, CBR is useful for streaming multimedia content on limited capacity 
channels. See also VBR.

CSA Common Scrambling Algorithm. 
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D

E

DCCT Direct Channel Change Table, part of 9 tables in the ATCS PSIP. The DCCT 
instructs the receiver to change channels based on viewer preferences, 
demographics or geographical location. This table works with a DCCSDT in 
the set top box. 

DCCSDT DCC Selected Code Change Table, part of 9 tables in the ATCS PSIP.

DES Data Encryption Standard. DES specifies a FIPS approved cryptographic 
algorithm as required by FIPS 140-1. Encrypting data converts it to an 
unintelligible form called cipher. The cryptographic security of the data 
depends on the security provided for the key used to encipher and decipher the 
data. Data can be recovered from cipher only by using exactly the same key 
used to encipher it.

DET Data Event Table, part of 9 tables in the ATCS PSIP. The DET announces the 
data portion of a video/audio/data event when the data event does not match 
the exact duration of an video/audio event.

DHCP Dynamic Host Configuration Protocol. DHCP servers let individual computers 
on an IP network extract their configurations. DHCP servers have no specific 
information about the individual computers until they request the information.

DOCSIS Data Over Cable Service Interface Specifications. Now known as CableLabs 
Certified Cable Modems. DOCSIS specifies modulation schemes and the 
protocol for exchanging bidirectional signals over cable. 

DPI Digital Program Insertion. The digital splicing of one MPEG program 
(typically a commercial) into another based on digital cues within the MPEG 
transport stream.

DVB Digital Video Broadcast. A European set of defined transmission standards for 
digital broadcasting systems.

DWDM Dense Wavelength Division Multiplexing. A fiber-optic transmission 
technique using light wavelengths to transmit data parallel-by-bit or serial-by-
character.

EAS Emergency Alert System. An operational structure for national and local 
emergency alerts used by broadcast, cable, and wireless cable.

EBIF Enhanced Binary Interchange Format. EBIF standard provides a solution for 
the delivery of interactive data to existing set-top boxes (STBs), including 
older models of STBs. EBIF condenses interactive applications in order to use 
the minimal STB resources available for interactive data delivery

ECM Entitlement Control Messages.

ECMG ECM Generator.

EISS ETV Integrated Signaling Stream data ES — carries timing signals that trigger 
events associated with the user-agent application loaded onto the STB.
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Glossary

F

G

H

EIT Event Information Table, part of 9 tables in the ATCS PSIP. EITs are 
associated with a specific virtual channel in the VCT, contain event 
information, and point to the location of extended text in the ETT. Each EIT 
PID contains 3 hours worth of events per program.

EM Element Manager. The graphical user interface for the BNP.

EMM Entitlement Management Message. A packet containing the information 
necessary to decrypt the picture.

EMMG Entitlement Management Message Generator. The component of the 
conditional access headend that delivers entitlements to the multiplexers. 

EOD Everything-On-Demand.

ES Elementary Stream, an individual audio, video, or data output stream that is 
transmitted in a program

ETT Extended Text Table, part of 9 tables in the ATCS PSIP. ETTs carry longer text 
messages than EITs for describing events and virtual channels. 

ETV Enhanced Television. 

FCC Federal Communications Commission. The agency that regulates 
communications services, including cable television, at the Federal level.

FPGA Field Programmable Gate Array. An array of logic gates that can be hardware-
programmed to fulfill user-specified task.

FVOD Free-Video-On-Demand.

GigE Gigabit Ethernet. Ethernet which supports data transfer rates of 1 Gigabit 
(1,000 megabits) per second.

GBP /GBP2 Gigabit Ethernet Processor module. 

GUI Graphical User Interface.

HD High Definition. High-resolution digital television combined with Dolby 
Digital surround sound (AC-3). 

HFC Hybrid Fiber/Coax. A distribution system combining fiber and coax cable. An 
HFC system is used to distribute CATV signals into a neighborhood. 
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I

J

L

M

N

IGMP Internet Group Management Protocol. IP hosts use IGMP to register dynamic 
multicast group membership. Connected routers discover the group members 
using the same protocol.

IP Internet Protocol. The network layer for the TCP/IP Protocol Suite. It is a 
connectionless, best-effort packet switching protocol.

ITU International Telecommunication Union. An international organization through 
which governments and the private sector coordinate global 
telecommunications networks and devices.

JRE Java Runtime Environment. JRE is made up of the Java virtual machine, the 
Java platform core classes, and supporting files.

LED Light Emitting Diode. A semiconductor diode that emits light when current 
passes through it. LEDs are used as indicators.

MGT Master Guide Table, part of 9 tables in the ATCS PSIP. MGT provides 
program-identification (PID) locations so a receiver can find the other tables, 
and informs the receiver of changes or table updates.

MIB Management Information Base. MIB defines the variables needed by the 
SNMP protocol to monitor and control elements in a network. 

MID Mid-plane.

MPEG Moving Pictures Experts Group. The standards group and the standard for 
compression and storage of motion video.

MPTS Multi-Program Transport Stream. A combined multiplex of video streams.

MUX Multiplexer. A device that both combines multiple data sources into a single 
data stream for transmission, and demultiplexes the single data stream into its 
composite forms.

NTP Network Time Protocol. A TCP protocol that assures accurate local time-
keeping with reference to radio and atomic clocks, and can synchronize 
distributed clocks within milliseconds.

NTSC National Television System Committee. Committee that defined the current 
standard for analog color television in North America, as well as the name for 
the standard. The format is 525 lines in 4MHx of video bandwidth.
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O

P

Q

R

OOB Out-Of-Band.

PAT Program Association Table. A table ID that indicates the MPEG-2 SI packet 
type.

PCR Program Clock Reference.

PMT Program Map Table. A table ID that indicates the MPEG-2 SI packet type.

PNG Portable Network Graphics. PNG format is used for lossless compression and 
for display of images on the web. Unlike GIF, PNG supports 24-bit images and 
produces background transparency without jagged edges. PNG format 
supports RGB, Indexed Color, Grayscale, and Bitmap mode images without 
alpha channels. PNG preserves transparency in grayscale and RGB images.

PSI Program Specific Information, as part of MPEG-2.

PSIP Program and System Information Protocol. PSIP is a collection of nine tables 
that allow the DTV transport stream to provide information about a station's 
services and programming. These nine tables include:

Master Guide Table (MGT) 
System Time Table (STT) 
Virtual Channel Table (VCT) 
Rating Region Table (RRT) 
Event Information Table (EIT) 
Extended Text Table (ETT) 
Data Event Table (DET) 
Directed Channel Change Table (DCCT) 
DCC Selected Code Change Table (DCCSDT)

QAM Quadrature Amplitude Modulation. This is the modulation technique used in 
systems carrying digital video.

QoS Quality of Service. Guarantees network bandwidth and availability for 
applications.

RF Radio Frequency. Television signals are modulated onto RF signals and are 
then demodulated by the television tuner.
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S

T

RTP Real Time Protocol. RTP provides services such as payload type identification, 
sequence numbering, time-stamping, and delivery monitoring to real-time 
applications.

RU Rack Unit. A common increment of equipment space height. The height of 1 
RU is 1.75 inches. 

SAP Secondary Audio Program. A way to provide a second audio channel within a 
TV broadcast channel. Commonly used for stereophonic sound or bilingual 
audio tracks.

SCTE Society of Cable Telecommunications Engineers. An organization that 
develops training for cable television installers and engineers and standards for 
the cable industry. 

SD Standard definition.

SFP Small Form Factor Pluggable. An optical interface that is used in network 
switches for Fibre Channel, Gigabit Ethernet and InfiniBand.

SNMP Simple Network Management Protocol. A protocol used to monitor and 
control network devices, and to manage configurations, statistics collection, 
performance, and security.

SPTS Single Program Transport Stream.

SSM Source Specific Multicast. A way to deliver multicast packets whereby only 
packets delivered to a receiver are those that have originated from a specific 
source IP address that has been requested by the receiver. 

STP Strip Processor. The STP modules (NP and ASI) is one of the units that 
comprise the BNP.

STT System Table Time. Allows a broadcaster to present time indicators to the 
consumer, ensuring that the time is synchronized.

SVOD Subscription-Video-on-Demand. This is a Video-on-Demand service offered 
by subscription, providing viewers with access to select programs from the 
libraries of featured cable networks.

TFTP Trivial File Transfer Protocol. TFTP uses UDP and is often used by servers to 
boot diskless workstations, X-terminals, and routers.

TS Transport Stream, the result of multiplexed--or combined--audio, video, or 
other data content that is packaged and transmitted through the broadcast 
network.

TVCT A Terrestrial Virtual Channel Table is a mandatory PSIP table that lists all the 
virtual channels available in an ATSC transport stream, and optionally, virtual 
channels available in other ATSC transport streams.
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Glossary

U

V

X

UDP User Datagram Protocol. A connectionless protocol that runs on top of IP 
networks. UDP provides a direct way to send information over an IP network. It 
is used primarily for broadcasting messages over a network.

VBI Vertical Blanking Interval. A portion of a television signal that carries non-
audio/video data, such as closed-caption text. 

VBR Variable Bit Rate. VBR streams vary in bandwidth over time.

VCT Virtual Channel Table, part of 9 tables in the ATCS PSIP. The VCT contains a 
list of all the channels that are or will be online, along with their channel name 
and number. This table contains the set of data that enables a receiver to tune 
and locate the service being broadcast. 

VOD Video-on-Demand. Video-on-demand systems allow users to watch video 
content over a network as part of an interactive television system, either by 
streaming or by download.

XFP 10 Gigabit Small Form Factor Pluggable (SFP). The XFP is a pluggable, hot-
swappable optical interface for 10 Gigabit SONET/SDH, Fibre Channel, 
Gigabit Ethernet, and other applications. XFP modules are optical transceivers, 
typically 1310nm or 1550nm. Optical XFPs include digital diagnostics.
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Index

Numerics
19-inch rack 22

A
AAA 57
AAA default IP 65
AAA default port 65
AAA default protocol 65
AAA Server Order menu 67
AAA servers 63
access criteria 266, 272
Account level

administrator 62
operator 62
user 62

Ad Server 214
ad splicing 221
Adding AAA servers 63
advanced messaging 7
air flow 22
Alarms 275

Viewing 275
alpha channel 90
alpha channels 8, 90
antistatic mat 16
applying power 26, 27, 28
ASI 9, 21
assumptions 2
Asynchronous Serial Interface 20
authentication, authorization and accounting 

(AAA) 57

B
bit rate 168
Bitrates

Monitoring 208
BNP3xr 1
bracket

rack mount 15

C
CA 35
CAS 237, 238, 255, 256, 258, 259, 266, 274
Caution

mounting location and environmental 
conditions 22

Change Password 62
Changing Server Order 66
chassis

ground 24
view 36

Chassis Redundancy 43
common scrambling algorithm 8, 237

CSA 237
compact flash 17, 18, 30, 279, 280
components 16
conditional access system 237
configure Global AAA parameters 59
configure passwords 61
crawl 8
creating

transport stream 127, 131, 137, 141, 142
creating multiple TS 128
CSA 8, 237
Customer Support

Contacting 280
CVCT 140
CWG 8, 237

D
deleting 163

streams 163
Deleting Servers 68
descriptor rules 223
Digital Program Insertion (DPI) 213
document audience 2
document organization 2
DPI Based

Ad Splicing 7
DTV transport stream 140
DVB Transport Stream 142
DVB-CA 8, 35, 237, 238, 239, 240, 241, 246, 251, 

252, 254, 264, 265, 266, 267, 269, 270, 272, 
274

access criteria 266
CAS mode 253
create ECM

access criteria 272
CAS ID 271
PID 272
sub CAS ID 271

create ECMG
CAS ID 257
CAS name 257
channel count 257
channel start offset 257
ECMG IP address 257
port 257
second CAS ID 257
Sub CAS ID 257

create EMM
client ID 260
data ID 260
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max bandwidth 260
second CAS ID 260

create SCG
CP duration 268
disable 269
scramble level 269
transport stream 268

createECM
private data 272

createECMG, CAS name 254
creating input TS 243
creating output TS 244
crypto period duration 252
CW mode 253
ECM ID 271
ECM test timeout 253
EIS test interval 253
EIS test timeout 253
EIT source 245
EMM multicast IP 254
EMM test interval 253
EMMG data port number 254
EMMG TCP control port number 253
external EIS port number 253
global parameters 250
license 239
modulation mode 245
network ID 244
private data 260
required components 238
SCG ID 268
scramble level 252
SDT source 245
TS type 244
unique TS ID 244
update timer 254

E
EAS 7

audio override 8
audio stream insertion 8
configuration 69

EBIF 219, 220, 222, 225, 226, 228, 229, 230, 322
late-bind 231
pre-bind 224, 227, 231
pre-bind, network 231
pre-bind, passthrough 224
pre-bind, passthrough,keep 228
pre-bind. passthrough, keep 228

ECM 8, 237, 253, 270, 271, 272, 274
ECMG 9, 237, 238, 253, 256, 257, 274
Edit AAA Server 64, 65
Editing AAA Servers 63
Editing an AAA Server 64
EIS 9, 237, 238, 245, 252, 253, 254, 274
EISS 220, 222, 226, 228, 230
electrostatic precautions 16

Element Manager 2, 31, 32, 33, 34, 35, 36, 107, 110, 
119, 221, 225, 227, 229, 231, 234, 238, 239, 
240, 241, 251, 254, 264, 280

menu descriptions 35
Element Monitor

reboot with 116
Element Stream 179
elementary stream 206
emergency alert system 7
EMM 8, 237, 253, 254, 259, 261, 263, 274
EMMG 9, 237, 238, 253, 254, 258, 260, 274
Enabling AAA Settings 60
enhanced television (ETV) 219
enhanced television binary interchange format 

(EBIF) 219
entitlement control message generator 9, 237
entitlement management message generator 9, 

237
ES 205
ESD 16, 284

wrist strap 16
Ethernet Control Port 38
Ethernet control port 50
ETV 219, 220, 231

configuration 226, 227, 229, 232
placeholder ES 223
pre-bind 231

ETV integrated signaling stream (EISS) 220
event information scheduler 9, 237
Events 275

Viewing 275

F
fan tray 21
fast Ethernet 29, 30, 50
Field-replaceable Unit see  FRU
force redundancy 50
Force Sync 45, 46
front bezel 16, 17, 289, 290
front panel 16, 17
FRU 284
FTP 108

G
GBP

installation 289
GBP module 20
GigE 9, 11, 12, 18, 25, 30, 38, 53, 54

IP address 54
GigE ports 120
Global 59
global AAA options 59
Grooming 7, 163, 173
grooming 119

PSI/SI table 247
ground

chassis 24
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Index

grounding 15, 16, 24, 25

H
HRC 30

I
Input Source 122, 123
installation 26, 27

rack mount 22
requirements 15

installing 15
XFPs 25

intended audience 2
IP Address 43
IP address 34
IPaddress

determining (with DHCP running) 53

J
Java 2, 32, 110
JRE 32

L
late-bind 231

source 233, 234, 236
LED indicator 279, 280
LEDs 279
LEDs, defined 17
Light Emitting Diodes, see LEDs
Local Configuration 61
Local screen 62
local user account 61
Local, 59
login 33, 34
logo overlay 69

positioning 92
zone configuration 91

M
mapping 164
mapping scheme, SFP port 19
master guide table 140
mat, antistatic 16
menus

chassis view 36
software upgrade 280

message system
operator alert messages 76

messaging system
configuration 69

MGT 140
mirroring

removing 55

modifying
programs 156
streams 156

module
GBP module 20

MSO 219
Multiple IP Creation 128
multiple TS creation 128
Multiple UDP Creation 128
multiplex 139
Multiplexing 7

N
Network Information Tables (NIT) 145
Network Information Tables, see NIT
network processing modules 20
NIT
noise emissions 296
nut, M4 25

O
overlay 8

P
PAL content 43
Panel 16
passthrough 224, 228

keep 228
passwords 62
PID 139
PNG 8, 90
port

mapping scheme 19
port connection

connecting ports 29
port mirroring 54
Portable Network Graphics 8, 90
Postblack 217
Postblack Configuration 44, 218
power cord 15
power cycle 116
power supply

redundant 21
removing and replacing 284

power, applying 26, 28
pre-bind 220, 221, 224, 227, 228, 229, 231
PROC3 21
program descriptors

managing 203
programs 163

deleting 163
modifying 156

Protocol 61
PSIP 121, 140



Index

332 BNP3xr User Guide

Q
Quality of Service (QoS) 7

R
rack mount 15, 22, 289
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